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Congratulations on the purchase of your new computer!

This document is a quick guide to help you to use your computer quickly and
efficiently without reading through the full manual. It assumes you are familiar
with GEM on Atari computers.

Setting up your new computer is easy. First, unpack your computer, keyboard
and mouse as well as the power and keyboard connection cables. Place the
computer on a firm level surface with the TT030 label facing you. Using the
coiled wire, attach the keyboard to the computer. The keyboard plug on the
computer is on the left side. The keyboard connection is on the back of the
keyboard.

Connect the mouse to the keyboard: the mouse plug is on the right side of
the keyboard.

Unpack your monitor and place it on top of the computer. Take the power cables
and plug in your monitor and computer. Turn the computer and monitor on.

After a few moments the power indicators on both the computer and the
monitor will light up. If they do not, check the power connections and try again.

The internal hard disk is pre-installed with all of the software needed to operate
and run. After the hard disk has warmed up. indicated by a series of light flashes
on the hard disk activity light and sounds, press the space bar on the computer.
This signals the computer that the hard disk is ready to operate. If you aren't
sure hai the hiard disk is done yel. dun't worry, the computer wiil wait about
2 minutes and start up anyway.

You should now see the desktop on the screen: this will indicate a floppy disk
icon and four hard disk icons along the top of the screen. If you see two floppy
disk icons and no hard disk icons, it means that you pressed the space bar
too soon. Just hold down both the Control and Alternate keys (on the left side
of the keyboard) and press the Delete key (just right of the large Return key).
This resets your computer for another try.

The Desktop in your new computer has many new features that were not
available in the ST Desktop. These include:

1) Keyboard Shortcuts for menu items.

2) Files and folders on the desktop.

3) Keyboard Shortcuts for window operations.

4) A file mask to show only some files in a window.

5) Multiple icon types.

6) More ways to run a program, with more options.

7) More file view options.

8) File Search.

9) More choice in how windows open.
10) Help, which appears when you press the Help key. Do this now.
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Now more detail on the list above, : : et

1) All menu items can be selected by pressing a key. The default key is shown
to the right of the menu item. You can change these keyboard shortcuts.
To change a keyboard definition select Desktop Configuration under the
Option menu. In the section marked Define Single Keystroke, click on the
arrows to scroll to the menu item you want to change. Press the key that
you now want to as the shortcut.Click on OK. To save your new keyboard
shortcuts use Save Desktop (under Optlons) ol

2) F|Ie and folders can now be pIaced dtrectly on ihe desktop This allows
you to have a very clear desktop that is customized to your needs. Drag
the files or folders you want to the Desktop, then use Save Desktop to keep
your changes i S

3) Window operations (not in menus) like opening a window or scrolling can
also be performed from the keyboard. To open a device into a new window
press <ALT> + <the drive letter>. For example t0 open a new window
for drive C press <ALT> +<C>. Press the cursor keys to scroll the topped
~window. - - R - o

4) The Set File Mask menu item is a very powerful new feature. It allows you
. to select which files' you would like to display in the current active window.
_You select Set File Mask and, using wild the cards* and ?, instruct the
computer which files to show. As an examplé if you only want to seé
program files that start with ‘W’ you would enter ‘W*.PRG’. When used in
- conjunction with Select’All this feature allows me-mzfmp-mmw*‘s TrT:IfWO‘Dld"““"""_'
be very tédious otherwise.

5) Multiple icon types are selected using the install icon menu item. This
allows you to choose from a number of icons to represent your drives, a
desktop printer, the trash can and files: Select Desktop for those icons
which can only be on the Desktop. Select Window for those that are usually

--in windows. Choose an icon by scrolling through the available selections
and that icon wili be used to represent the items defined at the' top of the
dialog box.

6) Programs can now be run by opening the icon that represents the program
or by opening a document of the installed type. Programs can be installed
so that they can be started by pressing a fynction key. Programs may also
be run by dragging a file to the program icon. This will also give the file
name to the program as a starting-parameter.~-Most programs will
automatically open:the file. The install ‘Application-and Desktop
Configuration menu items also allow you to choose theé way thé system
will appear to a program when it starts. The chmces affect the default
directory and the amount of information the program gets about a file you
want to start with. The default options are the ones that will work for most
applications. If your program reports that it cannot find one of its supporting
files, change the Default directory choice. If your program canndt find the
file you asked for (or displays a strange file name) change the Arguments
choice. Not all applications can be made to run with these new options,
contact your software vendor for more information if required.
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7) The Size to Fit menu selection (under View) allows you tells the Desktop
to only put as many items across a window as will fit. This prevents the
need to scroll sideways when you display as icons (or as text in TT high
resolution). You can now view files with the No Sort option. This allows
you to see a directory the way a program would see it. This is mainly for
advanced users who want a great deal of control over system performance.

8) File Search is another very powerful new feature. By ‘selecting a
" combination of file icons (or folders) you can instruct the desktop to find
all occurances of a file name that contains the string you specify.

9) Windows that are opened by clicking on a folder can now be new windows
instead of taking over the existing window. This is done by holding down
the ALT key while opening the folder. _

10) Press the help key for a handy reminder of these and other features.

Your new computer also has a new control panel with many new features. The
control panel is accessed as before, from the desk menu. Now a list of different
control panel functions can be accessed. The control panel uses a new form
of pop-up menu. An example of this is the Options button on the main control
panel. Select Options and a set of possible choices appear, release the mouse
button and move the pointer to the choice you want to select by clicking the
mouse button when the choice is highlighted. If a. large number of choices
are available, the list will contain arrows at the top and bottom to allow scrolling
through the range of choices. If you do not want to select any of the choices
~either select the one currently selected (indicated by a check mark) or click
outside of the pop-up.

The control panel features are quite simple to use and mostly self-explanatory.

Some features of note are:

1) General: Allows the speaker to be turned off and Status shows you available
RAM.

2) Sound: This one is new, click on the person icon to hear a sound. Volume
is the most commonly used control. The other adjustments meant for a
system attached to a stereo sound system (the built in speaker is mono).

3) Color Setup: The system has 16 banks of colors available in all modes with
less than 256 colors. These banks can be selected by using the bank slider.
Undo will restore the current bank to what it was before you changed it (most
useful if you just set the_foreground color and background color to match).
The Reload button resets all banks from the last saved state. If you want
to return to the color palette that is factory preset press Clr/Home.

4) Window Colors: Select a window feature, e.g. the move bar. Select a Fill.
Text or Outline color or a different background pattern. The sample windows
allow you a test your choices. Changes can be made to both windows that
are topped and ones that are not. There are 10 preset color combinations
available by pressing F1-F10. You can also select the default coloring by
pressing Clr/Home.

Note:Only windows created after the change will show the new colors
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IMPORTANT INFORMATION

Like any electrical appliance. the Atari TT computer uses and produces radio-
frequency energy. If not installed and used according to the instructions in this manual.
the equipment may cause interference with your radio and/or television reception.

If you believe that this equipment is causing interference. try switching it on and off. If

the interference problem stops when the equipment is switched off. then the

equipment is probably causing the problem. With the equipment switched on. you may

be able to correct the problem by trying one or more of the following measures:

* Adjust the position of the radio or television antenna.

* Reposition the equipment in relation to the radio or television set.

* Plug the equipment into a different wall outlet so that the equipment and the radio or
television set are connected to different branch circuits.

If necessary. consult your Atari computer retailer or an experienced radio-television

technician for additional suggestions.

PLEASE NOTE: Every effort has been made to ensure the accuracy of the product
documentation in this manual. However. because Atari Corporation is constantly
improving and updating its computer hardware and software. it is unable to guarantee
the accuracy of printed material after the date of publication and disclaims liability for
changes. errors. or omissions.

Reproduction of all or any portions of this manual is not allowed without the specific
written consent of Atari Corporation

Atari, the Atarilogo, TT, TOS, SM124. SC1224, SF314, SF354. PCF554. SLMB804.
CDARS0. and Atari SFP-004 are trademarks or registered trademarks of Atari
Corporation. GEM and GEM Desklop are trademarks or registered trademarks of
Digital Research, Inc. MS-DOS is a registered trademark of Microsoft Corporatinn
Epson is a registered trademark of Seiko-Epson Corporation.

NATARI

Copyright © 1990, Atari Corporation
Sunnyvale. CA 94089-1302
All rights reserved.
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CHAPTER ONE
GETTING STARTED

INTRODUCTION

Your Atari TT computer system combines the latest microcomputer
technology with an easily understood and simple-to-use working
environment. TT computers come standard with the following

= A 68030 32 MHz processor
« A palette of 4,096 colors; six different video modes

= An 80-column display

= Two, four, six. or eight megabytes of RAM, depending on the
model

« Expandable to 26 megabytes of RAM. using 4-Mbit DRAM chips

« A 68882 floating point coprocessor ter taster information
processing

« A built-in double-sided floppy disk drive that stores up to 726.016
bytes of information

« A built-in hard disk drive

« Ports for adding an additional floppy disk drive, SCSI devices.
ACSI| (DMA) devices, a parallel device. serial devices, MIDI
instruments, and stereo speakers

« A Local Area Network (LAN) interface
+ A VMEbus for high speed asynchronous parallel data transfer
« A CPU cache option for taster information processing

« The operating system. TOS. permanently installed in memory
TOS includes GEM, the powerful Graphics Environment Manager.
GEM provides the visual representation of the computer's
operations

» The Control Panel desk accessory contained on the built-in hard
disk drive and on the USA Language floppy startup disk

« A complete collection cf hard disk utilities on the Atari Hard Disk
Utilities disk

Getting Started
1-1
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Using This Manual

Operating your computer is easy This manual explains in clear
nontechnical language how to operate your computer After you
become familiar with the computer use this manual as a reference
guide to indwvitual procedures and specific information

Computer owrers hving in the United Kingdom should refer to
Appendix G {01 additional instructions when connecting ther system

A summary -+ 2ach manual section follows

Chapter One Getting Started familiarizes you with the
components 2i the computer system This chapter explains how 1o
unpack the computer and connect the system components. and
explores the major features and available options

Chapter Two Using the TT niroduces more basic computer
concepts. describes how to start up and switch off your system. and
discusses the (3EM Desktop environment

Chapter Three: Basic Skills Tutorial explains how tc use the
elements of the GEM desktop to manage information. both on
screen and o disk The tutonial teaches now 1o use the cursor.
work with windows. copy and delete icons faiders and files. and
tormat a flcopy disk

Chapter Four: Advanced Desktop continues where the tutorial

left off and =»piains advanced desktop functions such as updating
a directory aisplay . entering information when a diaiog ox displays
and advancea menu bar commands.

Chapter Five Directories, Folders, and Files teaches you all
about files. "lenames folders and directory structures This chapter
also explains how to use files and directories ifolders) to develop
and maintain an efficient working environment

Chapter Six Desk Accessories explains how to install and use

desk accessaories, and also describes in detail the Control Panel
desk accessory included with your system

Getting Started
1-2
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Appendix A: TT Panels and Ports presents labelled drawings of
the TT's side and rear panels.

Appendix B: Pointer Control Quick Reterence is a chart
describing pointer actions and how to achieve them using the
mouse or keyboard Keep this chart near the system for quick
reference.

Appendix C: Advanced Hard Disk Utilities describes how to
use the hard disk drive utilities

Appendix D: Troubleshooting and Preventive Maintenance
offers solutions to problems you may encounter while connecting or
operating the TT computer. The appendix includes guidelines for
proper maintenance of the computer system

Appendix E: TT Computer Specifications summarizes the
major features and requirements of the TT computer

Appendix F: Connector Pinout Specifications shows the pin
assignments of the computer ports

Appendix G: Power Connection in the United Kingdom
provides additional setup instructions for TT computer owners in the
United Kingdom

Glossary defines common technical terms used in this manual as
they relate to your computer

Index helps you locate terms and procedures used or explained In
the manual.

Customer Support tells where to find more information about the
Atar TT computer as well as other Atari computer products

Getting Started
1-3
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Special Notations

Characters enclosed by square brackets ([ ] represent keys on the
computer keyboard. Sometimes a procedure requires you to use
two or more keys at the same time. For example, [Control] [X]
means to hold down the [Controll key while you press the [X] key

Paragraphs marked Note or Warning appear throughout the

manual
@ Note: Notes contain useful hints and other information
relevant to the topic being discussed.
STOF Warning: Warnings alert you to potential problems and

suggest ways to avoid those problems.

SETTING UP YOUR SYSTEM

Set up your sysltem in a workspace that is both healthy for the
computer and comfortable for you. Choose a workspace with a
sturdy. level surface close to an elecirical outlet, with plenty of room
for airflow around the system Protect the system from dust, grease
extreme temperatures. direct sunlight. and high humidity. An
environment that works well for a television or stereo system will
also suit the computer

Carefully unpack the computer console, keyboard, mouse, and
monitor. Remove all packing materials {including the protective
inserts in the floppy disk drive and the mouse) and save them for
storing or shipping the system later Then follow the instructions in
this section for connecting the system

Note: You will find labelled diagrams of the TT's panels and ports
in Appendix F, TT Panels and Porls.

Getting Started
1-4
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Keyboard and Mouse

One of your computer's convenient features is the detached
keyboard. You can position the keyboard at whatever angle is most
comfortable for you. If you prefer a sloped keyboard. turn the
keyboard upside down and flip the two plastic retractable feet on
the bottom of the keyboard towards the back. This raises the back
of the keyboard. Flip the feet back into the retracted position tc
make the keyboard lie flat.

A mouse Is a device that allows a special type of communication
with your computer. Rolling the mouse on a flat surface moves a
cursor on the screen You move the mouse and click the mouse
buttons to perform select. move, delete, edit. and other operations
on icons, text, and graphics displayed on your screen

Connecting the Keyboard %,
'7
A coiled cord with a standard phone connector connects the
keyboard to the computer console. Plug the connector into the jack
on the left side panel of the TT.

Connecting the Mouse J

The mouse connects o the computer through the keyboard. The
mouse and joystick ports are located on the sides of the keyboard.

To connect the mouse, insert the mouse cable connector into the
Mouse/Joystick port on the right side of the keyboard.

Monitor

The monitor provides the video display for the computer. There
several monitor models available for use with the TT: multisync
monitors (color or gray scale) that each have two modes, VGA and
TT. and high resolution grey scale full page display monitors

Getting Started
1-5
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Connecting the Monitor ﬁ

First connect the monitor's video cable into the monitor (if not
already attached) Connect the other end of the cable to the
Monitor port on the back panel of the computer Use of an adaptor
plug (supplied with the monitor) may be required

Connect the power cable to the back of the monitor, then insert the
plug into a grounded wall outlet or power strip (Consult the manual
supplied with the monitor for further information )

Power Cable

The computer s power cable provides power to the computer and
the built-in (internal) disk drives. The green light on the computer
lights up when power to the computer is switched on The disk drive
busy light is it when the drive 1s sending. receiving, or saving data.

Connecting the Power Cable

(@) | ~o

The On/Off switch turns the The power cable connects the
computer on and off, I is on, computer to the electrical

O is off outlet.

Toggle the computer s power switch 1o the off position. Remove the
protective insert from the floppy disk drive. Connect one end of the
power cable into the jack marked Power on the back panel of the
computer. Then insert the cable s three-pronged plug into a
grounded wall outlet or power strip.

Getting Started
1-6
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Built-in Floppy Disk Drive

Your computer comes with a built-in double-sided floppy disk drive
The floppy disk drive slot is located on the computer’s front panel.

The built-in floppy drive is known as drive A. However, the desktop
displays two floppy disk icons, A and B. In systems with only one
floppy disk drive, the built-in floppy drive acts as both drive A and
drive B

Built-in Hard Disk Drive

A hard disk drive stores much more information and transmits that
information faster than a floppy disk drive. The hard disk is a rigid
plate coated with a substance which can receive and store data.
The disk i1s sealed into the drive, protected from dust and physical
damage. As the drive spins the disk at a very high speed,
information is written to or read from the disk. Read/write heads.
similar to those on a tape player or VCR. cruise across the disk and
read or write information without actually making contact with the
disk. Information on your hard disk is transferred to and from the
computer's memory through electronic circuitry.

Your built-in hard disk was formatted and partitioned at the factory
and is ready to use. |If you would like more detailed information
about the utilities on the Advanced Hard Disk Ulilities Disk,
including how to reformat or repartition your hard disk, see Appendix
C, TT Advanced Hard Disk Utilities.

You can also connect additional hard disk drives to your computer.
(See ACSI and scsl)

Reset Button V4

The reset button restarts the computer without switching it off.
Restarting the computer this way is known as a warmboot. You can
also perform a warmstart by pressing [Control] [Alternate] [Delete] .

Getting Started
1-7
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Cartridge Slot

Cartridges containing programs can be inserted into the cartridge
slot. Cartridges contain all the memory needed for running the
cartridge program A single cartridge can contain up to 131,072
bytes (128 kilobytes) of program information. The system
recognizes the cartridge slot as drive c.

Inserting a Cartridge

Switch off the computer and all peripherals. Insert the cartridge.
label side up nto the cartridge slot. Switch on your system The
program on the cartridge loads automatically

Quick Start

You have connected your system. and you know some information
about your computer's basic components and features The
following section describes additional ports and expansion slots and
explains how to connect various peripheral devices If you have no
devices to connect and you wish to start your system now, skip
ahead to Starting your System in Chapter Two

TT PORTS AND EXPANSION SLOTS

The panels on your computer contain ports. A port is an entryway
into your computer through which you can connect peripheral
devices such as printers and hard disk drives Your computer
communicates with peripheral devices by sending and receiving
signals through the ports. Small icons identify most ports. This
section discusses each port and its use. (See Appendix A, TT Panels
and Ports, for labelled drawings |

Your computer also contains a VMEbus expansion slot. You can

connect high speed VME devices 1o your computer through this
expansion slot.

Getting Started
1-8
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Switch off your computer and all peripheral devices before
connecting any new peripheral device. Some peripheral cables
have small retaining screws or clips on the sides of the connector
Tighten the screws or attach the clips to maintain a strong
connection between the computer and the peripheral This will also
help eliminate interference which might affect television or radio
reception in the area.

Warning: Never touch the exposed contacts on any port or
expansion slot. Static electricity could harm the sensitive electronics
inside the computer

External Floppy Disk Drive

o

Connecting an External Floppy Disk Drive \?,,

In addition to the floppy disk drive built into the computer, you can
connect a second. external floppy disk drive This second floppy
disk drive can be either the Atari SF314 or 354 double sided 3V2-
inch disk drive or the Atari PCF554 5Va-inch disk drive A second
disk drive makes copy operations, and data storage and retrieval
more convenient.

Note: The Atari PCF554 5va-inch disk drive lets you use MS-DOS
format compatible 5%4-inch data disks with your computer. You
must install a special device recognition program to use this drive
with your computer Contact Atari Customer Support or your dealer
for more information

iy
i

Switch off the computer and all peripherals and remove the
protective insert from the disk drive. Connect one end of the floppy
disk drive's interface cable into the port labeled Floppy Disk on the
back panel of the computer. Connect the other end into the port
labeled In on the back of the drive. Insert the round plug on the
drive's power adaptor into the jack labeled Power on the back of the
disk drive. Then insert the power adaptor’s three-pronged plug into
a grounded wall outlet or power strip.

Note: You can connect only one external floppy disk drive to the
computer system. The computer always refers to the external
floppy disk drive as drive B

(Getting Started
1-9
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ACSI (DMA)

The Atari Computer Systems Interface (ACSI) port is a high speed
Direct Memory Access (DMA) interface. The DMA chip in your
computer allows connected DMA devices to communicate directly
with the computer's memory, without having to go through the CPU.
The DMA chip transters data much faster than the CPU can, and
using the DMA chip frees the CPU for other tasks. . .
You can attach an Atari DMA hard disk drive, Atari SLM laser
printer, CDAR504 compact disc drive or other high-speed DMA
peripheral to this port. You can daisy-chain up to four DMA devices
to the computer through the DMA port.

S I R S
Daisy-chaining is a way to connect more than one peripheral device
to a single port. The first device in the chain connects to the
computer, and the rest of the devices in the chain connect to each
other. For example, device A would connect to the computer,

device B would connect to device A, device C would connect to
device B, and so on. See the manual supplied with the peripheral

for more detailed information.

Connecting a DMA Device @

Switch off the computer and all peripherals. Connect one end of the
DMA device's interface cable to the port labeled DMA on the back
panel of the computer. Connect the other end of the interface cable
to the IN port on the back of the DMA device. Connect the power
cable to the power jack on the back of the device, then insert the
three-pronged plug into a grounded wall outlet or power strip.

Printer

The Printer port is a standard parallel interface. You can attach
almost any parallel printer to this port. (Refer to the manual
supplied with your printer for further instructions.) However, you
must use the ACSI port to connect an Atari laser printer.
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Connecting a Parallel Printer - &,

Switch off the computer and all peripherals. Connect one end of the
printer's interface cable to the port labeled Printer on the back panel
of the computer. Connect the other end to the port on the printer.
Connect the power cable to the power jack on the printer, then
insert the three-pronged plug into a grounded wall outlet or power
strip.

S3V G

Modem and Seriél

The Modem and Serial ports are used for serial (one bit at a time)
transmission of data over a single wire. You can connect a standard
modem to either or both fully configured RS232 Modem ports. The
computer uses a modem to transmit and receive information to and
from other computers over telephone lines. You can use the Serial
or Modem ports to connect any serial printer or other serial device
to your computer. 2"
There are two Serial ports on your computer. You can connect
serial devices to both ports unless you are also using the Local
Area Network (LAN) port. If your computer is connected to a LAN,
Serial port 2 is disabled.

Modem % Serial Qﬁ

LAN

A Local Area Network (LAN) is a communications channel that
connects computers and other devices together. Each device or
computer in the network is called a node. Nodes are usually
computers and input/output devices such as printers and disk
drives.

Sharing access to network devices is very convenient when more
than one user must have access to the same information. For
example, a user at one location could update an inventory database
by adding received goods, while a user in another location could
deduct sales from the same database.

Getting Started
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SCSI

The Small Computer Systems Interface (SCSI) portis a standard
bus used to connect any SCSI printer or storage device to your
computer. You can daisy chain (see Acsl) up to seven SCSI
devices to your computer.

Connecting an External SCSI Device . G

Switch off the computer and all peripherals. Connect one end of the
SCS| device's interface cable to the port labeled SCSI on the back
panel of the computer. Connect the other end of the interface cable
to the port on the back of the SCSI device. Connect the power
cable to the power jack on the back of the SCSI device, then insert
the three-pronged plug into a grounded wall outlet or power strip.

VMEDbus
You can install @ VME card into the VME-compatible Eurocard
(A24. D16) expansion slot. Use the VMEbus for high speed
asynchronous parallel data transfer between the computer and any

VME device. For complete instructions on how to connect a VME
device to your computer, consult the device's owner's manual.

Stereo

A stereo amplifier connected to the RCA stereo ports on your
computer provide stereo sound when used with software that
supports this feature. The 8-bit digital-to-analog sound converters
contain hardware filters to prevent digital distortions (such as
aliasing), resulting in realistic Pulse Code Modulated (PCM) sound.

Connecting a sound system also improves the sound quality of
software not specifically designed to take advantage of stereo.

Getting Started
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Connecting Stereo Headphones or Speakers WA

Switch off the computer and all peripherals. Connect the left and
right audio cable plugs to the corresponding stereo ports on the
computer.

Joystick

o
o

Joysticks control the screen action of some computer games. (See
the manual supplied with the game for specific information on using
the joystick.)

Note: Joysticks must be purchased separately.
Warning: Disconnect joysticks before switching on your computer.

Connected joysticks can interfere with the initialization of keyboard
functions during the starting process.

Connecting a Joystick &

Connect Atari-compatible joysticks through either mouse/joystick
port O or joystick port 1.

MIDI

MIDI stands for Musical Instrument Digital Interface. The MIDI
capabilities of your computer help you create and record music one
track at a time. You can connect your computer to electronic
musical instruments through the two MIDI ports. The Midi In port
allows the computer to control a synthesizer or any MIDI-equipped
instrument. Through the Midi Out port, the computer controls an
instrument's digital intertace, letting you play complex compositions
while changing the volume, tempo, and instrumentation. MIDI
interfaces and appropriate software can allow your computer to
function as a sophisticated sound studio recorder.

Getting Started
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Connecting an Electronic Musical Instrument .. iy

Connect a MIDI instrument to the Midi In and Midi Out ports on the
left side panel. Retfer to your MIDI instrument's manual for

instructions.

o
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CHAPTER TWO ’ ’
USING THE TT

FUNDAMENTAL CONCEPTS

This section explains how a computer works, what memory is, and
how to start up your system from the built-in hard disk drive or
from a floppy startup disk.

How the TT Works

A computer processes instructions to perform a task. Two
examples of instructions are the operating system instructions on
your computer's Read Only Memory (ROM) chip, and the
instructions in an executable program contained on a disk. Your
computer receives these instructions as electronic signals to be
processed and/or stored. The processing and storing of data (sets
of electronic signals grouped together) is handled by a system of
electronic components and integrated circuits.

Memory

Your computer uses two types of memory: internal memory, and
external memory. Internal memory is information storage locations
on microchips inside your computer. External memory is
information storage locations on hard disks, removable cartridges,
floppy disks, and CD-ROM discs.

A computer’'s memory capacity is measured in bytes. Since
computer language is based on the binary numbers system, the
smallest data unit is one Blnary digiT, or BIT. Groups of 8 bits are
called bytes.

A kilobyte is 1,024 bytes: a megabyte is 1,024 kilobytes. Each TT
has 512 kilobytes of ROM and 2, 4, 6, or 8 megabytes of RAM.

Using the TT
2-1

TT manual Page 27



Internal Memory Storagé' £

There are the two types of internal memory: ROM and RAM.

ROM means Read Only Memory. As its name implies, you cannot
write more information into a ROM storage area. The information in
ROM is permanent, and cannot be erased. ROM chips inside the
computer contain the operating system information.

RAM means Random Access Memory. The RAM area within a
compulter is for temporary storage of information. RAM is the
computer's chalkboard. The computer can quickly and efficiently
access programs and data files written into RAM. To save
information stored in RAM, you must transfer the information from
RAM into external memory storage. Turning off your computer
erases the RAM chalkboard.

External Memory Storage

External memory storage disks include cartridges, floppy disks,

standard hard disks, hard disks in removable cartridges, and cD-
ROM discs.

Floppy and hard disks store information which can be read from the
disk into RAM, modified if desired. and later saved back to the disk

from RAM. Information on floppy and hard disks can be erased and
the disk reused. Magnetic floppy disks for your computer can store

either 357,376 bytes (single-sided disks) or 726.016 bytes (double-
sided disks) of data.

CD-ROM discs store information that can be read into RAM for
processing. You cannot write any additional data onto a CD-ROM

disc.

TOS

TOS is the name of the computer’s operating system. TOS controls
the way the computer works. handling tasks such as reading from
and writing to disks, translating mouse movement into onscreen

cursor movement, and displaying information on the screen.

Using the TT
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GEM. the Graphics Environment Manager, is an important partof
TOS. GEM provides a graphic interface for the computer. This
allows a screen display of information as graphic images (such as
picture icons and windows) as well as letters, numbers, and
symbols. .

STARTING YOUR SYSTEM T

You have connected the hardware and you have learned the
fundamentals of how your computer works. The next step is to
switch on your system. The ROM chips inside your computer
contain the operating system, so you do not need a system (boot)
disk in the floppy drive to start your computer. However, you can
have your computer read additional startup information and files
during the startup process. All of the startup information read
during the startup process will be automatically available when the
desktop appears.

You can store startup information on a hard disk or a floppy
startup disk. Your built-in hard disk already contains startup
information and will automatically access this information when
you switch on your system. This is the quickest and most
convenient way to start your system.

In rare cases, storing startup information on floppy disks may be
necessary. For example, you may have a large number of desk
accessories, more than you can have active at one time. If you
only need certain desk accessories active when you are doing
specific tasks (such as word processing. using your database,
etc.) you could create a custom floppy startup disk for each
activity. The startup disk you use would depend on the activity.
Most users will find this to be unnecessary and time consuming. It
is much more convenient to store your startup information on the
built-in hard disk.

If you wish to start your system from a floppy startup disk, skip to
the section Starting Your System from a Floppy Startup Disk. If you
wish to start your system from the hard disk, continue to the next
section, Starting Your System from the Hard Disk.
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Starting Your System from the Hard Disk - ~

Your built-in hard disk contains the following startup information
and files:

« The Control Panel desk accessory (XCONTROL.ACC)

« An SHDRIVER.SYS file. This file contains the startup
information on the hard disk.

o —

When you start your system, the computer reads the startup
information on the hard disk. When the startup procedure is
complete, the desk accessory will appear under the Desk menu,
and drive C will contain folders and files.

Follow these steps to start your system from the hard disk:
1. Switch off your computer and all peripherals.

2. If you have an Atari laser printer connected to your system,
switch it on.

3. Next switch on the monitor. second floppy disk drive, external
hard disk drive (see your hard disk drive owner's manual for
further instructions), all other devices (such as a second hard
disk, parallel printer, or modem).

If you have a connected external hard disk drive, wait until the
hard drive busy light goes off betore switching on another
device.

4_ Switch on your computer. When the internal hard drive has
completed its initialization, press any key. Pressing a key at this
stage speeds up the startup process by a considerable amount
of time. (The hard disk drive makes a certain sound during
initialization. When initialization is complete, the sound stops.)
The desktop displays.

0 Note: If the desktop does not appear on the screen. switch oft the

computer. Make sure the monitor is switched on and all cable
connections are correct and secure. Switch on the system again.
If the desktop still fails to appear. se€ Appendix B, Troubleshooting

and Preventive Maintenance.
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That's all there is to it. There are several reasons other than the
ones already mentioned that may make it necessary for you to
start your system from a floppy startup disk. Some games and
copy-protected programs require that you start your system from
the floppy program disk. If you want to learn how to start your
system from a floppy startup disk, read the next section.
Otherwise, skip ahead to Initial Screen Display-GEM Desktop.

Starting Your System from a
Floppy Startup Disk

The easiest way to start your system from a floppy disk is to
bypass the installed hard disk driver on the internal hard disk
drive. Then you can run the AHDI.PRG program from the
Advanced Hard Disk Utilities disk so your computer will recognize
the presence of the hard disk drive.

It will be helpful for you to follow the tutorial in Chapter Three
before you attempt to start your system from a floppy disk. The
tutorial will teach you all the skills you need to easily follow the
floppy disk startup instructions.

Warning: Before starting your system from the USA Language
disk, follow the instructions in the next chapter to make a working
copy of the disk. Always use the working copy- never the original
disk.

Follow these steps to start your system from a floppy startup disk:

1. With your computer switched off, insert the working copy of the
USA Language disk into drive A.

2 Switch on the computer. When the power light comes on,
immediately hold down [An). As soon as the floppy drive busy
light comes on, release [AIt]. Wait several seconds, then press
any key. After a short delay the desktop displays, containing
three icons (floppy disk icons A and B, and the trash can icon)

and a menu bar.
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If you are starting your computer from a commercially prepared
program disk, the program may run at this time and the
desktop may not display. You do not need to follow the
additional steps.)

€ Note: If you are not using a commercially prepared program

disk to start your system, and the desktop does not display,
switch off the computer. Make sure the monitor is switched on,
the disk is correctly inserted in drive A, and all cable
connections are correct and secure. Switch on the system
again. If the desktop still fails to appear, see Appendix B,
Troubleshooting and Preventive Maintenance.

4. Remove the USA Language disk from drive A. Insert the
working copy of the Advanced Hard Disk Utilities disk into drive
A. Display the directory.

5. Open the Auto folder. Open (run) AHDI.PRG. This will allow
the computer to recognize the presence of the hard disk drive.
After the program runs, close all windows.

6. To install hard disk icons, select Install Devices from the
Options menu. All hard disk icons appear on the screen.

Initial Screen Display-GEM Desktop

When you switch on your system, the computer reads the startup
information from the hard disk or the startup floppy disk and loads
that information into RAM. The desktop appears on your screen.

GEM Desktop is the starting point for almost everything you do
with the computer. The basic desktop contains two floppy disk
icons, four hard disk icons, and a trash can icon on the left edge
of the screen, a menu bar at the top of the screen, and a pointer.

%

Hard Disk Icons

Your built-in hard disk drive is already formatted and divided into
sections (partitions). Having more than one partition makes it
easier for you to organize your files. For example, you can use
one partition to store all of your word processing programs and
files, another for databases, elc.
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A hard disk icon is an entrance to the information storage area on a
partition. All hard disk icons are automatically installed for you.
Since your built-in hard disk drive has four partitions, four hard disk
icons display on your screen.

‘Each icon must have its own unique letter identifier, and the letters
must be in alphabetic sequence. The letters A and B have already
been used for floppy disk icons, and the letters C through F
represent logical drives (the four partitions on your hard disk).

Floppy Disk and Trash Can lcons

Two of the disk icons that first appear are labeled FLOPPY DISK.
(Both A and B icons appear even if you have only one floppy disk
drive.) You use these icons to access information on floppy disks.
Use the trash can icon to delete unwanted files or folders from
disks. - - ——

The trash can icon works like an incinerator. Once you throw a file
or folder in the trash, that file or folder is gone forever.

Menu Bar

The desktop also displays four menu names along the top edge of
. the screen. Each menu bar heading (Desk, File, View, and Options)
' _ has its own drop-down menu, from which you can select options.
(Chapter Four gives a detailed description of the menu bar options.) -

Pointer

The final basic desktop element is the pointer (cursor). The cursor
can also appear in the shape of an I-bar or a busy bee icon,
depending on the activity. The I-bar usually represents an insertion
point for text entry, and the busy bee icon appears when your
computer is processing data.

Usingthe TT = ~
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KEYBOARD FEATURES

Much of what you will do with the computer will involve pressing
keys. The keys you will use most often with word processing
applications are letter keys. You will use number keys most often
with spreadsheet programs.

The computer keyboard is similar to a conventional typewriter
keyboard in both design and function. For example, the [Return] key
on the computer keyboard acts like the carriage return lever (or
key) on a typewriter. Pressing [Return] moves the cursor down the
screen.

Most keys automatically repeat when held down. (For information
on changing the rate of automatic repeat, see Control Panel in
Chapter Six.)

The alphanumeric keys (letters, numbers, and symbols) usually
have the same function as similar keys on a typewriter. Press [S] fo
produce a lowercase letter s and press [shift] [S] to produce the
uppercase letter S. Press [Caps Lock] to toggle (switch back and
forth) between upper and lower case letters.

In addition, several keys on the computer's keyboard perform
special functions not found on a typewriter.

For example, you can use [Controll. [Alternate]. and [Shift] in
conjunction with another key to produce a secondary function or

code. Hold down one or more of these keys while pressing another
key.
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Along the top of the keyboard are the function keys [F1] through
[F10). Holding down [shin] while pressing function keys accesses
ten more function keys: [F11] through [F20] Software applications
often assign special functions to these keys.

Use the four arrow keys to move the cursor in the direction
indicated by the arrow. The cursor is a movable graphic screen
symbol (often an arrow, block, or vertical line) that marks where
the next action will take place.

0 Note: The presence of a text cursor (usually a vertical line or a
block) indicates that the computer is ready for you to type
something.

The calculator keypad usually functions as an alternate method
for entering numbers and math symbols, producing the same
effect as typing the number or symbol from the keyboard. [Enter]
acts as [Return].

SWITCHING OFF THE SYSTEM

There are two ways of switching off and restarting your system.
Completely switching off the system for any period of time longer
than 10 seconds is called a coldstart. This completely resets the
machine and clears all information from RAM. A warmstart does
not completely clear RAM.

Coldstart

You can coldstart your system from the keyboard without
switching the system on and off. Simply press [Control] [Alternate]
[Right Shift] [Delete].

You can also coldstart the system in the following way. Switch off
all system components in the reverse order that you switched

them on. Wait at least 10 seconds before switching the computer
back on. This completely resets the computer.
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Some applications and desk accessories require that you coldstart
after changing certain options.

Warmstart

To warmstart the system from the keyboard without switching the
system on and off, simply press [Control] [Alternate] [Deletel.

You can also warmstart the system by pressing the reset button
on the back panel.

Usingthe TT
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CHAPTER THREE
BASIC SKILLS TUTORIAL

This chapter presents the information you need to work with the
different basic elements of the desktop. By following the tutorial,
you will learn how to control the onscreen pointer using the mouse
or the keyboard, manipulate icons and windows, make selections
from the menu bar, format and copy a floppy disk.

To follow the copying and formatting sections of the tutorial, you
must have two blank unformatted floppy disks available. You will
use the disks to make working copies of your USA Language disk,
and your Advanced Hard Disk Ulilities disk.

2 E

Before you begin the tutorial, you must do the following:

« Start your system and display the desktop as described in
the previous chapter

« Insert your USA Language disk into drive A

Inserting and Removing Floppy Disks

When you insert a floppy disk into a floppy drive, a mechanical
catch inside the drive slides the metal sleeve open, exposing the
sensitive magnetic disk to the drive’s read/write head. The disk
stores information in concentric rings called tracks. The read/write
head moves from one track to another as the disk spins.

Front of Disk
Metal Sleeve

Back of Disk

Write-Protect Notch

Sliding Tab
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Always be sure the floppy drive’s busy light is off before you insert
or remove a floppy disk. To practice inserting and removing a :
floppy disk, follow these steps:

1. Align one of the blank, unformatted floppy disks with the floppy
drive slot, the metal sleeve against the slot and the write-
protect tab on the left.

@ Warning: Do not slide the metal sieeve open or touch the
magnetic disk. Doing so may damage the disk and the
information on it.

2. Slide the floppy disk into the drive slot until it drops down and
seats within the slot.

3. Remove the floppy disk by firmly pressing the eject button on
the front of the floppy disk drive. The disk ejects part way.
Remove the disk. .

ERRL

DESKTOP ELEMENTS A
lcons. windows, and the menu bar are the three important
elements of the desktop. Desktop icons are graphic NEF IS |

representations of drives (logical drives and floppy disks), devices
such as printers and cartridge drives, and the trash can. Window
icons represent folders and files. Files and folders can be
displayed as either text or graphics. A text display is simply the
name of the file or folder appearing on the screen. A graphic
display is the same as a desktop icon; a small picture with the
name of the file or folder underneath. Files and folders displayed
as text are also referred to as icons.

There are two kinds of windows: directory windows and windows
known as dialog boxes. Directory windows display the contents of
a drive (floppy disk or logical drive) or folder. Dialog boxes
communicate information, receive commands, or both.

The third important element of the desktop is the menu bar. The

basic menu bar displays four menu headings: Desk, File, View,
and Options.
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When you first switch on your system, the desktop displays two
floppy disk icons, four hard disk icons, the trash can icon, pointer,
and menu bar. It will also display a cariridge icon if a cartridge is
inserted into the cartridge slot before you switch on the computer.

R B}

USING THE POINTER

LTS .
The pointer is the key to all desktop operations. You use the pointer
to select icons or menu options, and to move objects on the
desktop. You control the pointer either by moving the mouse or with
keystroke combinations.

Controlling the Pointer with the Mouse

o

The mouse supplied with the computer controls the pointer. By
moving the mouse, you can position the pointer anywhere on the
desktop. Roll the mouse over a clean, hard, flat surface such as a
tabletop. The computer detects the motion of the mouse (direction,
distance, and speed) and moves the pointer accordingly.

Place the mouse near the computer with the cable painting away
from you. Roll the mouse. Notice how the pointer moves on screen
as the mouse moves.

Note: If you touch the menu bar with the pointer a menu drops
down. Retract the menu by moving the pointer out of the menu and
clicking the left mouse button.

Controlling the Pointer with Keystrokes

You can use specific key combinations to move the pointer around
the desktop instead of using the mouse. To use keystroke combina-
tions. hold down the first key listed and press the second key (or if
three keys are listed, hold down the first two keys and press the
third key).

Note: See Appendix B for a quick reference chart listing the
keystrokes for controlling the pointer.
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Your screen is divided into tiny sections known as pixels. When
you use keystroke combinations to move the pointer, the pointer
moves either one pixel at a time or in multiple pixel jumps. Try
each keystroke combination to move the pointer.

« Alternate] combined with any arrow key moves the pointer eight
pixels in the direction of the arrow.

- [Alternate] [Shift] combined with any arrow key moves the
T pointer one pixel in the direction of the arrow. Use this
combination for fine positioning.

Selecting a Single Item

Selecting a item (icon or menu option) tells the computer you
want to use the item. When an item is selected it highlights, which
means it displays on the desktop in different colors from your
normal desktop colors.

The first two sections below explain how to select using either the
mouse button or keystroke combinations. In the sections that
follow, it will be assumed that you are using the mouse to move
the cursor or make selections. If you are using keystroke
combinations, just substitute the instructions under Selecting with
Keystroke Combinations.

Selecting with the Mouse Button

Clicking is the mouse operation used to select an item or initiate a
procedure. Most actions require you to use the left mouse button.
Only use the right mouse button if specified.

Single clicking selects and highlights only. Double-clicking
combines two single-click actions in quick succession to both
select and initiate a procedure.

To click, press and release the mouse button once. To double-
click, quickly press and release the mouse button twice. (Double-
clicking correctly may take some practice.)
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0 Note: To adjust the responsiveness of the mouse buttons to your
clicking speed, see Control Panel in Chapter Six.

Follow these instructions to practice mouse button clicking and
double clicking:

vighe o af v i
1. Position the pointer over the drive A icon.

2. Click the left mouse button once. The drive A icon highlights.
You have selected the drive A icon. Now move the pointer to
an open area of the desktop and click the mouse button to
deselect the drive A icon.

. 3. Now to practice double clicking (selecting and opening the
drive A window in one maneuver), again position the pointer
over the drive A icon. Now, double click the mouse button. A
window opens and displays the contents of the disk in drive A.

Note: |f you forgot to put the disk in the drive, an alert
message appears. Just place the disk in the drive, position the
pointer over the word OK, and click the mouse button. Try step
3 again.

4. To close the open window, position the pointer over the small

. box in the upper left hand corner of the window and click the

mouse button. The window closes.
Selecting with Keystroke Combinations

Using the keystroke combination [Alternate] [insert] performs the
same function as clicking the left mouse button. To perform a
keystroke double-click, hold down [Alternate] and quickly press -jag
[Insert] twice.

Follow these instructions to practice selecting and initiating a
procedure using keystroke combinations:

1. Position the pointer over the drive A icon.
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2. Press [Alternate] [insert]. The drive A icon highlights. You hate
selected the drive A icon. Now move the pointer to an open
area of the desktop and press [Alternatel [Insert] again to
deselect the drive A icon.

3. Now to practice keystroke double clicking (selecting and
opening the drive A window in one maneuver), again position
the pointer over the drive A icon. Now. hold down [Alternate]
and quickly press [insert] twice. A window opens and displays
the contents of the disk in drive A.

Q Note: If you forgot to put the disk in the drive, an alert
message appears. Just place the disk in the drive, position the
pointer over the word OK, and click the mouse button. Try step
3 again.

4_ To close the open window, position the pointer over the small
box in the upper left hand corner of the window and press
[Alternate] [Insert]. The window closes.

Selecting an lcon

There are two types of icons: desktop icons (floppy and hard disk
drive icons, printer and cartridge icons, and the trash can icon),
and window icons (folder and file icons). Remember, files and
folders can be displayed as either text or graphics.

You selected an icon when you practiced clicking on the drive A
icon. An icon that has been selected appears highlighted.

Selecting a Menu Heading

Each menu heading on the menu bar has its own drop-down
menu. If you move the pointer onto the menu bar near one of the
headings that menu immediately drops down and displays its
command options. Moving the pointer away from the dropped
menu to another menu heading causes the new menu to drop
down. and the previously displayed menu to retract.
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Follow these steps to practice displaying and choosing menu sl

options:
SR Tatsa B Taul i Nese g pregc
1. Position the pointer near the Options menu heading. The menu
drops down.

0 Note: A drop-down menu may have both active and inactive
command options. Active options are in bold text and produce
an action when selected. Inactive options appear as lightened
text. Selecting an inactive option causes the menu to retract.
Options with a check mark to the left of them are currently
selected.

.2. Position the pointer over the Save Desktop command option.
The command highlights.

3. Click the mouse button. A dialog box appears, asking if you
really want to save the desktop.

0 Note: The box in bold type surrounding the word OK denotes
the default selection. You can always choose a default
selection by pressing [Return].

=i+ Select Cancel by positioning the pointer over the word Cancel
in the dialog box and clicking once. The dialog box disappears.

To retract a menu without selecting a command option, just move
the pointer outside the menu and click the left mouse button.

Dragging

Holding down the mouse button and moving the pointer is called
dragging. You can also use a key combination to perform
dragging.

Dragging moves icons from one place to another. After you select
an icon, you can drag the selected icon to a new location. You
can perform different operations by dragging, depending on the
icon type and the icon’s destination. You also use dragging to
create a rubber-band box to select multiple icons. (See Selecting
Multiple Icons.)
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Dragging with the Mouse

Using the mouse to drag is easy. Just move the mouse while
holding down the mouse button. Any selected icon or group of
icons will be dragged. The pointer must be positioned over the
selected icon or group of icons for successful dragging.

&
Dragging with Key Combinations

To drag with keystroke combinations, press [Alternate] [Insert]
combined with any arrow key to drag a selected icon or group of
icons in the direction of the arrow. The pointer must be positioned
over the selected icon or group of icons for successful dragging.

Dragging an lcon

.1

You need to drag to perform copy, move, or delete operations.
After you drag an icon or icons to a new destination and release
the mouse button, the icon or icons will be copied, moved, or
deleted, depending on the operation performed.

When you drag icons from one location to another, a ghost outline
of all selected icons follows the cursor from the original location to
the destination. The pointer shape also changes from a pointer to
an outline of a hand until you release the mouse button.

You will use the move operation to practice dragging. The copy
and delete operations will be explained in later sections of the
tutorial.

Now practice dragging using one of the described methods. Move
the desktop icons into different configurations. If you accidently
drag one icon on top of another icon, a special window called a
dialog box will display. Select Cancel. The window disappears,
and the moved icon will return to the position it occupied before
you moved it.

0 Note: You can also drag more than one icon at once. See

Selecting Multiple Icons.
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Selecting Multiple Icons e

G . 4 .y .
Sometimes you will want to select more than one icn at a time to
perform delete, copy, move, or other operations. There are two
ways to select multiple icons.

The first way is using the rubber band box to select icons that are
grouped together on the desktop or in a window. You use the
pointer to create a box on screen to surround the icons you wish
selected. The box is called a rubber-band box because it expands
or contracts when you drag the pointer.

You can use shift-clicking to select multiple icons individually
instead of having to select items that are physically grouped
together. The selected icons do not have to be in sequence on a
list, or near each other on the desktop.

Both methods of selecting multiple icons can be used on desklop
or window icons.

SELECTING WITH THE RUBBER-BAND BOX

Whenever you drag the pointer, a rubber-band box appears on
the screen. The first corner of the rubber-band box is created .,
wherever the pointer is positioned on the screen. The box
expands in the direction of pointer movement.

Follow these steps to practice selecting multiple icons with the K
rubber band box:

1. Position the pointer above and to the left of the drive A icon.
Try not to touch the nearby menu heading. If the menu drops
down, just retract the menu and try again.

2. Now drag the pointer down and to the right. The rubber-band
box appears and expands with the pointer.

3. Surround the drive A and B icons with the rubber band box.
Release the pointer. The icons highlight.

4. Move the pointer fo a clear area of the desktop and click the
mouse button to deselect the icons.
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SELECTING BY SHIFT-CLICKING S

Shift-clicking lets you select multiple items that are not next to
- each other on the desktop, or in sequence in a window.

To

practice selecting by shift-clicking, follow these steps to select

the drive A and C icons:

1. First, select the drive A icon.

2.

4
ot}

Now hold down [shift] and position the pointer over the drive C
icon. Click the mouse button. Both the drive A and drive C

_ icons are now highlighted. The drive B icon in the middle

o

remains unselected.

Note: You must hold down [Shift] until all desired icons are
selected. Once you release [Shift], no further icons can be
added to the selected group. If you attempt to select an icon
after you release [Shift], all previously selected icons will be

deselected.

_ Move the pointer to a clear area of the desktop and click the

mouse button to deselect the icons.

SELECTING BY COMBINING RUBBER-BANDING AND SHIFT-CLICKING

You can combine rubber-banding and shift-clicking to select a
group of icons, then deselect any icons you don't want in the

group.

Follow these steps to practice combining the two methods of
selecting multiple icons:

1.

2.

3.

First. use rubber-banding to select all three drive icons.

Now use shift-clicking to deselect the drive A icon. Only the
drive B and C icons are highlighted.

Now use shift-clicking to reselect the drive B icon. All three
icons are again highlighted.
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4. Move the painter to a clear area of the desktop and click the
mouse button to deselect the icons.

For additional practice, try selecting and dragging more than one
icon at once.

USING WINDOWS 3 o

Most of the desktop activity takes place in windows. Windows &re
small screens within the larger screen display. You can have up to
seven windows displayed at one time. When a window is
displayed on the screen it is open.

Opening and Closing a Window

You can only open directory windows. Dialog boxes simply
appear during certain operations or to give you information.
Directory windows can be opened in several ways by using the
pointer and mouse button. The first window you will open is the
drive A directory window. Make sure the USA Language disk is in
drive A before you begin.

One way to open a window is to double click on the desired
desktop icon. Open the drive A window now by moving the pointer
over the drive A icon and double clicking. The contents of the
drive appears in the drive A directory window.

it means that the TT has not recognized your click as a double
click. but only as a single click. Move the pointer to a clear area of
the desktop and click once to deselect the icon. Try again, and
remember that double clicking can be a bit tricky at first. Just keep
practicing.

0 Note: If the drive A icon highlights but the window does not open,

Now you need to close the drive A directory window. In the upper
left corner of the window is a small box containing an X icon. This
is the close box. Move the pointer over the close box and click
once. The window closes.
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Another method of opening a window uses the menu bar. Open
the drive A window again by selecting the drive A icon. The icon
highlights, but does not open. Now select the Open command
from the File menu. The drive A directory window opens.

Now close the window by selecting the Close Top Window
command from the File menu.

There are other ways to open windows and programs that will be
discussed in other sections of the manual.

Window Elements e &

You have already learned about the close box in the upper left
hand corner of most windows. The following example displays all
window elements. Some are explained here, and others will be
explained as you use them in the tutorial.

Drive Wdenbifier
Close Box L File Mask  Move Bar Full Box
1Y s e AR i i
Bytes Used— 119770 bytes used in 4 items. — T ion Line
— n 2]
FRE =
CONTRDL .ACC DES: « IvF LOGD PEG oG JREC
e ——1. ! ! 1 ‘J‘—‘
o A | “Tolw, — Scroll Bars
Scroll Arrow Scroll Box Size Box

The Drive Identifier appears in the center of a window’'s move bar.
It shows the drive letter of the open drive. in this case floppy drive

A.

The File Mask tells you what type of files are displayed in the
window. You can set the File Mask to display all the files in a
directory, or you can set up restrictions on the types of files
displayed. The window displays an icon for each folder in the
directory, and for every file in the directory that matches the file
mask setting. For more detailed information on setting the File
Mask. see Set File Mask in Chapter Four.
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The Information Line displays the Bytes Used (total number of
bytes of disk space used by the contents of the directory), and
ltems (the number of files and folders residing within the
directory).

The other elements of a window are explained in the following
tutorial sections.

The Active Window

When you have more than one window open at a time, you can

only work with the files and folders in the active window. In

addition, you can move, scroll, update, or resize only the active A
window. You can identify which window is active by looking at the
move bar. Only the active window’s move bar is shaded.

You can open up to seven windows on the desktop. You can
make any window the active window by positioning the pointer
anywhere on the window and clicking the left mouse button.

Open windows-may overlap. If they do, the active window is
always completely displayed. Activate a partly hidden. inactive
window by positioning the pointer anywhere on the window and
clicking the left mouse button. The active window moves to the
front and displays over the other windows.

Sizing a Window

Sizing windows is especially useful when you want to display
more than one window on the desktop at one time. To practice
sizing a window, follow these steps:

1. Open the drive A directory window.

2 Locate the size box in the lower right corner of the window.
Position the pointer over the size box and use dragging 1o
move the size box up and to the left. An outline of the window
follows the pointer movement. Release the mouse button when
the window outline is about half of the original window size.
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3. Now locate and select the full box in the upper right corner of
the screen. Selecting the full box expands a window to fill the
entire screen.

4. Select the full box again. The window returns to the most
recent size and position.

5_ Continue to practice sizing the window. Drag the size box down
towards the bottom of the screen to lengthen the window, up to
shorten the window, right to widen it, or left to narrow it. When
you have finished practicing, close the window.

& S0

Moving a Window

You can use the move bar to move a window to any screen
position below the menu bar. Follow these steps to practice
moving a window:

1. Open the drive A directory window.

2. Double click on the SAMPLE.PRG icon. The Sample window
displays. Resize the window to about one half its original size.

3. Position the pointer over the shaded move bar. Use dragging to
move the window to a new position on the screen, then release
the mouse button. The window displays in its new position.

Note that when you dragged the window the cursor appeared
as a hand icon, and an outline of the window followed the
movement of the hand cursor until you released the mouse
button.

4 Close the Sample window. Close the drive A directory window.
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Sometimes a single directory will contain too many items to
display in a window at one time. When this occurs, some of the
directory items remain undisplayed, or hidden. You can view the
hidden items by using the scroll bars. The scroll bars along the
bottom and right edges of the window let you scroll the window
horizontally (right and left) or vertically (up and down).

If a directory contains more items than will fit in the window, a
portion of the scroll bar will be shaded. The scroll box shows the
current position of the window relative to its total directory. If there
is gray above or below the scroll box, more of the directory is

_ available by scrolling the window in the direction of the gray area.

There are three ways to scroll a window: entry by entry, one
window display at a time, or continuous scrolling. To practice
scrolling, follow these steps:

1. Open the drive A directory window.

2. Decrease the window's size until only two directory items are
displayed, one on top of the other.

3. To scroll by one directory entry at a time, position the cursor
over the scroll arrow that indicates the direction of the hidden
contents. Click once. Now click once on the opposite arrow o
return to the original window display.

4. To scroll by one window display at a time, position the cursor
over the shaded area of the scroll bar. Click once. The
previously displayed items are now hidden, and the screen
displays previously hidden items.

Another way to accomplish this is by using the up and down
arrow keys to the right of the main keyboard. Each time you
press an arrow key the previously displayed items are hidden,
and the screen displays previously hidden items.

5 To scroll entries continuously, position the cursor over the scroll

arrow that indicates hidden items. Hold down the left mouse
button.
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6. To scroll entries continuously one window at a time, position the
cursor over shaded area of the scroll bar. Hold down the left
mouse button. e

THE I %
You can also skip over some of a directory’s contents by
dragging the scroll box to 2 new position in the scroll bar. The
window will now display the contents of that portion of the

directory.

7. When you have finished practicing scrolling, close the drive A
directory window.

0 Note: Directory windows displayed as text instead of icons cannot
be scrolled horizontally. (See Show as Icons and Show as Text in

Chapter Four.)

USING FLOPPY DISKS

Fioppy disks serve as permanent storage for programs and the
information you create. TT computers use 3Vz-inch disks that
consist of a 3%2-inch rectangular plastic casing holding a circular
sheet (disk) of oxide-coated material. This material is the magnetic
media which holds data and which the disk drive reads. Its
accessible section is protected by a sliding metal sleeve. Most
floppy disks also have a write-protect sliding tab. (See Write-
Protecting a Floppy Disk in this chapter.)

i

Floppy disks can be either single-sided or double-sided. Both types
of disks look the same. On a single-sided disk, only one side of the
magnetic disk is certified by the manufacturer as safe for storing
information. Both sides of a double-sided disk are certified. A
single-sided disk can store up to 357,376 bytes of information; a
double-sided disk can store up to 726.016 bytes of information.
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Formatting a Floppy Disk - &

You must format a new floppy disk before you can store programs
and data on the disk. Formatting prepares a floppy disk by
completely erasing the disk’s contents, checking for damage to
the magnetic media, and setting patterns in place to hold
information. Floppy disks formatted by your computer are format
compatible with MS-DOS computers. This means information
written to a floppy disk formatted on your computer can be read
by MS-DOS computers and vice versa.

Single-sided floppy disks must be formatted as single-sided.
Floppy disks formatted as single-sided can be used in both single
and double-sided floppy disk drives. However, you can format
floppy disks certified for double-sided use as either double or
single-sided. Floppy disks formatted as double-sided can be used
only in a double-sided drive.

You can also reformat previously used floppy disks. Since
formatting erases all information on a disk, it is sometimes more
efficient to reformat a floppy disk than to delete all of a floppy
disk’s files.

@ Warning: Formatting a floppy disk permanently erases all

information on the disk. Before you format any floppy disk, be
sure to copy any data you want to save. (See copying Files and
Folders in this chapter.)

To format a disk, follow these steps: |

1. With the computer switched on and the desktop displayed, =
insert a blank, unformatted floppy disk into drive A.

o Note: If you have two floppy disk drives on your system, you
can format a disk in either drive A or drive B.

2 Select the Format Floppy Disk command from the File menu.
The Copy/Format dialog box displays.
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Note: Both Copy and Format operations are combined in one
dialog box so you can format, and then copy disks without
returning to the desktop after formatting. If you select the
Format option and decide to copy a disk instead, click on

COPY. You can also click on FORMAT

after initiating a disk

copy operation if you must format a disk first.

3. If you wish the disk to have a label, type in the label. Then

select the disk drive on which you want

to format a disk. The

default is the disk drive you selected in step 2. Select SINGLE
or DOUBLE sided, depending on how you want to format the

disk.
4. Select OK.

: displays formatting progress.

s

The disk drive begins formatting the disk. The indicator bar

0 Note: You must have a double-sided disk in a double-sided
drive to use the double-sided format option. (The built-in drive
is double sided.) Once you format a floppy disk as double-
sided, you can only use itin a double-sided drive. You may

format a double-sided floppy disk as single-sided, but only one

side of the disk will be used.

5 When formatting is completed, an alert
telling you that a double-sided disk has
a single-sided format) bytes available.

Select OK.

message appears
726.016 (or 357,376 for

gt el

Warning: If the computer does not report that the formatted
disk can hold 726,016 bytes of information for a double-sided

disk or 357,376 bytes of information for a single-sided disk. the
disk may be defective. Try formatting the disk again. If the

problem persists, discard the bad disk and use another disk.

6. To return to the desktop select Cancel.
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Note: If you try to use a disk without first formatting it, or if you try

to use a double-sided disk in a single-sided drive, the computer

displays an alert dialog box. The dialog box tells you that the disk

. drive is not responding, and to please check the disk drive, or

insert a correctly formatted disk into the drive. Then you must

. 3g|5c)l Retry or Cancel (to tell the drive not to attempt to read that
isk.

Repeat the formatting process with the other blank, unformatted
floppy disk.

Copying a Floppy Disk

It is essential to make a backup copy of all important disks. This
protects you against loss of important files. Since it is especially
important to make a backup copy of the USA Language disk and
Advanced Hard Disk Ultilities disk supplied with your computer,
you are going to make copies of the two disks now. After you
make the copies. store the original disks and use the backup
copies as your working disks.

You will copy the original disks supplied with your computer onto
the two floppy disks you just formatted. The original disk is known
as the Source disk, since it is the source of the information. The
disk you are copying to is the destination disk. A destination disk
need not be blank, but all data on it will be overwritten (erased)
during copying. You cannot copy a double-sided disk to a single-
sided disk, or vice-versa. .

sini »
For systems with only one floppy disk drive, the internal floppy
drive is both drive A and drive B. This enables you to use a single
floppy disk drive to copy and move files between disks. During
disk copying operations, the source disk is disk A and the
destination disk is disk B, or vice versa. Dialog boxes appear
during the copy operation to tell you when to remove one floppy
disk and insert the other floppy disk. For systems with two floppy
drives, the internal floppy disk drive is drive A and the second,
external floppy disk drive is drive B, so you don’t have to swap
floppy disks when copying files from one disk to another.
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To copy an entire disk, follow these steps:

1. With the computer switched on and the desktop displayed,
insert the source disk (USA Language disk) into drive A. If you
have two disk drives, insert the source disk into drive A (the
internal floppy drive) and the destination disk (formatted floppy
disk) into drive B (the external floppy drive).

0 Note: If you have one double-sided disk drive and one single-

sided disk drive, you cannot copy an entire disk using the disk
copy operation. You must iransfer the files and folders from the
source drive to the destination drive. For detailed instructions
see Copying Files and Folders in this chapter. O

2. Drag the drive A icon onto the drive B icon. When the floppy
disk icon for drive B highlights, release the mouse button.

3. An alert dialog box appears. warning you that copying the disk
in drive A to the disk in drive B will erase all information on the
disk in drive B.

If you have two floppy disk drives, make sure the source and
destination disks are in the correct floppy disk drives before
proceeding. Then select the OK button. The Copy/Format
dialog box appears.

4. Select OK to begin copying the source disk. The copy indicator
bar shows the progress of the copying process.

0 Note: If you have one disk drive, the computer prompts you

(with alert dialog boxes) to switch disks from time to time as it
copies and then writes sections of information.

5. When copying is completed, select Cancel (or press [Return])
1o return to the desktop.

Now repeat the procedure, making a backup copy of the
Advanced Hard Disk Ulilities disk onto another formatted floppy
disk. Store the original disks in a safe place. and use the copies
for all future operations.
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Write-Protecting a Floppy Disk | a5

Write-protecting a floppy disk prevents information from being
written to the disk. To write to a disk means to store information
on the magnetic media. (Similarly, to read a disk means to
retrieve information recorded on the disk.) The floppy disk drive
and computer work together to write information from the
computer's memory onto the floppy disk, or to read information
from the floppy disk into the computer's memory.

Most floppy disks have a small write-protect tab in their plastic
casing. Write-protect the working copy of the Advanced Hard Disk
Utilities disk now by sliding the tab until the notch is completely
exposed.

0 Note: Write protect 5 V4 inch floppy disks by covering the write-
protect notch with special tape supplied with the floppy disk.

You cannot write to, format, or erase a write-protected disk. It is a
good idea to write-protect disks containing important information
so you do not inadvertently erase information from the disk,
especially when copying disks with a one-drive system. You can
move the write-protect tab back to the unprotected position at any
time.

)
Note: Some commercial program disks may not have write-
protect tabs. These disks are permanently write-protected.

COPYING AND DELETING FILES AND
FOLDERS

You have already learned how to copy an entire floppy disk. But
most of the time you will want to copy selected files and folders

from one drive to another, or delete files or folders from a drive.

This section will explain how.

b
g L
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Copying = 18 S
You will be copying fiieé ‘é'n.d' folders from one disk to another. The
same file copy procedure below also applies to copying folders.

To practice copying files and folders, follow these steps:

1. Display the drive C directory window.

2. Drag the SAMPLE PRG file icon onto the drive D icon. The
Copy Files dialog box displays. Select OK.

The SAMPLE.PRG file will be copied onto logical drive D. Display
a directory of drive D to make sure the file reached its destination.

Deleting .

There are two ways to delete a file or folder. You can drag the
item to be deleted onto the trash can icon, or select the item to be
deleted and select Delete Item from the File menu.

To practice deleting a file, follow these steps:

1. Display the directory for drive D.
a,
2. Drag the SAMPLE.PRG icon onto the trash can icon. Release
the mouse button. A dialog box appears, asking if you really
want to delete the file. Since we are just practicing and we do
not want to delete the file yet, select CANCEL. Selecting OK
would have deleted the file.

3. Now you are going to practice the other method of deleting
files. Repeat step 1. Now select the SAMPLE.PRG icon. The
icon highlights.

4 Select Delete Item from the File menu. A dialog box appears,
asking if you really want to delete the file. Select OK. When the
delete operation is complete, the SAMPLE.PRG icon
disappears from the directory. Close the drive D directory
window.
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Note: Only if the Confirm Deletes option (see Set Preferences in
Chapter Four) is active will the dialog box appear to confirm the
delete action.

You can use the same delete operation to delete the entire
contents of a disk. !f you just want to remove an icon from the
desktop, see Remove Desktop Icon in Chapter Four.

w
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CHAPTERFOUR « = =+
ADVANCED DESKTOP - . - ..«

This chapter continues where the tutorial left off and explains
advanced desktop functions such as: updating a directory display.
entering information when a dialog box displays, and advanced
menu bar commands.

UPDATING A DIRECTORY DISPLAY

Being able to update a displayed directory is useful when you are
working with floppy disks. If you insert a disk into drive A and
display that disk’s directory. and then remove that disk and insert
a new disk into drive A, the window does not automatically display
the new disk’s directory. You can update the directory displayed in
the window by pressing [Escl. Your computer will read the
directory of the disk that is currently in the drive, and display that
directory in the window.

Displayed directories update automatically after you copy. move,
or delete a file or folder, or copy or format a disk.

DIALOG BOXES AND ALERT BOXES

Your TT computer can communicate with you through dialog
boxes which request information, and alert boxes which warn you
about an action. Some dialog boxes ask you to supply information
or make a choice. Use the keyboard or mouse to make a choice
or supply the information needed. An |-bar text insertion cursor
indicates where the next typed character will appear on a text
field.

Some dialog boxes contain more than one field requesting
information. To select a field, position the pointer over that field.
Click once. The cursor jumps to that field.
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The following keys provide additional functions

« Lelt Arrow -- Moves the cursor one character 1o the left within a
field.

« Right Arrow -~ Moves the cursor ene character to the nght within
the field

- Down Arrow — Moves the cursor to the next field
- Up Arrow — Moves the cursor to the previous field
- [Tabl -- Moves the cursor to the next field {same as Down Arrow’

. [Backspacel] - Deletes the character or space to the left of the
cursor.

+ [Delete] -- Deletes the character or space to the right of the
cursor

- [Esc] -- Clears the current field

« [Return] - Selects the default dialog button if one 1s present A
bold border around the button indicates the default button

Some fields contain punctuation marks such as penods t ) or back
slashes (\1 to divide text To advance past a punctuation mark.
type that mark For example. you may see a field with a period
dividing the field. such as the period that separates a file's name
from the extension Type a penod to advance to the second part
of the field

When the computer needs to communicate with you a dialog box
appears in the center of the deskiop Torespondlo a dialog box
type in the requested answer of perform the requested action.
Then select ane of the dialog buttons If a dialog button has an
enlarged barder. itis the default button and can be selected by
pressing [Return]

The computer uses alert boxes to bring something to your atten-
tion. Alert boxes contain stop signs. question marks. or
exclamation points, and may either caution you about an intended
action or tell you that something went wrong.

When you see an alert box. tollow its instructions. then select the
appropriate dialog button
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THE MENU BAR

The top edge of the desktop contains the menu bar The menu
headings are Desk. File, View, and Options To see the
commands within any menu heading. position the pointer over the
menu heading The heading highlights and the menu displays
under the selected heading.

When the menu displays you can select an option Options In
black text are active and available for use Options in light text are
inactive Inactive options are not available for use at the time you
display the menu. (See the specific option later in this chapter for
more information.)

Most of the commands listed under the menu headings can be
selected by using a single keystroke. Each command's keystroke
s listed In brackets to the right of the command name To initiate
the command. just press the key indicated It saves a lot of time If
you memorize the keystrokes for the commands you use
frequently. You can change the assigned keystroke of a
command. or assign a keystroke to a command that does not
have one. (See Desktop Configuration in this chapter )

Desk Menu

The Desk menu is divided into two sections The top section
usually contains a single entry which. when selected, displays
information about the application you are working with This
information can be a complex series of windows explaining In
detail how the application works, or it could be a single dialog box
display of copyright information.

The lower section lists your active desk accessories To be active.
a desk accessory file must have the extension ACC and must be
on the root directory of drive C (or on a floppy startup disk in drive
A } when you switch on the computer
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You can open desk accessories from the desktop or from any
application that displays the menu bar. The desk accessory
included on your USA Language Disk is the Control Panel
(XCONTROL.ACC). For detailed information on the Control Panel.

see Chapter Six.

Switching on the computer without active desk accessories frees
some RAM and displays the desktop faster

Desktop Info

When you display the Desk menu from the desktop. the top section
of the menu lists the Desktop Info option. If you select Desktop Info.
a window listing GEM and TOS copyright data displays.

File Menu

The File menu contains options for opening and closing directory
windows. selecting all displayed files and folders for an operation,
deleting a file or folder, creating a folder. formatting disks, and

more. This section explains in detail each File menu option

Open

The Open command can be performed on a disk or cartridge icon,
tolder. or file. printer icon, or trash can icon.

First select the item you wish to open. Then select Open from the
Eile menu. The result of the command depends upon which of the

following was highlighted:

Disk icon or folder- the disk or folder directory window
appears.

Cartridge icon (drive c) or executable file- The desktop
disappears and the program runs.
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Printer icon- An alert box displays informing you that the icon
you attempted to open is a printing device.

Trash icon- An alert box displays.

Data file- If you have installed an application that 1s linked to
the same document type as the data file you are opening. the
application will automatically open and load the data file. If no
such application is installed, a dialog box displays, giving you
the choices show, print, or cancel. Show displays the contents
of the file on the screen as ASCII characters. Print prints the
contents of the file {(only if you have a printer connected to your
system!), and Cancel cancels the command.

Note: An alternative to using the Open menu command is to
position the pointer over the icon you wish to open and double-
click the left mouse button.

Show Information

When you highlight a floppy disk. logical drive. folder. or file icon
and select the Show Info option, the screen displays information
about the highlighted item.

When you select Show Info for a floppy disk or logical drive icon.
the Disk Information dialog box displays the following information:

Drive ID- The drive's letter identifier.

Disk Label- The name you assigned to the drive. (This field
can be blank.)

Number of Folders- The total number of folders on the disk
of logical drive, including folders within folders.

Number of Files- The total number of files on the disk or
logical drive, including files within folders.

Bytes used- The number of bytes used by all files and folders
on the disk or logical drive.

Bytes available- The available storage space (measured In
bytes) left on the disk.
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Note: In the Disk Information dialog box, the number of bytes
used plus the number of bytes available for a floppy disk or logical
drive does not always equal the exact total storage capacity. This
is because the computer allocates space for each file in fixed-size
blocks, even if the file does not completely fill the last block. The
Bytes Available information is an accurate indicator of available
unused storage space.

When you select Show Info for a file or folder, the File Information
dialog box or Folder Information dialog box displays the following
information:

Path- The top line lists the complete path of the file or folder. If

the path is too long to display on the line, you can use the scrall .

arrows to reveal the hidden part of the pathname.

Name- The name of the folder or file. The text insertion cursor
appears to the right of the name. To change the name of a file
or folder, press [Esc] to clear the name line. Type in the new
name., using eight characters or less. Type a period, then the
three character file extension (usually not used in folder
names).

Size- Size, in bytes of the file or folder. Folder size is the total

i number of bytes used by all the files within the folder.
Sn

Date- The date the file or folder was last modified.

Time- The time the file or folder was last modified.

Number of Folders- The number of folders within the folder.
This only applies to folders.

Number of Files- The total number of files within the folder,
including files within other folders. This only applies to folders.

Attribute- The two choices are Read Only and Read/Write. If

se you want to make sure a file remains intact and no changes

are made to it, select Read Only. You will still be able to display
and copy the file, but you cannot modify or delete it.
Read/Write allows you to read the file, change it, or delete it.
The Attribute field does not apply to folders.
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The Search command performs a file search on a floppy disk,
logical drive, or folder. When you select Search, the Search File

dialog box appears. You must set the parameters of the search by
typing in the name of the file for which you are searching. You can

also type in part of a filename, and Search will match the typed
characters. For example, if you wish to search for all files with the

extension .DOC, type a period, then type DOC. Search opens the

window containing the first DOC file it finds and asks you if it
should continue the search. If you select OK, Search will use the
same window to show the next .DOC file, and so on. When
Search can find no more .DOC files, an alert box displays to let
you know that no more files are to be found.

Before selecting Search, you should highlight the floppy disk,

logical drive, or folder upon which you wish the search performed.

If no item is highlighted, Search will perform the command upon
the active window. If there is no open window on the desktop and
no highlighted item, you cannot select Search from the menu.

0 Note: The Search dialog box may cover highlighted icons.

Delete

The Delete command deletes all highlighted files and folders. If
you highlight a floppy disk or logical drive icon and then select

Delete, all files and folders on the highlighted item will be deleted.

The icon remains on the desktop.

Create Folder

The Create Folder command creates a new folder in the active
window. When you select this command, the New Folder dialog
. box appears. Type in a name for the folder, then select OK (or
° press [Return]). The name of the new folder appears in the
directory window.
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0 Note: _Certain chgracters cannot be used within a folder name or
extension. For a list of illegal characters, see Files and Filenames
in Chapter Five.

Close Directory

The Close Directory comtr:nand closes the top level of the active
window. For example, let's say the top window is a folder window,
and that folder resides in the main directory of drive C. When you
select Close Directory, the folder's window closes, and the main
directory window displays.

Note: You can also close a directory by selecting the close box in
the window's upper left corner.

eyt

Close Top Window

The Close Top Window command completely closes the active
window. including all levels of folder windows and the main
directory window. |f windows from other floppy disks or logical ”
drives are open on the desktop, the most recently opened window
becomes the active window.

Bottom to Top

The Bottom to Top command is useful when you have multiple,
overlapping windows displayed on the desktop. When you select
this command, Bottom to Top brings the bottom window to the top
of the stack and displays it as the active window. The current
active window is sent to the bottom of the stack.

Select All Items

The Select All ltems command highlights all files and folders in the
active window. The files and folders that are hidden, but would be
shown by scrolling, are also selected. However, files that are in
the directory but do not match the file mask parameters are not
selected. (See Set File Mask.)

Advanced Desktop
4-8

TT manual Page 67

il

Siolid b5 o



0 Note: If the File Mask is *.* (show all items), then all items,
including all folders, are selected. If the File Mask is set to show a
se:ecleg filename or file extension or both, folders will not be
selected.

Set File Mask

The Set File Mask command allows you to choose the file type to
be displayed in the active window. When you select this
command. the Set File Mask dialog box appears. You must fill in
the file type parameters, both file name and file extension.

For example, if you want only those files beginning with the letters
"DESK" to appear in the directory list, you would press escape to
clear the Name line. Then you would type DESK* * and select
OK. The first asterisk after the word DESK means that any file
with characters in the filename following the letters DESK should
be displayed. The asterisk is known as a wild card character. (See
File Specification in Chapter Five). The period is the separation
between the filename and the file extension. The second asterisk
means any file with a filename that meets the parameters should
be displayed no matter what extension the file has. Setting the file
mask as described here would display files with different
filenames and extensions, such as NEWDESK.INF and
DESKACC.DOC, as long as the filename begins with the
characters DESK.

The default file mask parameter is an asterisk for the filename and
an asterisk for the extension. This means all files are displayed.

o Note: Folders are not affected by Set File Mask.
The parameters selected for the open window remain in effect as

long as the window remains open. Once you close the window,
the parameters you chose are cleared.

FE Y
Format Floppy Disk
Formatting prepares floppy disks to accept data. You can format

disks as either single or double-sided. Used disks can be
reformatted.
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All disks formatted with TOS can be read by IBM PCs and
compatible computers using MS-DOS version 3.2 or later.

To format a floppy disk, insert the disk into a floppy disk drive.
Select the floppy disk icon, then select the Format command. For
complete information on formatting disks, see Formatling a Floppy
Disk in Chapter Three.

View Menu

The View menu lets you choose the way your computer displays
files and folders.

You can view files and folders as icons or text. You can display
those filenames alphabetically by name (filename or extension),
or numerically by date or file size. To modify the display, select
the menu option you want. A check next to a option indicates that

option is selected.

Options selected from the View menu affect all directory windows.
You cannot select one option for one window and a different
option for another window.

0 Note: When you save your desktop, TOS saves all the View
menu choices you made to the NEWDESK INF file on your startup

disk. (See Save Desktop in this chapter.)

-
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Show as lcons or Show as Text

The same directory, with entries displayed both as icons and as
text, is shown below:

119778 butes used in 4 items.
== .k

COMTROL.ACC DESKTOF . INF LOGO PR3 LOGO .RSC

<l B8
ml ' :
119778 butes used in 4 itens.
CONTROL ACC 15616 11-20-85 12:03 an ©|
DESKTOP INF 478 11-20-85 12:03 am
LOGO PRG 98770 11-20-85 12:083 anm
LOGO RSC 4906 11-206-85 12:84 anm =
] [o]F

When directory entries are shown as icons, different icons indicate
ditferent types of files or folders. The window displays icons in
horizontal rows across the desktop. You can choose the shape of
desktop and window icons. See Install icon in this chapter.

When directory entries are shown as text, the window displays the
filename, file size, and the date and time the file was last modified.
A square icon to the left of a filename indicates a folder. The
window displays files and folders as vertical text.

0 Note: A triangle symbol appearing next to a file name indicates a
read-only file.

Files and folders displayed as text may be opened, copied, and
deleted using the same procedure used with icons.
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Sort by Name/Date/Size/Type

It is sometimes necessary for you to have a list of your files and
folders presented in a certain order. Folders as a group are
always listed first, followed by files (Except with the No Sort
Option). You can sort your files and folders in the following ways:

« Sort by Name-Lists files and folders in alphabetical order

« Sort by Date=Displays files and folders chronologically. The
most recently created or revised file or folder appears first

« Sort by Size—Lists files and folders according to their size in
bytes _

« Sort by Type-Lists files alphabetically according to their
extension type. Files with common extensions are grouped
together in alphabetical order by filename

« No Sort—Lists files and folders according to the order in which a
program would recognize them

Size to Fit

When you select Size To Fit, all icons are displayed in horizontal
rows starting at the top of the window. Each row is only as wide as
the window and will automatically resize whenever the window is

resized.

Set Color and Style

Set color and style allows you to create a unique desktop
environment. You can use Set Color and Style to choose a color
and fill pattern for both your desktop and for opened windows.
When you select Set Color and Style, the following dialog box

appears.
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et Dessiopminson——t=Set: [Desktop] TN ‘
,

SET COLOR AND STYLE

'
H H
- -

Fill Patterns————1* g ] I:] |

Color Palene

Preview Window

In the example the Desktop box is highlighted. This allows you to
modify your desktop display. To modify the window display, the
Window box must first be highlighted.

To create your desktop environment, follow these steps:

1.
2.

Highlight the Desktop box.

Position the pointer over the solid black Style square and click
once.

_To select a color, position your pointer over the desired color

on the color palette and click once. The color displays in the
Preview Box. (If you are using a monochrome monitor, position
your pointer anywhere on the black section of the color palette
and click once.)

_ To select a fill pattern, position your pointer over the desired fill

pattern and click once. The fill pattern displays over the color in
the Preview Box.

_ Next highlight the Window box and repeat steps 2 through 4 to

modify your window display.

_ Select OK to select the chosen options and exit Set Color and

Style.
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Options Menu

o

The Options menu includes commands that allow you lo save
your desktop configuration. install icons applications. and
devices and print what i1s displayed on your screen You can use
the Set Preferences oplion under the Options menu to switch
confirmation dialog boxes on or off and set your screen resolution

Note: When you save your desktop. TOS saves ali the Options
menu choices you made to the NEWDESK INF file on your startup
disk (See Save Desktop In this chapter * Use Save Desktop to
save changes made with Options menu commands

Install lcon

install icon allows you to choose the shape of your window and
desktop icons The DESKICON RSC file an your C drive or floppy
startup disk contains a collection of detailed icon shapes. You
access this file through Install icon Choose irom a vanely of icons
to create an interesting and entertaining deskiop.

You can also use Install lcon to change a floppy disk s or logical
drive's icon identifier and icon label

When you select Install Icon from the Options menu, the select
icon type dialog box displays. You can select either Desktop or
Window Desklop icons are device icons ‘printer. floppy disk
drive. logical drive, and cartndge!. and the trash can icon. Window
icons are folder and file icons

DESKTOP ICON

When you select Desklop ticon!, the following dialog box displays

Advanced Desktop
4-14

TT manual Page 73



SojAes; . INSTALL DESKTOP ICON : o 3
Bas o Tcon Identifier: Lt s
Rl ot Icon Label: EETR]
Icon Type!
ICIITTIM (Trash can] [Printer ]

HiTE 15‘&! [ Icon Shape: @ R

[ [Skip ] [eancel]

To install a single desktop icon, follow these steps:

1.

If you are installing a floppy disk or logical drive icon, typé the
drive identifier letter. Press [Tabl.

. Type in the name of the floppy disk or logical drive. You can

use up to 12 characters. This step is optional; you do not have
to assign labels (names) to your desktop icons.

. Position your pointer over the type of icon you wish to install:

Drive, Trash Can, or Printer (see Using an Installed Printer Icon
later in this section). Click the mouse button once.

. Use the scroll arrows to scroll through your icon choices. When

the desired icon displays, select OK to install. The icon appears
on your desktop.

You can also assign an icon shape to a group of desktop items.
For example, if you want all of your logical drive icons to have the
hard disk icon shape, in the same operation you can assign that
shape to all logical drive icons.

To assign an icon shape to a group of desktop items, follow these

1

steps:

. From the desktop, use rubber-banding or shift-clicking to

highlight the group of desktop items.
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2. Select Install Icon from the Options menu. The Install Desktop
Icon dialog box displays. The drive identifier, icon label, and
currently assigned icon shape of the first selected desktop item
appears in the dialog box.

3. If the Drive box is not highlighted. position your pointer over the
Drive box and click the mouse button once.

4. Use the scroll arrows to display the desired icon shape. To
assign that icon shape to the first of the selected group of
items. select OK . The second item of the selected group
displays in the dialog box.

0 Note: If you do not wish to assign a new icon shape 1o an item
in the selected group, select Skip when that item displays in the
dialog box. That item will retain its current icon shape.

When yoﬁ have completed the selection process for the final item
in the selected group, the dialog box disappears. The new icons
for all selected items appear on your desktop.

WINDOW ICON

There are two ways in which window items can be displayed in a
window: text and icons. You can assign icon shapes to window
items that are currently displayed as text. but the assigned icon
shapes will not display until Show as Icons (under the View menu)
is selected.

o4
You can assign icon shapes to: a single window item (file or
folder), a group of window items, or a specific file type.

INSTALL WINDOW ICONS

[T T
Icon Shape! @

File Type: [FOLDER]
[Tastall] [Renove ] [Skip ||C|nr.ej|
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To assign an icon shape to a single window item (file or folder), or
a group of window items, follow these steps:

1. Open the window containing the desired window items.
Highlight a single displayed window item or use rubber-banding
to highlight a group of displayed window items.

2. Select Install Icon from the Options menu. The Install Window
Icons dialog box displays. The name of the first selected
desktop item appears in the dialog box. Either the File or
Folder box is highlighted, designating the type of item
displayed, and the icon currently assigned to the item is
displayed.

3. Use the scroll arrows to scroll through your icon choices. When
the desired icon displays, select Install to assign the icon shape
to the displayed item. The name of the selected group’s second
item displays in the dialog box. along with that item’s current
icon.

0 Note: If you do not wish to assign a new icon shape to an item
in the selected group. select Skip when that item’s name and
current icon displays in the dialog box. That item retains its
current icon shape. If you wish to remove the item’s currently
assigned icon shape. select Remove. The default icon shape
for that item type will automatically be assigned to that item.

When you have completed the selection process for the final item
in the selected group. the dialog box disappears. The new icons
for all selected items appear in the window.

You can also assign an icon shape to a file type. After setting the
parameters to define the file type, all the files that match the
selected parameters will be assigned the specified icon shape.
Select the parameters the same way you would set a file mask,
typing in the parameters on the Name line ot the install Window
Icons dialog box. (See Set File Mask in this chapter.)

To assign an icon shape to a specific file type, follow these sieps:
1. With a window open, select Install Icon from the Options menu.

Select the Window box from the dialog box. The Install Window
lcons dialog box displays.
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2. Type *. followed by the extension (for example, *FNT).

3. Use the scroll arrows to display the desired icon shape. To
assign that icon shape to the files matching the specified

L. parameters, select Install. The dialog box disappears. All files
that match the selected parameters will be represented by the
new icon.

CHANGING THE ICON IDENTIFIER AND LABEL

To enter a new icon identifier and label for an icon, follow these
steps:

1. Highlight the icon you wish to change. Select Install lcon from
the Options menu. The Install Icon dialog box displays.

2. Type the new Icon Identifier letter and press [Tabl. If you wish
to retain the current drive identifier, press [Tab] to move the text
insertion cursor to the lcon Label line.

0 Note: The letters A and B are reserved for floppy disks, and
the lowercase letter c is reserved for the cartridge slot.
Uppercase letters C through P represent logical drives.

3. Press [Escl to clear the Icon Label line. Type in the new icon
label. You can use up to 12 characters. Select OK.

USING AN INSTALLED PRINTER ICON

An installed printer icon can help you print files in the same way
as the Print command of the Show/Print dialog box (see Opening a
Data File in Chapter Five). Drag and position the desired files over
the printer icon. If you have a printer properly connected to your
system, the information from the file will be sent 1o the printer.
Some files may print only coded or incomplete information.

After installing a printer icon, use Save Desktop to save the
installation. The next time you switch on your system, the printer
icon will appear on your desktop. :
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Install Application
Using Install Application, you can:

« Link an application to data files with a specified extension.
You can then process those data files (documents) directly
from a window instead of having to open the application first

« Select an autoboot status for any application, so whenever
you switch on your computer the application opens
automatically

« Assign a function key to open an application

« Specify what default directory to use for a specific
application. The assigned default directory takes precedence
over the defaults assigned by Desktop Configurations

« Specify full path or filename to an application. The
specification takes precedence over the defaults assigned by
Desktop Configurations

e Assign arguments to programs

ARGUMENTS e

When you open a program file, you are telling the computer to
follow the instructions in that file. The instructions within the
program file then take over and run the show until you exit from
the program. Sometimes you need to give the program additional
information. such as what to do with a data file. This additional
information is called an argument.

Most programs provide ways for the user to input arguments, such
as an Open File command in a word processing program. In fact,
if you input the name of an existing data file in the Arguments line,
and you have your input parameters set in such a way that the ,
program can find the file, the data file will open automatically
when you open the word processing program. But unless you
work on one data file almost exclusively, other options such as
linking an application to a data file type make arguments of this
kind clumsy and unnecessary.
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Arguments are used most often with utility programs. These
programs often need complex additional instructions such as a
code sequence to determine which part of RAM will be used to
contain the program instructions. Detailed explanations of the
arguments needed, and the correct syntax for those arguments
will be included in the program'’s documentation.

When you open the Install Application dialog box, the text
insertion cursor is already on the Arguments line. Simply type in
the arguments and press [Return]. Remember to use Save
Desktop to save the argument, otherwise it will be erased when
you switch off the computer.

LINKING A DOCUMENT TYPE TO AN APPLICATION

Normally, the only way you can process a data file is to first open
an application that can work with the type of data contained in the
file. Then you can open the data file from within the application. If
you attempt to open a data file directly from a window, a dialog
box displays informing you that your options are to show or print
the file. or cancel the request. You cannat edit the data in the file.

But you can use Install Application to link a data file type
(determined by the three character file extension) to an
application. Choose the file type most commonly used by the
application. After linking the application with the document type,
the linked application automatically opens when you open the
document.

Note: You must pay particular attention to assigning correct
default directories and parameters to an application when linking
a document type to an application. This is especially true when
you open the application from its icon on the desktop. Refer to the
application’s documentation for detailed information on correct
default directories and parameters.

To use Install Application to link an application to a data file type,
follow these steps:
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1. Display the window containing the application you wish to link
to a document type. Highlight the desired application. Select
the Install Application dialog box from the Options menu. The
name of the selected application appears in the Install
Application dialog box.

0 Note: You can select more than one application at once for
this operation. Highlight all the applications you wish to install,
then open the Install Application dialog box. After completing
the operation on the first selected application, the name of the
second selected application appears in the Install Application
dialog box.

2. Press [Tab] to move the text insertion cursor to the Document
type line. Type in the three character file extension of the file
type you wish to link to the displayed application.

3. Select the appropriate Application type.

4. Choose a Default Directory and Parameter. (See Selecting a
Detault Directory and Parameter in this section.)

5. Select Install to enter the selected settings.

Note: When installing multiple applications. selecting Skip will
cause Install Application to skip over the application whose name
is displayed on the Application name line. All current settings will
be retained.

SELECTING A DEFAULT DIRECTORY

Every program that works with supporting files (such as resource
files or help files) has to have, as part of the program, a way to
look for those files. Desktop Configurations tells your computer
which directory should be the default. This is where the program
will access files if the program assumes that it is not installed.
Using Install Application to assign a default directory to a specific
application overrides the Desktop Configuration’s assignment for
that application.

You can set the default directory to Top (active) Window, or
Application (the directory in which the program resides).
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Some programs do not look for files in any location other than the
default directory. For these programs, select Top Window. and
make sure that the program file and all supporting files are in the
active window.

SELECTING PARAMETER W

Before an open application can use a data file, it must first find
and open the file. Most programs enable you to search through all
existing directories to locate and open a desired file. These
programs have no preconceived ideas about the location of files.
For these programs you would choose Full Path, so the entire
pathname of the file is used when a file is opened.

Other programs already have pre-existing partial paths. This
means that the program contains a partial pathname that it uses
every time the program searches for a file. A partial pathname
consists of the drive identifier, and all applicable directories. Only
the file name and extension is input for the search. All files must
be in the specified directory, or they cannot be located. Check
your program’s documentation to determine the program's defauit
path, and make sure all of your data files reside in the correct
directory.

Always try Full Path first. Then if necessary, experiment with other
combinations until you find one that works with your application.

INSTALLING AN APPLICATION TO OPEN FROM A FUNCTION
KEYSTROKE

Any executable file (program) can be installed to open from a
function key ([F1] through [F10] at the top of the keyboard). You
can install up to 20 programs to open this way. Use [F1] through
{F10] for the first ten programs, and [Shift] [F1]} through [Shift] [F10]
for F11 through F20.

After you assign a function key to a program, you only have to
press the assigned function key to open that program. The
assigned key will only open the program from the desktop. Once
you are within an application. the function keys perform the tasks
assigned to them by the application.
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To assign a function key to open an application, follow these
steps:

1. Highlight the application.
2. Select Install Application from the Options menu.

3. Press [Tab] twice to move the text insertion cursor to the Install
as line.

4. Type the number of the function key you wish to assign to the
application.

5. Select Install.

INSTALLING AN APPLICATION TO AUTOBOOT OR NORMAL BOOT
STATUS

If you mainly use your computer for a single purpose using one
specific application (such as a database, a word processor, or
graphics program), it will save time if you install that application to
autoboot. An application installed to autoboot status will open
automatically whenever you switch on your computer.

Follow these instructions to install an application to autoboot or
return an application to normal status:

1. Highlight the icon or name of the application you wish to install
to autoboot. Select Install Application from the Options menu.
The Install Application dialog hox displays.

2. Select the Boot Status: Auto box. (To restore normal boot
status to an application installed to autobcot, select the Boot
Status: Normal box.)

3. Select the appropriate Application type box.

4_ Select Install or press [Return).

Remember to use Save Deskiop to save the selected boot status,
otherwise it will be erased when you switch off the TT. The next

time you switch on your computer, the selected boot status will be
in effect.
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Install Devices = S
The Install Devices command installs desktop icons for all hard
disk partitions on all properly configured devices. It also installs a
cartridge icon if a cartridge is in the cartridge slot during startup.

To use Install Devices, follow these steps:

1. From the Options menu select Install Devices. Icons for all
configured devices appear on your desktop. Each icon has a
uniqueEdrive identifier letter, and each device icon is labelled
DEVICE.

0 Note: You can change the shape of your desktop icons. See :
install Icon in this chapter. 2

2_Use the mouse to place the desktop icons where you want
them to appear. Select Save Desktop from the Options menu.
The Save Desktop Dialog box displays. Select OK.

The Save Desktop command saves your deskiop configuration in %
a file called NEWDESK.INF. This file stores information about 4
which icons have been installed and the location of each icon on

the desktop. See Save Desktop in this chapter.

Remove Desktop lcon

If you wish to remove an icon from the desktop. follow these
steps:

1. Highlight the icon you wish to remove.

2 Select Remove Desktop Icon from the Options menu. The icon
disappears from the desktop.

0 Note: If the highlighted icon represents a data or application

file. a dialog box displays and asks you whether you want to
delete the file or just remove the icon.
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Remember, the information stored on the logical drive
represented by a removed hard disk icon is still on the hard disk.
To regain access to that information, you can: reinstall a hard disk
icon for that logical drive, or press [Alternate] and the drive letter.

Set Preferences

The Set Preferences option lets you choose whether or not yofi"
wish to have alert boxes display during copy, move, delete, and
file overwrite operations. Set Preferences also lets you select
monitor resolution.

When you select the Set Preferences option, the Set Preferences
dialog box appears:

SET PREFERENCES
Confirmation required for:
& File Deletes: [THo ]
File Copies: [% ]
File oversrites: [EEE [ Wo |

Set screen resolution:
[ ST Low |[ST Hediun [ ST High ]

Wy
]

AT 11 eoiun [IRREIFON
]

b

If you select Yes, an alert box will display whenever you begin to
delete, copy. or overwrite a file (depending on which option you
have selected). The alert box requests confirmation of the
command, giving you the option to proceed or cancel the

operation. This step can help prevent accidental deletion or o
overwriting of important files. Selecting No skips this step; no alert
box will display.
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0 Note: You must save your desktop to save changes made to the

confirmation section of the Set Preferences dialog box. Any
change made to the screen resolution section of the Set
Preferences dialog box causes the computer to warmstart. If you
do not save your confirmation preferences with Save Desktop
before you change screen resolution, the warmstart will erase all
of your confirmation preferences.

Set screen resolution lets you select monitor screen display
resolution. The TT supports three new graphics modes in addition
to the three previous modes. TT Low allows 256 colors onscreen,
selected from a palette of 4,096 colors. TT Medium allows 16
colors onscreen, with a resolution of 640 x 480. TT High is an
incredibly crisp resolution of 1280 x 960.

TT Graphics Modes

Resolution Palette Colors Onscreen
ST Low (320 x 200) 4096 16
ST Medium (640 x 200) 4096 4
ST High (640 x 400) 4096 2
TT Low (320 x 480) 4096 256

TT Medium (640 x 480) 4096 : 16
TT High (1280 x 960) Mono

You will need a high resolution monitor to display the TT High
resolution.

Click on OK (or press [Return]) to set the selected preferences.
Remember that changing screen resolution causes the computer
to warmstart. Your selected screen preference will be in effect
after the TT warmstarts.

Read .Inf File

You can have more than one desktop information file on your
hard disk, each containing different information (such as installed
desktop icons and their placement, and all View and Options
menu options). The Read .INF File command allows you to
change to a different desktop environment without having to
transfer files or reboot.

Advanced Deskiop
4-26

TT manual Page 85



The default NEWDESK.INF file is in the root directory of your C
drive. You can name the alternate desktop information files
anything you like, but the three character extension must be .INF.

With the Read .INF File command. you instruct the TT to read
information from a specified alternate desktop information file.
Follow these steps to use the Read .INF File command:

1. Select Read .INF File from the Options menu. The S.elecl an
INF File dialog box displays.

2. Display and highlight the alternate desktop information file.
Select OK, or press [Return]. The new information is read into
your computer.

0 Note: If you wish to save the current NEWDESK.INF file before
using the READ INF command, simply change the name of the
current file NEWDESK.INF file. This will allow you to save your
desktop without losing your current setup.

Desktop Configuration
=0 13
With the Desktop Configuration dialog box you can set the default
directory and input parameters for all applications, scroll through
assigned function keys, and assign a single keystroke to various
menu commands. The Desktop Configuration dialog box also
displays the amount of RAM still available.

DESKTOP CONFIGURATION
Set default directory as:

[Application]
Set input parameter:

[Full Path

Function-key Assignments:

[0 M |

Efiisingle Keystroke:
(Menu Item:

[_open... [0l
Key: 0| (Clear All ]

Systen Free Memory: 7515894 bytes
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Most applications use the default directory and input parameters
displayed in the Desktop Configuration dialog box. The exceptions
are applications that have been assigned their own specific
default directory and input parameters through the Install
Applications dialog box. You can find detailed information
regarding setting the default directory and input parameters under
Install Applications in this chapter.

You can use the Function-keys Assignment to display the full
pathname of each program that has an assigned function key.
Use the right and left scroll arrows to display hidden parts of the
pathname. and the up and down arrow keys to scroll through the
assigned function keys.

All menu commands can be assigned a keystroke. This enables
you to bypass the menu bar and initiate the command by pressing
a single key. Use Define Single Keystroke up and down arrows to
scroll through the menu commands and their keystroke
assignments. To change the keystroke of a displayed menu
command, type in the desired keystroke. To clear all menu
command keystroke assignments. select Clear All.

System Free Memory displays the number of bytes of RAM still
available.

After making changes to the Desktop Configuration dialog box,
select OK to confirm your choices. Use Save Desktop to save
your selections, or they will be erased the next time you switch off

your TT.

Save Desktop

You can rearrange the desktop icons and windows to suit your
personal preferences and use the Save Desktop option to save
the new arrangement. For example, you might want to move the
trash can icon, line up the disk icons horizontally, or have the
startup screen display several open directory windows.

Save Desktop also saves Option and View menu selections. The
computer stores saved configurations and menu selections in a
NEWDESK _INF file and places this file on your startup disk or
hard disk drive root directory.
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Arrange disk and trash can icons by dragging them to new
positions on the desktop. You may want fo close all windows first
to start with a clean desktop.

How you arrange your desktop will depend on your needs, but it's
usually a good idea to place the trash can icon away from the disk
drive icons to protect against unintentionally dragging files to the
trash can instead of to a disk or logical drive icon.

Arrange directory windows on the desktop by opening. moving.
and sizing selected windows. You can have up to seven directory
windows open at once on the desktop. Select options from the
View menu to determine how window items (folders and files) will
be shown (as text or as icons) and sorted (by name, date, size, or
type). If you show window items as text, you may want to narrow
the windows to show only the item's name and extension.

If you leave the windows open when you save the desktop, those
windows will open to the same size and position the next time you
switch on the computer. The window that is active when you save
the desktop will be the active window the next time you switch on
the computer.

The size and position of closed windows is also saved when you
select Save Desktop. The next time you open the window, it will
open to the size and position it occupied on the desktop the last
time it was opened.

Print Screen

The Print Screen command lets you print the current screen
display. Everything showing on the screen prints.

To use this command, you must have a graphics printer
connected to the computer. The printer must be installed from the
Control Panel and switched on. If you are using an Atari SLM
Laser Printer, the program SDUMP.PRG must be in the Auto
folder on your startup disk. Set up the screen you want to print,
then select the Print Screen option.
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Note: A new TT compatible SDUMP.PRG program is on your
hard disk in the SLM folder on drive C.

Select OK to print the screen. Select Cancel to stop the process.

Note: If you try to print a screen without first switching on the
printer, the system wili try to reach the printer for approximately 30
seconds before giving up. This is known as timing-out. If this
occurs, switch on the printer and try again.

Cache

A CPU cache is a special area in the system used to store
frequently used data from data files and programs. This saves
access time, since the computer has the data in the cache and
does not have to access the data from RAM or ROM. Turn the
Cache on or off by selecting the Cache option from the Options
menu. When there is a check next to this option, the cache is
turned on. When there is no check, the cache is disabled.

In most cases, you will want to have the cache on because your
programs will process information more quickly. However, some
programs that contain self modifying code (parts of a program that
are able to make changes to the program itself during the
execution of the program) may not function properly with the
cache turned on. If a program fails to run, turn off the cache and

start the program again.

113 4 2s
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CHAPTER FIVE st ;
DIRECTORIES, FOLDERS, AND FILES

A computer processes information, but it must first be provided
with the information and then told what to do with it. A collection of
information grouped together is called a file. A program or
application file contains instructions for the computer. A data file
contains information to be used or edited by the program or
application.

Directories and folders provide a way to group files together for
organization and storage. Maintaining an organized structure for
your files and folders helps you easily locate files and creates an
efficient working environment.

DIRECTORIES AND FOLDERS

A directory is the area on a drive (a drive can be either a floppy
disk, or logical drive on a hard disk) that contains a list of the files
residing on that drive and the locations of those files. The
computer can display directories as either a list of file and folder
names, or graphically, with each file and folder represented by an
icon.

Every formatted drive has at least one directory (the main or root
directory), which lists all the files and folders on the disk or logical
drive. Directories can contain other directories, allowing you to
create a hierarchical structure of directories within directories. A
directory within another directory is called a subdirectory or folder.
The terms folder and subdirectory are synonymous.

w3

Identifying Directories and Folders

The root directory is the first directory displayed when you open a
disk icon. When you open a root directory, only the Disk Identifier
and file mask appear in the window's move bar. For example, the
move bar of a newly formatted floppy disk in drive A would display
the following:
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A\r*

When you open a folder, the folder's name is added to the move
bar. If you opened a folder called LETTERS that resided in the root
directory of a floppy disk in drive A, the move bar would display the
following:

ANLETTERS\*.*

Displaying a Directory or Folder

You can view the contents of a directory or folder by opening the
icon representing that directory or folder. A desktop window opens,
displaying the contents of the directory or folder. The contents will
display as either text or icons.

To open a directory or folder, position the pointer over the desired
icon, then double-click the left mouse button. Or highlight the
desired icon. then select the Open command from the File menu.
Once the window displays, you can select the contents (other files
and folders) of the directory or folder.

Directories and folders can contain data files, program files, and
folders. If you have a number of related files, you can place them
inside one folder to keep them together. You can also put folders
and files within other folders. You can create a folder using the
Create Folder command. (See File Menu in Chapter Four.)

FILES AND FILENAMES

A file is a collection of information grouped together under a single
filename. There are two types of files. Executable files (also called
programs or applications) contain instructions for the computer to
carry out. Most of the time the instructions contained in executable
files are used to work with information in data files. A data fileis a
collection of information that contains no instructions for the
computer.
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You can place files in root directories and folders. If you choose to
display your folders and files as icons (see View menu in Chapter
Four), you will have as many icons in a directory as you have
folders and files in that directory. The name of the file or folder will
display under its icon.

Filenames and Extensions

Files are identified by filtenames. You can name the files you create,
and change the names of existing files. New files are named within
an application when they are created. You can also use the Show
Information command under the File menu to rename existing files
(See File menu in Chapter Four for more information.)

The filename is made up of two parts: the name and the optional
three character extension. In the following example, the name is
SAMPLE and the extension is .PRG.

ISAMPLEJI’F!G ol

| exiension (optional; a period (.) and up to three characters)

|
name (mandatory; up to eight characters)

The name section of a filename can be from one to eight characters
(letters, symbols, or numbers) long. A filename extension can be
from one to three characters long, separated from the filename by a

period.

sahb b
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The following characters cannot be used within a file name or
extension:

« Period (.)

« Quotation Marks (")

« Forward Slash (/)

« Backslash (\)

« Brackets ([ or ]) . s

« Vertical Break Bar (1)

« Less-Than Symbol (<)

 Greater-Than Symbol (>)

« Plus Sign (+)

« Hyphen/Minus Sign (-)

« Colon {:)

« Semicolon (;)

« Comma (,)

« Asterisk (*)

« Question Mark (?)

Filenames usually refer to the information contained in the file,
such as TAXES for tax information, or TAXES87, TAXES88, and

TAXESS9 for a series of tax information files.

An extension often indicates the file type, and certain types of files
must have specific extensions. For example, the .PRG extension
indicates to your computer that the file is an executable GEM
application. If you remove the extension, the computer would not
recognize the file as an application.

Applications often use a specific file extension. This extension is
automatically assigned to any file that application creates. For
example, word processors often use DOC or .TXT as an
extension for documents. See the documentation supplied with
the application for more information.
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Each of the following executable file types has a unique file
extension by which it can be recognized. These extensions should
be used only for executable files: .PRG, .TTP, .TOS, .ACC, and
.APP. Files with any of those extensions cannot be opened if the
extension is deleted or changed.

The five most common extensions and their definitions are listed
below:

.ACC A GEM Desktop accessory. The system accesses .ACC
files which appear under the Desk menu. Use
accessories by selecting them from the Desk menu. You
can have up to six active accessories on the system at a
time.

.APP A GEM application. An .APP file is a GEM application
and will usually take advantage of the GEM environment
by using windows, icons, and drop-down menus.

PRG GEM application. (See .APP.) A

.TOS A TOS application. A .TOS file is a non-GEM application.
It does not use the GEM environment and may not even
use the mouse.

TTP A .TTP (TOS-Takes-Parameters) application. A . TTP
file is a .TOS file that expects some typed parameters
(data that will control the program’s operation). When
you open a .TTP file, an Open Application dialog box
appears requesting you to enter some parameters.
Consult the .TTP program's documentation for more
information.

0 Note: When you sort files by type, they are arranged
alphabetically by their extensions.
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Pathnames -
A pathname is a description of a folder's or file's location. A
pathname begins with the appropriate drive identifier, and then
lists each applicable folder, starting with the folder residing in the
root directory and ending with the folder in which the file or folder
actually resides. The final element of a pathname is the name and
extension of the file or folder. The move bar displays the complete
pathname of the displayed file or folder.

Let's build an example. You have a floppy disk in drive A which
contains all 1986 sales and marketing reports for all sales regions.
But you are interested in finding the July 6th sales report from the
western sales region.

First you open the disk icon for floppy drive A. A window opens,
displaying drive A’s root directory. The move bar displays only the
drive identifier and file mask. The file mask is the *.* following the
backslash:

Avr o

0 Note: For a full explanation of file masks, please refer to Set File
Mask under File Menu in Chapter Four. The asterisks in the file
mask above are known as wild card characters. Wild card
characters are explained in the section on File Specification in this
chapter.

One of Ihe items in the displayed root directory is a folder called
SALES. When that folder is opened, the name of the folder is
added to the pathname. The pathname then consists of the Disk
Identifier and the folder name like the example below:

]
:

ANSALES\**
The window now displays the contents of the SALES folder. One
of the items in the displayed directory is a folder called
WESTERN. When that folder is opened, the name of the folder is
added to the pathname. Now the pathname looks like this:

A\SALES\WESTERN\**
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In the displayed directory of the WESTERN folder you find the file
you are looking for, called JULY_B6.DOC. If you opened that file
from within an application, the following entire pathname may
display in the move bar:

ANSALES\WESTERN\JULY_6.DOC.
The file mask is replaced by the actual file name and extension.

0 Note: Do you notice something odd about the filename
JULY_B.DOC? An underline character separates JULY from 6.
Since the space character is an illegal character (you cannot use it
in file or folder names), sometimes the underline character is used
to simulate a space.

Opening a Program File

When you open a program file, the computer carries out the
instructions contained in the file. This is also called starting,
running, or launching the program.

There are many ways to open a program file from the desktop. You
can position your pointer over the file's name or icon (located either
in a window or on the desktop) and double-click the left mouse
button. You can highlight the file, then: select the Open option
under the File menu, or press the assigned command key (the
default command key for opening a file is [0]). You can also use an
assigned function key to open the program. (See Open under File
Menu in Chapter Four.)

Other methods of opening a program file are explained in the Instan
Application section under Options menu in Chapter Four.)

File Selector

The File Selector is a special dialog box that can only be accessed
from within a program. You will use the File Selector for loading and
saving files. Many applications programs use the File Selector
dialog box.
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FILE SELECTOR
Directory:
D:\ADMIN\FAX_MEMO\*,D0C oo —_—

Selection: | _____

o —m
b i LA
ol L&
FAXJAPAN.DOC |~ | | E |
FAX_CHCG.DOC | 6|
F¥_1.9 .DOC | T |
MEWO  .DOC K 3
p— ;
il B
D — S I__I

When you display the File Selector dialog box, the Directory field
displays the current directory’s pathname. The pathname consists
of a disk identifier, folder name(s), and a file specifier.

The Selection field shows the currently selected file (if one has
been selected) and can be edited like the Directory field.

The directory window shows the current directory’s folders and
files that can be accessed by the application. The folders are
listed first in the directory window, and then all files are listed. (For
further information on sorting see Sorting Files and Folders in this
chapter.) If the directory contains more files than it can display in
the window at one time, scroll the window to view the hidden files.
(See Scrolling a Window in Chapter Three.)

The drive selector shows the currently selected drive.
Note: When you make a change within the File Selector dialog
box. related fields automatically show that change. For instance, if

you change the drive with the drive selector, the drive letter in the
Directory field also changes.
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SELECTING A FILE LM i

Place the pointer on the filename you wish to select. Select a file
by one of these methods:

¥

« Click the left mouse button. Select OK.
= Double-click the left mouse button.
« Enter the filename on the Selection field, then select OK.

SELECTING A DIRECTORY. "

From the directory window, open a folder directory by selecting
the folder name. The current directory window's folders appear at
the top of the directory, marked with a folder symbol. To close a
folder directory, select the close box button. The current
directory’s pathname appears in the Directory field.

From the Directory field, you can select a directory by typing that
folder's pathname. To do this, erase the Directory field, type the
new pathname, and press [Return]. The pathname contains a disk
identifier, and may contain folder names and a file specification.

SELECTING A DRIVE

You can select a drive from the drive selector or the Directory line.

To select a drive with the drive selector, position the pointer over
the desired drive’s letter. Click the mouse button to view the

drive’s directory.

o Note: The drive letter is part of the disk drive identifier. The disk
drive identifier includes a letter specifying the disk drive, a colon
(:), and a backslash (\).
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THE FILE SPECIFICATION R
" The file specification in the Directory field is a search criterion that
may include letters, numbers, and special characters called
wildcards (* and ?). The file specification determines which files
will appear in the directory window. By editing the file
specification, you can choose which files or types of files to
display. ) _
12 T 1 i & P

The file specification is similar to a filename. It contains a
mandatory name of up to eight characters and an optional
extension of up to three characters. A file specification uses the
asterisk (*) and the question mark characters as wildcards.

An asterisk in a file specification stands for all characters and
combinations of characters, and can replace an entire name or
extension. For example, the file specification ** calls for the
display of all filenames with all extensions.

A file specification will often have an asterisk as the name but
specify an extension. For example, the file specification *DOC
allows all filenames with the .DOC extension to appear in the
directory window. This file specification would show the files:

REPORT.DOC
STOCK.DOC
MEMO.DOC

e i

This file specification would not show:

FINANCE. TXT

The asterisk must be the last character in the name or extension
of a file specification. For example, the file specification
TAX*DOC is valid, but the file specification T*X.DOC is not .
valid. The letter following the * is of no importance since the * ;
before the letter specifies all characters.

The question mark in a file specification replaces a single
character. For example, the file specification MEMO?7 LET
specifies all files which begin with MEMO, which have any
character in the fifth position of the file's name, and which have
the extension .LET. This file specification would display the files:
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MEMO1.LET . A
MEMO4 LET
MEMOZ.LET

This file specification would not display the files:

BID.LET
MEMO33.LET
MEMO1.DOC

The file specification 77777777.277 is equivalent to *.* .

You can combine wildcards and characters. For example,
?IL*. T?T and F*.T* are both valid file specifications which would
display FILE. TXT.

To change a file specification, edit the specification in the
Directory field, then update the directory window by pressing
[Return].

Opening a Data File

You can open the application file first (see Opening a Program File
in this section) and then open the data file using the File Selector.
Or you can save a step by using Install Application to link the data
file type (identified by the three character extension) to an
application. If the data file type is linked to an application, you can
use one of the four methods for opening a file (see Opening a
Program File in this chapter) as if you are opening the data file .,
from the desktop. The computer will open the selected file. (See
Install Application in Chapter Four.)

Note: You can also open a file by dragging a data file over the
icon for the program file. -
If you attempt to open a data file whose file type is not linked to an
application, the Show/Print dialog box displays.
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Select Show to display the data file on screen. If the file contains
readable text, the text displays. If the file is longer than one
screen, the message -More- appears at the bottom of each
screen of lext. You can scroll through the file in the following
ways:

« One screen at a time by pressing [Spacebar] or the mouse
button

« One half screen at a time by pressing [D] or [Control] [D]
« One line at a time by pressing [Return]

Note: You can only scroll forward. You cannot scroll back through
text you have already viewed.

If you press the left mouse button or [Space Bar] while scrolling
text by the screen or half-screen, the screen will continue to scroll
until it displays a full or half screen starting from where you last
pressed the left mouse button or [Space Barl. The message -End
of file- appears when the entire file has been displayed . Press
[Space Bar] to return to the desktop. To return to the desktop at
any time before -End of file- appears, press the right mouse
button, [@], [Controll [C], or [Undo].

-~ l”-.’ Q*"‘ -
Select Print to print the data file. You can stop printing at any time
by pressing [Ql. [Control] [C]. or [Undo].

Select Cancel to return to the desktop without displaying or
printing the data file.

Note: Not all data files contain readable text. When you print or
show such a file, the screen may display only coded or incomplete
information.

FILE AND FOLDER MANAGEMENT

Copying, moving, deleting, and other file and folder operations
allow you to better organize your disk space. If you maintain good
file and folder organization, you will conserve disk space and
create an efficient working environment.
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Copying Files and Folders et

You can copy window items (files and folders) onto a floppy disk,
logical drive or folder. When you copy a folder, the subdirectory
information and all the folder’s contents (files and other folders)
are copied to the new location.

To copy a window item, select the item and drag it to its new
position on the desktop. You can drag a window item to another
window, disk icon, or folder icon. The item's destination icon will
highlight when the item is positioned on top of the destination
icon.

Note: If you drag a data file on top of an application. the
application will run. The data file will be used as a parameter and
will open automatically.

When you begin a copy operation on a single or on multiple
window items, the Copy File(s) dialog box appears. You must
select OK to continue the copy procedure. With single disk drive
systems, you will need to switch disks occasionally to complete
the procedure. The computer provides alert dialog boxes to tell
you when to switch disks. The Copy File(s) dialog box shows the
name of the destination folder, and displays each item'’s name as
that item is copied.

Note: The Copy File(s) dialog box will not appear if the File
Copies confirmation option has been turned off. See Set
Preferences under Options Menu in Chapter Four for more
information on the File Copies confirmation option.

You can halt the copy operation by pressing [Unde] while the bee
icon displays. On a single disk drive system, press [Undo] while
the source disk is in the drive. When the Abort Operation dialog
box appears, select Yes to halt the operation, or No if you wish to
continue copying.

To copy an entire disk, drag the disk icon to the copy destination
(floppy disk, logical drive, or folder). Copying a disk icon to a
folder adds the contents of the disk to the folder without disturbing
the contents of the folder. If the destination folder's window is
open, copying a file or folder updates the displayed directory.
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Warning: Copying from one floppy disk icon to another floppy
disk icon erases all existing information on the destination disk.
When you begin this operation, an alert dialog box appears to

make sure you do not erase information you need.

Note: When copying from one disk icon to another, both disks
must be the same format (single or double-sided).

o

Name Conflict During Copying

A name conflict occurs when you attempt to copy a window item
to a floppy disk. logical drive, or folder that already contains an
item of the same name. Depending on the File Overwrites
confirmation setting (see Set Preferences in Chapter Four), the
Name Conflict alert dialog box appears warning you that a name
conflict occurred. If you wish to replace the existing item with the
item of the same name, select Copy.

You could also choose to change the name of the window item
you are copying so no name conlflict will occur when you continue
the copy operation. You can change the item’s name from within
the Name Coniflict alert dialog box. The text insertion cursor is
already positioned at the end of the Copy's Name line. Press
[Backspace] to clear the Copy's Name line one character at a time,
or press [Esc] to clear the entire field. Now type in the new file or
folder name and select Copy or press [Return] to continue the
copy operation. The original item will remain intact, and the
copied item will appear in its destination under the new name.

When copying multiple window items, select Skip it a name
contflict occurs and you wish to skip over that particular item, but

you wish to continue the copy operation on the other selected
items.

Moving Files and Folders

Moving a window item allows you to transfer that item to a new
location, deleting the item from its initial location.
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To move window items, highlight one or more items. Then hold
down [Control] as you click on and drag the items to a new
location. The Move File(s) dialog box appears, showing you the
number of items involved in the Move operation.

Select OK to complete the move. To cancel the move operation,
select Cancel. When you select OK, the Move File(s) dialog box
shows the destination folder (if there is one) and the name of the
item moved.

You can halt a move oberation in progress by pressing [Undo]
while the bee icon displays. When the Abort Operation dialog box
appears, select Yes to stop the operation.

Renaming Files and Folders = s

o

You can rename files and folders with the File Information dialog
box. The Show Information command displays the File
Information Dialog Box. For more complete instructions, refer to
Show Information Under File Menu in Chapter Four.

Filenames can have from one to eight characters. Optionally,
filenames are followed by a period (.) and a three-character
extension. Folders can have from one to eight characters, and
usually do not have an extension.

Note: As a general rule, avoid modifying the three-character
extension. A change in the extension may prevent the system or
an application from using program, resource, data, and other files
correctly.

Deleting Files and Folders

You can delete unwanted window items to free up room on a disk
or in a folder. There are two ways to delete window items. You
can highlight the desired item and drag it into the trash can icon
on the desktop. The trash can icon highlights and the Delete
File(s) dialog box displays. You can also highlight the desired item
and choose Delete Item from the File menu or use an assigned
keystroke for Delete.
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When the Delete Folders/Items dialog box appears, you can
confirm or cancel the delete operation. To continue the operation
and delete the item, select OK.

Note: If the Delete File(s) dialog box does not appear, the File
Deletes confirmation option has been turned off. See Set
Preferences in Chapter Four for more information on the File
Deletes confirmation option.

You can halt a delete operation in progress by pressing [Undo)
while the bee icon displays. Deleting files is a fast operation, so
you must act quickly to halt the process. When the Abort
Operation dialog box appears, select Yes to stop the delete
operation. This will not retrieve those files already deleted.

Warning: Deleting a folder deletes all files and folders within thé’
selected folder. Once the bee icon disappears, you cannot
retrieve any files and folders.

Note: You cannot delete a file if its read/write status is set at
Read Only. Also, you cannot delete a folder containing a Read »
Only file. To change the read/write status of a file, select Show
Info from the File menu, then select Read/Write.
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CHAPTER SIX
DESK ACCESSORIES

Desk accessory programs are unigue because they can be
opened not only from the desktop. but also while you are running
another program. For example, if you want to change how fasta
key repeats while you are working in a word processor, you can
use the Control Panel desk accessory to change keyboard repeat
time without exiting the word processor. Most programs that use
the menu bar will allow you to access desk accessories. Desk
accessories can be accessed from the far left menu item (usually
the Desk menu).

Installing a desk accessory is easy. Whenever you switch on your
TT, the operating system checks the main directory of your
startup disk for files that need to be run during startup. One of the
criteria used in identifying those types of files is the ACC (desk
accessory) file extension. Any file ending in .ACC and residing in
the main directory will be read and loaded during startup.

To install a desk accessory. simply place a copy of the program
file into the main directory of your startup disk. (Make sure the
desk accessory's file extension is ACC.) Then you must restart
your system, since the file can only be properly read and loaded
during the startup procedure. The desk accessory will now appear
under the Desk menu.

You can load up to six desk accessories at one time. If you store
more than six desk accessories on your startup disk, make sure
that the six desk accessories you currently wish to use have the
ACC extension. The ACC extension means the file is active.
Change the extension on ali other desk accessories to ACX (or
any extension other than ACC). Inactive files will not be
recognized or loaded during startup.

0 Note: No harm will be done if you have more than six active desk

accessories on the startup disk's main directory. The first six
active desk accessories will load in the order that the files appear
on the disk, and any additional active desk accessory files will be
ignored.
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XCONTROL.ACC, the control panel desk accessory included with
your TT, is already installed. The file resides in the main directory
of your USA Language disk, and in the drive C main directory of
your internal hard disk drive. The Control Panel will be loaded
automatically the first time you switch on your TT. ‘

o
To open a desk accessory, first display the Desk menu. Position
the pointer over the desk accessory and click. The desk
accessory opens into a dialog box or window.

CONTROL PANEL

The Control Pane! coordinates many smaller programs called
control panel extensions (CPXs). The initial Control Panel screen
displays the names of all currently loaded CPXs. You can open a
CPX by positioning the pointer over the desired CPX and double
clicking.

The Control Panel also contains a pull down Options menu. When
no CPX is highlighted, the Options menu displays two menu
choices: About and Setup. Two additional Options menu choices
display when a CPX name in the main Control Panel window is
highlighted. The three additional options are Open CPX, CPX
Info, and Unload CPX.

To select an option, position the pointer over the Options menu.
Then click the mouse button. The Options menu displays. Move
the pointer until the desired option highlights. Click the mouse
button to select the highlighted option.

Whenever you open a Control Panel or CPX window, you are
usually given the following options: Save, OK, or Cancel. Clicking
on the close window box is the same as selecting OK and then
closing the Control Panel.

Selecting Save places the currently displayed setting information

in a file on the startup disk. The TT will read this file during
startup, and load in the saved seltings.
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Select OK if you just wish to change a setting for one session. The
Control Panel window will close, and the changes will remain in
effect only until you switch off the TT. The most recently saved
settings will be in effect then next time you switch on the TT.

Selecting Cance! will always return you to the main Control Panel
window.

About... . ot

When you select About, Control Panel information (such as
version number and copyright date) displays.

Setup... -

You can use the Setup dialog box to change a CPX's status
(activelinactive), reload CPXs without restarting the TT, set the
amount of memory reserved for basic CPX information, and
designate a CPX directory path. You can also use the calendar

and clock to set the TT's time and date.

Time:

T CONTROL PANEL ¢
8/16/98

12124 Hour Time——=Timet [ 12 Hour Minimum Number
Reload CPYa—— = : 0f Slots:

CPX Mover - % ,. ﬁ 3 Minimum Number of Siots

CPY Directory Path
3 FACICA—

“Save 1 ok

CPX Directory Path

Date and Time

time to mark individual files with
ted or revised. This feature is
hich file was most recently

The computer uses the date and

the date and time they were crea
useful when you want to determine w

changed or created.
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You can use 12/24 Hour Time to set the Control Panel clock to 12
or 24 hour time. This does not affect the way files are dated, only
the way the time is displayed in the Contol Panel window.

To set the clock or calendar, follow these steps:
SN e ta
1. Open the Control Panel. Select date or time by positioning the
gointer over the desired selection and clicking the mouse
utton.

2 Press the Left Arrow key to position the cursor in the window,
or press [Backspace] or [Esc] to erase the window. [Backspace]
erases the characters in the window one character at a time.
[Esc] erases the entire window.

3. Type in the desired time or date.
4. Click on the new time or date.

To change between 12 and 24 hour time, position the cursor over
the selection box to the left of the word Time. Click the mouse
button. Both the 12 and 24 hour selection boxes display. Move the
cursor until the desired box is highlighted. Click the mouse button

again.

CPX Mover and Reload CPXs

Only active CPXs are loaded during startup. All active CPXs
appear in the main Control Panel Window. If you need to use an
inactive CPX, you can use the CPX Mover to change the status of
the CPX from inactive to active. Then when you select Reload
CPXs. the newly active CPX will display in the main Control Panel
window.

You can also remove a CPX from the main Control Panel Window
by changing the status of the CPX from active to inactive.

To change the status of a CPX, follow these steps:

1. Open the Control Panel. Select Setup from the Options menu.
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2. Select the CPX Mover. The CPX Mover window displays. A

Move Box

Xy et

3. Select the desired CPX by positioning your pointer over the
name of the CPX and clicking. The CPX highlights, and the
appropriate operation appears in the Move box.

Note: You can select multiple CPXs for the move CPXs
operation. Use shift-clicking or rubber banding to highlight %
more than one CPX. If you use rubber banding, the rubber
band box will not actually appear, but it still works the same
way.

4. Select the operation by clicking in the Move box.

" If you have transferred a CPX from inactive to active status, you

must reload before you can use the CPX. To Reload CPXs, follow
these steps:

1. Open the Control Panel. Select Setup from the Options menu.

2 Select Reload CPX. When the confirmation dialog box
appears, select OK.
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Advanced Setup Options

Setting the Minimum Number of Slots and the CPX Directory Path
are advanced features of the Setup dialog box. You wili probably
use these options infrequently.

MINIMUM NUMBER OF SLOTS

CPXs are stored in an external memory device (hard disk or
floppy disk) During startup or reloading, only basic information
about each active CPX (such as the CPX's name and icon) is
loaded into RAM. When you actually open an active CPX, the
bulk of the file is then loaded into RAM so you can use the CPX.
When you close the CPX, the file is erased from RAM until the
next time you open it.

0 Note: CPXs with Resident status do not follow the above pattern,
but are copied into RAM at startup time.

The TT has to know how much RAM to reserve for CPX basic
information. When you set the Minimum Number of Slots, you are
telling the TT to reserve enough RAM to be able to store basic
...formation for that number of CPXs. If the number of active CPXs
at startup time exceeds the Minimum Number of Slots, the TT will
reserve enough RAM for that number of CPXs. You can select
from 5 to 99 slots.

To change the Minimum Number of Slots, follow these steps:
1. Open the Control Panel. Select Setup from the Options menu.

2 Use the scroll arrows to display the desired number of slots.
Select OK or Save.

CPX DIRECTORY PATH

The CPX Directory Path tells the Control Panel where to look for
CPX files. You will probably want to store all of your CPX files in
one folder, and set the directory path to that folder. But if you
store CPX files in more than one place, the CPX Directory Path
must be set to the directory that contains the CPX files you wish to

use.
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Note: If the CPX Directory Path is too long to display in the box,
use the left and right scroll arrows to display the hidden sections of
the path.

To change the CPX Directory Path, follow these steps:
1. Open the Control Panel. Select Setup from the Options menu‘..

2. Click anywhere on the CPX Directory Path box. The File
Selector displays.

3. Use the File Selector to select a new path. When you open a
directory, the directory name is added to the File Selector’s
Directory line. When the desired directory path is displayed,
select OK. The new path will appear in the CPX Directory Path
box.

Open CPXs...

You can open a CPX by first highlighting the CPX on the Control
Panel main window, and then selecting Open CPXs from the
Control Panel Options menu. You can also open a CPX by double
clicking on its box in the Control Panel main window.

CPX Info...

When you highlight a CPX and then select CPX Info from the
Control Panel Options menu, the CPX Info window displays. The
window contains the selected CPX's filename, version number, 1D
number, and Resident/Non Resident status.

Filename is the CPX's actual filename as it appears on the disk.
Version and ID are assigned by the CPX's programmer. Two
versions of the same CPX can have the same ID number. In this
case, only the most recent version will be loaded. If you have
several versions of the same CPX, you can look at the version
number to determine which is the most recent version.
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You can use Configure CPXs (see Configure CPXs) to change the
resident status of a CPX. You will probably want most of your CPXs
to have Resident: No status. This means that the bulk of the
program is stored in external memory (hard or floppy disk) and only
read into RAM when you open the CPX. But if you have a CPX that
you use frequently, you may want to give it Resident: Yes status.
CPXs that have a Resident: Yes status on startup will be read
directly into RAM and will remain there until you switch off the
computer. Resident CPXs run a bit more quickly, but may take up a
great deal of RAM.

Note: Wheft you change a CPX's status to Resident: Yes, the

status change will not be in effect until the next time you start your

system. The only time a CPX can be installed into RAM with

Resident status is during startup. In addition, changing a CPX's

status to Resident: No status will not actually remove it from RAM
5 until you switch off your system.

Unload CPX... . o

Unload CPX does not change the status of the CPX to inactive. It
simply removes a CPX from the CPX list on the Control Panel main
window. You can use Reload CPX to place the CPX back on the
list.

0 Note: You cannot unload a resident CPX.

CPXs

This section describes in detail each CPX included with your TT.
6 #
Window Colors

Window Colors allows you to assign different colors (depending on
the selected resolution) to different elements of desktop windows.
You can assign colors to each of the 15 elements of the active
window and 5 elements of inactive windows.
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Even though the TT color palette contains 4,096 colors in most
resolutions, the colors available depend on the selected resolution
(from 2 to 256 colors on the screen at any one time). You can use
the Color Setup CPX if you wish to create a custom set of available
colors. See Color Setup. You can also use the factory assigned
default color set, or use function keys 1 through 10 to select one of
Window Color's preassigned color sets.

P

L

itve Window Title
Inactive Window Information Box -
—Lp Arrow
vertical Scroll Box
[;”:t 1 “inacive window Venical Scroll Bar
Fill L vertical Scroll Bar Slider Space
] p Down Arow
Right Arfow | " To! Size Box
¢ 2 ! — A VAL Inactive Window Size Box
Horizontal Scroll Box
[Save ]| ][ Cancel ]
Leh Arow

Horizonial Scroll Bar Shoer Space
Inactive Window Horzontal Scroll Box

You can choose four options for each window element. Border
allows you to choose the color of the narrow border that surrounds -
each window element. Use Text to choose the color of any text or
icon (as in the case of the Full box) that appears within the selected
window element. Fill is the background color of the selected
element, and you can also choose one of the eight fill patterns

“ appearing directly under the Fill scroll bar. The fill color will appear

in the selected pattern.

The Mode box allows you to toggle between having text appear
directly on the fill pattern, and having text appear within a solid
background over the fill pattern.
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When you assign active window element colors and then select

Save or OK. the new colors will display the next time you open a

window. Any window that was opened before will not reflect the
. new active window element colors. 3

Ty

Before you assign window element colors, choose the color set you
wish 1o use. You can: use the factory assigned default color set,
press a function key (1 through 10) to use a Window Colors
preassigned color set, or use Color Setup to create a custom color
set.

Follow these steps to assign active and inactive window element
colors:

1. Select a window element for color assignment. A box outlines
the selected element.

2. Click and drag the appropriate scroll box to assign Border, Text,
and Fill colors to the highlighted window element. Click on the
desired Fill Pattern. 3

3 Select the desired Mode. Repeat steps 1 through 4 until all the
desired colors have been selected.

4. Choose Save to permanently save the selected window element
colors. OK to select and use the current colors until you switch
off the TT (the next time you start the TT the most recently
Saved colors will appear), Cancel to exit Window Colors and
return to the Control Panel menu (no changes are saved).

3y

Color Setup

Depending on your monitor type and the screen resolution you

. have selected, up to 256 colors can display at one time on your
screen. You can choose the colors you wish to have displayed from
a palette of 4,096 available colors (except in TT High resolution,
which is monochrome only).

Color Setup allows you to choose which colors from the color

palette you wish to have available for use when you assign window
colors. See Window Colors.
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15

Pen Number ———

Pen Number Scroll Bar—— 2 b—— AGE Color Tuning Scroll Bars

b Gray/Color Box

5%
Bank [¢[ B | Gray
Bank Dispiay Box Save [ Cancel | [Reload]

Bank Scroll Bar

Think of the 4,096 available colors as a collection of inks. These
colors are divided into smaller groups called banks. The Bank
Display Box can display a bank of up to 16 colors. The number of
inks in a bank will be the same as the number of colors your
resolution is able to display on the screen at one time. Except in the
TT High and TT Low resolutions, you can scroll through 16 difterent
banks of inks. The number of inks that can display in your resolution
at one time is your color palette of inks.

Banks of inks will display in the Bank Display Box as you scroll
through the different banks. Each bank will contain 2, 4, or 16 inks,
depending on the number of colors your chosen resolution is able
to display on the screen. (TT Low Resolution, which is able to
display 256 colors at once, does not have banks of inks. You use
the Pen Number Scroll Bar to scroll through 256 pens instead of
using)the Bank Scroll Bar to scroll through banks of 2, 4, or 16
pens.

You can modify a bank to display the colors you wish to have
available for screen display. Follow these steps to modify the pens
in the displayed bank:

1. Select the desired mode with the Gray/Color box. Select Gray
(the word Color displays) to display banks of pens in shades of
gray only, or select Color (the word Gray displays) to display
banks of colored pens. Gray mode is most commonly used with
gray-scale monitors.
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@ Note: In ST High resolution, you have the Invert option in place
of the Bank Scroll Bar. Invert allows you to invert the screen.

2 Use the Bank Scroll Bar to scroll through the available banks (if
applicable to the selected resolution). Display the bank that
contains the collection of pens that most nearly matches the pen
colors you desire. (In TT Low resolution, use the Pen Number
Scroll Bar to display the pens you wish to modify.)

3. Select the pen you wish to modify by: moving the pointer over
the desired pen and clicking the mouse button, or using the Pen
Number Scroll Box to display the number of the desired pen. A
black box outlines the pen selected for modification.

4. Now use the RGB Color Tuning Scroll Bars to change the color
of the highlighted pen. Changing the ratio of Red, Green, and
Blue will change the color of the highlighted pen.

Repeat steps 3 and 4 for every pen to be modified.

5. After you modify the displayed bank as desired, select Save to
permanently save the palette, OK to select and use the bank
until you switch off the TT (the next time you start the TT the
most recently Saved banks will appear), Cancel to exit the Color
Setup CPX and return to the Control Panel menu (no changes
are saved). or Reload to display the most recently saved
defaults. If you wish to return the banks to the factory set
defaults, press [CIr Home].

@ Note: You can restore the currently displayed bank to the condition
it was in before you opened it. Simply press [UNDOI. Use Reload to
restore all banks.

Configure CPXs

Configure CPXs allows you to change the name, choose the
displayed text and icon color, and change the RAM resident status
of CPXs.
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CONTROL PANEL
¢ General Setup.—_ | Name e

GEMERAL

CPX Options
Text Color:

¢
Icon Color: ¢l 4 [%]
RAM Resident:
| Save | | Bantell

Ram Resident Box

o]

To configure a CPX, you must first display the name of the desired
CPX in the name line. Use the left and right scroll arrows to scroll
through the CPX list.

When the Configure CPXs window displays, the text insertion
cursor is already positioned at the end of the CPX Name line. To
change the name of the displayed CPX, press [Esc] to clear the
entire Name line, or press [Backspace] {0 erase one character at a
time. Then type in the new CPX name.

To select Text and icon colors, use the appropriate scroll arrows to
display the 16 different available colors. The name and icon
displayed on the Name line will display the selected colors.

You can also set the RAM resident status of the selected CPX.
Position the pointer over the shaded RAM resident box and click
the mouse button. move the pointer to highlight the desired status.
Click the mouse button to save the highlighted selection.

When the desired text/icon color selection displays, and the desired
RAM resident status is selected, click on OK or Save.

Note: RAM resident status takes effect only at start up time and
when you change resolutions.
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General Setup

The General Setup CPX allows you to set the keyboard response
and repeat rate, the mouse double click response rate, and the
audio feedback. It also allows you to toggle on and off the CPU
Cache option and display system statistics such as TOS version
number and amount of available RAM.

%] CONTROL PANEL
- Response - ﬂcymamﬂes{mnseﬂaleS_hdef

Status Selection Box

afl  Repeat Rate __ Keyboard Repeat Rate Slider

218,94 2
Cache Selection Box —— - r
— Double Click Speed Selector

Sound Selection Box ~ Double Click Speed Test Box

STATUS

Select the Status box to display the TOS version number and date,
the number of available bytes of ST RAM and TT RAM, and the
number of total bytes available.

AUDIO FEEDBACK

The computer has two kinds of audio feedback, a click signaling
each keystroke and a bell signaling keyboard or mouse errors.

To control audio feedback, select the keytop button or the bell

button. A gray image means that the sound has been turned off. A
clear image means that sound is turned on.
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CACHE

For complete information about the CPU cache, refer to Cache in
Chapter Three. To turn the cache option on or off, position the
pointer over the Cache box. Click the mouse button. Move the
pointer until the desired selection highlights, and click the mouse
button again.

SOUND

If you want all sound turned off, pasition the pointer over the Sound
box. Click the mouse button. Move the pointer until the word Off
highlights, and click the mouse button again.

KEYBOARD RESPONSE

Every key on the computer keyboard responds when pressed, and
every key (except [Shift], [Control], [ESC], [CapsLock] and
[Alternate]) repeats its character if held down. The keyboard repeat
controls how much time it takes for the keys to repeat when they
are pressed, and how quickly they repeat after the repeat process
begins.

The upper slider controls how soon a key starts to repeat. Moving
the slider to the left makes the keys repeat sconer. Drag the slider
to the desired position, then release the left mouse button.

The lower slider controls the speed at which the keys repeat once
they start repeating. Move the slider to the left to make the keys
repeat faster. Drag the slider to the desired position, then release
the left mouse buttan.

Test the new settings by turning the sound on, if required, and
pressing [Space Barl. You will hear a click each time you press the
space bar. Listen to the clicks to judge the repetition speed of the
keyboard.
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DOUBLE-CLICK RESPONSE

You can adjust the TT's response to double clicking. To slow the
computer’s response to double-clicking. allowing you to double-click
more slowly, select a numbered box nearer to the resting mouse
icon. To quicken the computer’s response to double-clicking (for
fast double-clicks), select a numbered box nearer to the running
mouse icon.

After setting the double-click response, you can test the setting by
double-clicking on the Double-Click Response Test box. When you
double-click at the set rate or faster, the box will briefly highlight.

Modem Setup

The poris labeled Modem on the back of the computer are RS232
serial ports. By connecting a- modem to the computer, you can
communicate with other computers. You can also connect a serial
printer or any other RS232 device to the modem ports.

The Modem Setup CPX lets you configure the computer's modem
ports to work with your modem or other serial device. Refer to the
manual supplied with your peripheral for specific information on
which parameters to choose. The parameters needed by the
computer with which you are communicating (the remote device) is
known as the communications protocol.

SERIAL PORT SELECTOR

The Serial Port Selector allows you to tell the computer which of
the available serial ports to recognize as active. Select the port you
are using for the connected modem.
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BAUD RATE

Baud rate is the speed at which data is transmitted. Baud. the stan-
dard unit measure of transmission speed, is the number of signal
elements per second. The fastest rate available to you is 19,200
baud: the slowest is 50 baud. Set the baud rate to accommodate
both your modem and the remote computer's modem. (The baud
rate for bulletin board systems is usually listed along with the phone
number for the board.)

To set the baud rate, position the pointer over the Baud Rate box.
Click once. Use the up and down arrows to scroll through the baud
rate selections. When the desired baud rate displays, move the
cursor to highlight the desired rate. Click the mouse button to select
the highlighted rate.

PARITY

Whenever computers transmit data through telephone lines, there
is a chance that some of the information will become garbled due to
imperfections and noise within the lines. Parity is a error checking
procedure that computers use to examine information and
determine whether data was cleanly transmitted.

The parity bit is added to a group of bits to make the total number
of bits transmitted odd or even. Transmission errors can be
identified when the number of bits in a group does not match the
parity chosen (odd or even). Depending on the modem and the
remote device, you will choose either None, Odd, or Even parity.
(Refer to the manual supplied with your modem for specific
information.)

To set the parity, position the pointer over the shaded Parity box.
Click once. Use the cursor to highlight the desired parity. Click the
mouse button to select the highlighted option.

BITSICHAR
Each character is stored in memory as one byte. Usually a byte is
made up of eight bits. Depending on bits per character used by the

remote device, you may need to change the number of bits per
character when transmitting through the RS232 port.
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To set the bits/char, position the pointer over the shaded Bits/Char
box. Click once. Use the cursor to highlight the desired number of

~  bits per character. Click the mouse button to select the highlighted
option.

o

STOP BITS

The stop bit indicates the end of an asynchronous RS-232
character. You will normally use 1 stop bit, but you may need to use
1.5 or 2 stop bits. .

To set the number of stop bits, position the pointer over the shaded
Stop Bits box. Click once. Use the cursor to highlight the desired
number of stop bits. Click the mouse button to select the highlighted
option.

FLOW CONTROL ' q

e Te ar.

You can choose between two flow-control protocols: Xon/Xoff, and
Rts/Cts. Flow control protocals are procedures that allow your
computer and the remote device 1o signal one another when to start
or stop sending information. Choose the flow control supported by
the remote modem.

PR R

To select a Flow Control protocol, position the pointer over the
shaded Flow Control box. Click once. Use the cursor to highlight the
desired flow control protocol. Click the mouse button to select the

highlighted option.

.'.m‘ " ¢

Printer Setup

Any program may access the printer configurations set by the
Printer Setup CPX. For example, the Print Screen option under the
Options menu uses the printer setup information. Other utilities or
applications may not. Check the manuals supplied with your
programs to see if a program can use the printer setup information.
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0 Note: You cannot configure an Atari SLM laser printer with the
Install Printer dialog box. Instead, refer to the Atari SLM Printer
Emulator User's Manual (supplied with the SLM laser printer) for
instructions on changing printer settings. If you have both an SLM
and dot-matrix or daisy wheel printer connected to your computer

~ you may be able to select the printer type within your application. If
not, you must turn off one of the printer driver programs.

To configure your printer, display the Printer Setup CPX window.
Position your pointer over the shaded box representing the setting
you wish to change. Click the mouse button. Move the pointer over
the desired setting. When the setting highlights, click the mouse
button to select the highlighted setting.

PRINTER TYPE

The choices are Dot (dot matrix printers) and Daisy (daisy wheel
printers). Select the appropriate box for your printer.

COLOR

The choices are B/W (black and white, or monochrome) and Color.
Select the appropriate box for your printer.

LN
PIXELSI/LINE

Only dot matrix graphics printers use the Pixels/Line option. Pixel
means picture element. On dot matrix printers, a pixel is a dot. Dot
matrix printers print a certain number of pixels per line when
printing in graphics mode. If you have an Atari dot matrix graphics
printer, select 1280. If you have an Epson, or Epson-compatible dot
matrix graphics printer, select 960. Both values assume an eight-
inch printed line.

QUALITY

Only dot matrix printers use the Quality option. Select Draft for
draft-quality printing. Select Final for letter or near-letter quality
printing.
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In Draft mode, the printer may make only one pass of the print head
when printing. For darker printing, select Final. Keep in mind that in

Final draft mode the printer will generally make two passes of the
print head, thus taking twice as long to print the page.

ath

Note: Do not select Final if your printer does not support near-letter
quality printing.

g .

el ",-"{.".‘_‘?.""’9'““9'{'; ~ ":[‘rW" '!“‘-
PAPER

ek ik

If your printer feeds paper automatically by means of a tractor or
single-sheet feeder, select Feed. If your printer accepts only a sheet
at a time which you must insert manually, select Single. The Single
option prevents the printer from printing beyond the end of a page
on documents longer than a single sheet.

PORT 4

If you have a parallel printer, select Printer. Parallel printers connect
to the port marked Printer on the back of the computer. If you use a
serial printer, select Modem. Serial printers connect to the port
marked Modem (the RS232 port) on the back of the computer.

Note: For most serial printers, Xon/Xoff flow control is set to On.
This setting enables the printer to signal the computer to
temporarily stop sending data so it can print data it has already
received. (See RS232 Configuration earlier in this chapter.)

Sound Setup

The Sound Setup CPX allows you to adjust the balance, volume,
bass, and treble stereo sound output. To generate a tone to test the
current sound settings, position the pointer over the face icon and
click the mouse button.

All Sound Setup settings can be adjusted in two ways. You can use

the scroll arrows to scroll through every possible setting, or you can
click on and drag the scroll box from one setting to another.
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The Balance setting determines the strength of the audio signal
sent through both the right and left speakers. You can adjust for an-
even balance. or send a stronger signal through the right or left
speaker. You can use the Bass and Treble settings to adjust the
strength of low and high register tones, respectively. The Volume
setting adjusts the volume of sound.

When the setting highlights, click the mouse button to select the
highlighted setting.

Accelerator

The Accelerator CPX allows you to adjust the speed at which the
onscreen cursor responds to the movement of your mouse. The
Accelerator also contains a screen saver.

" CONTROL PANEL

f Fast
(o]}
| — Screen Saver Delay Shider

Super Fast
Mouse Accelerator

Screen Saver Box———

Modem Recognilio

There are three Mouse Accelerator settings: Off, Fast, and Super
Fast. Choose the Off setting if you do not wish to increase the
response speed of the cursor. Select Fast or Super Fast to increase
the cursor response speed.

To select a new cursor response speed, position the pointer over
the desired setting and click the mouse button.
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The Screen Saver will automatically darken the screen after a set
period of inactivity. To activate the Screen Saver, select the Screen
Saver box. When the Screen Saver is active, the Screen Saver
Delay slider and the Modem Recognition icon appear as solid
objects on the screen. When the Screen Saver is inactive, the
Screen Saver Delay slider and the Modem Recognition icon appear
as outlines.

b
When the Screen Saver is active, it will automatically darken the
screen after a period of mouse and keyboard inactivity. You can set
the number of minutes of inactivity in two ways. You can use the
clock icons on either side of the Screen Saver Delay slider as scroll i
arrows, or you can drag the scroll bar. Release the mouse button
when the desired number displays in the scroll bar.

Modem Recognition allows you to choose whether or not you want
the Screen Saver to recognize modem activity. If the Modem
Recognition is on, the Screen Saver will recognize any modem
activity and will not activate. If the Modem Recognition is off, the
Screen Saver will ignore modem activity and will activate after the
set delay period of keyboard and mouse activity has passed.

3
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APPENDIX A
TT PANELS AND PORTS

Back Panel Ports
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APPENDIX B
POINTER CONTROL
QUICK REFERENCE

The following table lists mouse functions and keystroke
combinations. You may copy this page and post it near your
computer for quick reference.

Action

Move pointer.

Select item.

Select and
open item.

Drag item.

Right
button
functions.

Mouse Function

Roll mouse in desired
direction.

Position pointer on item.

Click left mouse button.

Position pointer on item.

Double-click left mouse
button.

Select item. Hold down
feft mouse button. Roll
mouse in desired
direction.

Click right mouse
button.

Keystrokes

[Alternate] any arrow
key moves pointer eight
pixels in the direction of
the arrow.

[Alternate] [Shift] any
arrow key moves pointer
one pixel in the direction
of the arrow.

Position pointer on an item.
Press [Alternate] [Insert].

Position pointer on an item.
Press [Alternate] [Insert]
twice.

Position pointer on an item.
Hold down the [Alternate]
[Insert] keys and use arrow
keys to move the item.

[Alternate] [CIr Homel

Pointer Control Quick Reference
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APPENDIX C -
ADVANCED HARD DISK UTILITIES

This appendix contains information about the Atari Advanced Hard
Disk Utilities disk. It applies to both the internal SCSI and external
SCSI or ACSI hard disk drives. This disk contains programs and
files that allow you to:

» Park and Unpark the read/write heads
» Install or remove the hard disk driver file
« Format and partition the hard disk
» Erase the contents of a logical drive
* Extend the system-wide folder limit
* Mark bad sectors
' » Create an Extended Partition Scheme : 28

You will not use these programs as part of the hard disk’s daily
operation. Instead, the programs allow you to start the drive for the
first time, perform functions that are required from time to time, or
maximize your use of the hard disk drive. This chapter will help you
choose the programs and utilities you need.

PARKING AND UNPARKING THE
READ/WRITE HEADS

Whenever you move your computer, you should park the hard drive
heads to prevent damage to the hard disk and the data it contains.
Parking the hard disk drive heads moves the read/write heads of
the drive away from the disk media. Parked heads cannot damage
the disk media during moving or shipping. The Atari Advanced
Hard Disk Ultilities include two types of head parking programs. One
type parks the disk heads of all hard drives connected to your
system. The other parks the disk heads of individual units.

@ Warning: If you fail to close all hard disk windows before parking
the drive heads you may damage data on your hard disk.

Advanced Hard Disk Utilities
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Parking Drive Heads on all Units  — **7« =

To park the hard disk drive heads on all hard disks connecled to
your system, run SHIP.PRG. You must run this program from a
floppy disk in drive A or B.

) Note: SHIP.PRG will not park the heads of a Megafile 44
Removable Hard Disk Drive. :

With a directory of the Atari Advanced Hard Disk Utilities disk
displaying, follow these instructions to run SHIP.PRG.

1. Open the HDX folder.
2. Close all other open windows. *

3. Run SHIP.PRG. - R

4. Switch off your hard disk units assoon as the desktop appears.

Parking Drive Heads on Selected Units

- . To park a specific hard drive, you must select a physical unit to be
.' ' parked. With your hard disk utilities disk in drive A or B, follow these
instructions to park the heads on individual physical units:
1. Run the HDX program.
. Close all other open windows.

. Select the Ship option on the Disk menu.

a W™

. A dialog box displays, asking you if the hard disk drive to be
formatted is an ACSI drive or a SCSI drive. Select the
anC appropriate drive type. Click on OK o continue.

5. When the Select physical unit(s) dialog box appears, select the
physical units that are to have their heads parked. Select OK.

Advanced Hard Disk Utilities
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0 Note: You can select any physical unit connected to your
system (formatted or not). The unit number boxes of connected
devices appear shadowed.

5. An alert box message appears on screen offering you a last
chance to cancel the head parking procedure.

Select OK to park the heads. 1

6. A final alert box appears, instructing you to turn off your hard .
disk.

Select OK and switch off the power to your disk drive(s).

0 Note: If you are preparing to move your entire system, switch off
your computer at this time.

Unparking the Drive Heads

The next time you start your system the drive heads are
automatically unparked.

INSTALLING AND REMOVING
THE HARD DISK DRIVER FILE

The HINSTALL.PRG program installs or removes the hard disk
driver file. The hard disk driver allows you to start your system from
your hard drive.

Installing the Hard Disk Driver

Display the directory of the HINSTALL folder. Follow these steps to
install the hard disk driver:

1. Run HINSTALL.PRG.

2. Select Install from the File menu.

Advanced HardsDisk Utilities.
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3. Select a logical drive for the operationi. You can only select
logical drives that are highlighted in shadowed boxes. Select OK.

4. From the displayed dialog box, select OK to install the driver, or
Cancel to abort the operation.

'F%emoving the Hard Disk Driver

Display the directory of the HINSTALL folder. Follow these steps to
remove the hard disk driver:

1. Run HINSTALL.PRG.
2. Select Remove from the File menu.

3. Select a logical drive for the operation. You can only select
logical drives that are highlighted in shadowed boxes. Select OK.

4. From the displayed dialog box, select OK to install the driver, or
Cancel to abort the operation.
B

Bypassing the Hard Disk Driver

As an alternative to removing the hard disk driver, you can simply
bypass the driver. To do so, switch off your computer (or perform a
keyboard coldboot) and make sure there is a floppy disk in drive A
that does not contain a hard disk driver file. Switch on the system.
The drive light comes on, and then goes off. Immediately hold down
[Anternate]. Release [Alternate] when the floppy drive’s busy light
goes back on.

Advanced Hard Disk Utilities
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FORMATTING AND PARTITIONING THE ~*
HARD DISK

Warning: The HDX Format and Partition options described in this
chapter completely erase all data on your hard disk. Back up all of
your valuable files before proceeding. .

Formatting

You will probably never have to re-format your hard disk. The hard
disk has already been formatted at the factory. Formatting the hard
disk creates magnetic patterns called tracks and sectors. The
process also marks and logs bad sectors, areas on the disk with
surface damage or other imperfections. Data stored in these areas
could be corrupted or lost. During hard disk operations, the
computer avoids sectors marked and logged as bad. The
formatting process also automatically divides the hard disk into
storage areas called partitions or logical drives.

The internal hard disk drive is already formatted. Formatting erases
all information from a disk and prepares the disk to accept data.

You may need to format the hard disk if the factory format becomes
erased due to mishandling or if the hard disk develops bad sectors.

Display the directory the HDX folder. Follow these instructions to
format a hard disk:

1. Select HDX.PRG. Then select the Format option from the Disk
menu.

2. Read the alert message that appears on screen. |f necessary,
back up all your data before proceeding.

Select OK to continue.

3. A dialog box displays, asking you if the hard disk drive to be
formatted is an ACSI drive or a SCSI drive. Select the
appropriate drive type.

Select OK to continue.

Advanced HardSDisk Utilities
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4. Select a physical unit (hard disk drive) for formatting. If you are
formatting only the internal hard disk, select UNIT 0. If you are
formatting an additional hard disk, select a unit that corresponds
to the hard disk's DIP switch settings. (See your hard disk drive
owner’s manual for information about DIP switch settings.) Units
in shadowed boxes are the units that are connected to your
system.

M Select The Physical Unit #h

UNIT 8]

) [

Select OK to continue. A dialog box may appear, displaying a list
of hard disk unit types.

5. Select the hard disk type showing your drive’s model name.

Select the unit type:
[HEGAFILE 60) [MEGAFILE 44 [MEGAFILE 10]

[MEGAFILE 20| SHZ85 [ SH204 |
[ sHipd |

Coc ] [eaneer]

Select OK to continue.
5. Read the alert message that appears on screen.

Select OK to format the unit. A message appears informing you
that formatting is in progress.

Note: When the partitioning message disappears, the formatting
operation is complete.

Advanced Hard Disk Ultilities
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When formatting is complete, the Format option automatically
initiates the Markbad and Partitioning options. To find out more
about these functions, refer to the sections on Marking Bad Sectors
and Partitioning.

The default partition quantity and size is determined by the hard '
disk drive model.

* b by et

Partitioning

The TT's internal hard disk drive is already partitioned. Partitioning
a hard disk is a process that divides the disk into sections. Setting a
partition size tells the hard drive how much storage capacity to
assign to each partition. You can use the factory-set partition
capacities or change the storage capacity of each partition to suit

your file organization needs.

Partitioning divides your physical hard disk into data storage
areas called logical drives. Each logical drive is pre-installed and
will automatically appear on your desktop unless you re-partition
the disk. Partitioning allows you to store and access your data
efficiently by allowing you to group files and folders in different
logical drives.

Use the Partition option to create partitions in sizes best suited to

your disk storage needs. The Partition option lets you use an

editing menu to set the size of each partition or select a

guggesled partitioning scheme without having to reformat your
isk.

Note: When you repartition your hard disk, you must use the
Install Devices command to install desktop icons for the logical
drives.

Advanced Hard Disk Utilities
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Selecting a Unit to Partition L AR

Display a directory the HDX folder. Follow these instructions to
partition a hard disk:

1. Select HDX.PRG from the HDX folder. Then select the Partition
option from the Disk menu. .

2. A dialog box displays, asking you if the hard disk drive to be f
formatted is an ACSI drive or a SCSI drive. Select the
appropriate drive type.
a . |
Select OK to continue. The Select a physical unit dialog box 1
displays. i
3. Select a physical unit for partitioning. To partition your hard disk,
select the unit number of the device you want to partition. Only
units in shadowed boxes can be selected.
Select OK to continue.
4. Select a partitioning scheme. . 1

There are two ways to select a partitioning scheme. You can use
the Choose a Partition Scheme dialog box to choose from preset
partitioning schemes. Or you can use the Edit Partition Scheme
dialog box to create a customized partitioning scheme. The
following sections fully describe each method.

Selecting a Partitioning Scheme

After you select a physical unit for partitioning, the Edit Partition
Scheme dialog box displays.

Use the Edit Partition Scheme dialog box to create a customized
partitioning scheme. If you wish to select a preset partitioning
scheme, click on Menu to display the Choose a Partition Scheme
dialog box.

From the Choose a Partition Scheme dialog box you can click on
the Edit box to return to the Edit Partition Scheme dialog box.

Advanced Hard Disk Utilities
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Crﬁllng"i"ﬁilﬁoﬁﬂzed Partitioning Scheme

The Edit Partition Scheme dialog box displays information about the
selected unit's current partition scheme.

=
£ /N Edit partition scheme of the unit /N

Total # of Partition(s): 4
Hemory Left: OMb
w105 (816
wp [ILSHb][e]e]
3

| s [(1LS](319)

L 5]
[ MERU)[UKDO ][ oK J[CANCEL] FERT 1

Information lines appear at the top of the dialog box. The Total line -

displays the current total number of partitions. The Left line displays
the number of megabytes on your disk that have not yet been
assigned to any partition.

Each partition’s size is displayed to the right of the partition number
in the edit box. Minimum partition size is 1 megabyte. Maximum
partition size is determined by the capacity of your hard disk. You
can allocate all of the memory on your hard disk to one partition.
For example, a 40 megabyte hard disk can have a single partition
containing all 40 megabytes of memory. .

Use the scroll bar to scroll through partition boxes. To view the 28
partitions you can click on the shaded area of the scroll bar to scroll
through four partitions at a time.

Click on the partition box you wish to create or edit. Then click on
the up and down arrows to the right of the partition size box to
increase or decrease partition size. Clicking on an Unused box
creates a new partition.

Note: There must be available bytes listed on the Left line before
you can increase the size of any partition. 1 megabyte or more
must appear in the Left box before an unused partition can be
activated.
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You can select Menu to display the Choose a Partition Scheme - !
dialog box. This dialog box allows you to choose preselected 1
partitioning schemes.

To return to the most recent partition scheme, select Undo.
OK initiates the partitioning process. . i
If you want to return to the HDX.PRG main menu, select Undo.

The Expert option is shaded and cannot be selected unless you
have more than four partitions. You need to use the Expert option
only if you plan to use more than one operating system. If you are
planning to use more than one operating system with the same
hard disk, see Appendix E, Extended Partition Schemes.

Selecting a Preset Partitioning Scheme s

The Choose a Partition Scheme dialog box appears when you
select Menu from the Edit Partition Scheme dialog box.

Choose & partition scheme!
AT11-11-11 T13-13-9-9 | [15-15-7-7
EE : [17-17-5-5 | [13-19-3-T |

&) [Cae] (e

The Choose a Partition Scheme dialog box provides a list of
suggested partitioning schemes. Select the scheme you want from
the list. Select Edit to return to the Edit Partition Scheme box.

After you select a partitioning scheme, select OK to partition the
disk.

i 408 [ %
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ERASING THE CONTENTS OF A LOGICAL"
DRIVE

You can erase all data from a selected logical drive with the Zero
option of the HDX program. Erasing (or zeroing) a logical drive is
useful if you want to clear the drive to make room for new data or if
you want to erase damaged data from a logical drive without
reformatting (and thus erasing) the entire hard disk.

Display a directory of the HDX folder. Follow these steps to erase
the contents of a logical drive.

1. Select HDX_PRG. Then select the Zero option from the Disk
menu.

2 Read the alert box that appears on screen. Select OK to
continue.

3. Select a drive for zeroing from the Select the Logical Drive  # j 4
dialog box. Select OK to continue. hitd

4. An alert box appears giving you a final chance to quit the
program before proceeding.

Select OK to continue.

EXTENDING THE SYSTEM WIDE FOLDER
LIMIT

You can run FOLDER100.PRG to extend the number of folders
your system recognizes. Though most users will be able to create
as many folders as they wish without problems, you can still use
FOLDR100.PRG to extend the folder limit even further.

Advanced Hard Disk Utilities
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To use this program, display The AUTO folder directory on drive
C containing the FOLDR100.PRG file. Then change the 100 in
the filename to any value between 001 and 998 using the Show
Info option from the File menu. The value you enter is the
number of folders beyond 40 you can now access. For example,
to extend the limit to 240 folders, you would change the filename
to FOLDR240.PRG.

The FOLDR program must be stored in the AUTO folder of the
startup disk (partition C on the hard disk if physical unit 0 is the
startup disk).

The new folder limit takes effect when you reboot your system.
During the boot procedure, a message appears that shows how
many exira folders you have designated and how many bytes of
HA# are allocated 1o the extra folders. Each folder uses 132 bytes
of RAM.

MARKING BAD SECTORS

o

Error messages stating that the data on your disk may be damaged
might indicate the presence of bad sectors on your disk. If such
error messages frequently appear, you should check your hard disk
for bad sectors. This process identifies and flags defective areas on
the hard disk. Hard disks may develop defective spots after the
drive has been in use. Once these spots have been logged with
Markbad, they will not be used for your hard disk operations.

The Atari Advanced Hard Disk Utilities disk includes two versiorfs of
Markbad. One version is run automatically during the HDX Format
option. This version operates on the entire selected physical unit
and erases all data on the disk during formatting. The other version
operates on the selected logical drive when you run the HDX
Markbad option. This version helps you preserve data by letting you
decide whether or not to erase data containing bad sectors.

Both versions of Markbad display a log of any bad sectors found.
The cumulative tally of bad sectors in the log appears during
subsequent Markbad operations.

Note: You can use the HDX Markbad option on hard disks
formatted with a previous version of HDX.

Advanced Hard Disk Ultilities
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" Display the directory of the HDX folder. Follow these steps to mark
= bad sectors on selected logical drives:

1. Select HDX.PRG. Then select the Markbad option from the Disk
menu.

2. Select a logical drive from the Select the Logical Drive dialog

box.
Select the logical drive
e o J[CE: JL Fr )
e JCw JCn Ja |
i o [N | N | N FR | N T
T | T
o]

Select OK to continue.

3. While Markbad scans the logical drive for bad sectors, a
message appears telling you that the program is marking bad
sectors. If bad sectors are found in a file, select a course of
action for the file from the Logical Drive Markbad dialog box.
This box displays the name of the file, the address location of the
bad sector and cluster in the logical drive, and your choices for a
course of action.

Note: The Logical Drive Markbad dialog appears only when
Markbad flags bad sectors in allocated clusters. An allocated cluster
is a cluster that has been assigned to a file.

/N Logical Drive Markbad M
File
E:\SAHPLE.DOC

Bad sector: 627.
Cluster: 266

L Delete file |
[ TIgnore bad sector |
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Select Delete File toerase the file or Skip Over Bad Sector to
preserve the undamaged portions of the file. Select Ignore Bad
Sector 1o leave the file unchanged. (Select Ignore Bad Sector if
you want to examine the file before taking action.)

If bad sectors are found in a subdirectory file, select a course of
action for the subdirectory from the Logical Drive Markbad box.
This box displays the name of the subdirectory, its address
location, and your choices for a course of action.

Select Delete Directory Only to delete the directory structure and
save the deleted directory files to the root directory. All files
saved to the root directory will be named "TMPnnnn” where
"nnnn” stands for the starting hexadecimal cluster address of the
file. Select Delete Directory And Files to delete the directory
structure and all of its files. Select Ignore Bad Sector if you don't
want to take any action at all.

Q Note: If a bad sector is found in a lost cluster, an alert box
appears giving you the option of marking the cluster. A lost
cluster is a segment of data that is unaccounted for and
inaccessible to the system.

5. When Markbad finishes scanning the disk, a Logical Drive
Markbad tally box with the total count of newly found bad sectors
8 and the count of all previously found bad sectors appears.

ek
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ORGANIZING AND MAINTAINING YOUR
HARD DISK

e

The larger storage capacity of a hard disk means that careful folder
and file organization is more important than ever. When planning
and using your folder structure, keep the following tips in mind.

« Use folder names that describe the types of files in the folders.
Keep files organized in folders so you can easily find them.

* Keep as few files as possible in the root directory.
« Keep the files you use most often in the first level of directories.
« Delete unneeded files to free up disk space for new files.

Backing Up the Hard Disk e

It is important to frequently back up your hard disk data.

.. Otherwise, accidentally deleted or damaged files will be lost

" forever. As a general rule, it is good practice to back up new or
modified files after each session at your computer.

To back up your data, regularly copy important files or folders onto
floppy disks and store them in a safe place. In addition to the copy
option, you can use one of the many hard disk backup programs
available through your Atari dealer or Atari user groups (see
Customer Support).

i)
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Optimizer Programs

An optimizer program checks the structure of your hard disk and
rearranges files and free space on the disk. The multiple sectors of
each file are grouped together. Contiguous free space is placed
either at the top of the disk (to increase the speed of writing new
files to the disk) or at the bottom of the disk (to increase the speed
of accessing existing files). Back up your data, then use a file
optimizer program regularly to increase the speed and efficiency of
your hard disk drive and to reduce the possibility of data corruption
and loss.

Use one of the many hard disk optimizer programs available
through your Atari dealer or Atari user groups (see Customer
Supporl),

EXTENDED PARTITION SCHEMES

Creating an extended partition scheme is an option for advanced
users. You will probably never need to use this option in the normal
operation of your computer.

There are four slots on your hard disk that keep track of partition
information. You can fill each slot with a standard partition, and
have each partition represented on your desktop by a logical drive.
Or you can fill one of the four slots with an extended partition to
obtain more than four logical drives.

An extended partition is subdivided into more than one partition.
This allows you to have more than one logical drive representing
that slot.

0 Note: To store system startup data the first partition must be a
standard partition. This partition is always assigned to the first slot.
You cannot select the first slot to contain the extended partition.
You must use one of the three remaining slots to contain your
extended partition.

Advanced Hard Disk Ultilities '
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Supporting TOS as Y8ur primary dbperating system, HDX.PRG will
automatically choose slot number two to contain your extended
partition. However, if you plan to use more than one operating
system, it may be useful to choose the specifics of the partition
assignments. Some operating systems will not recognize an
extended partition scheme. The partitions you use with these
operating systems must be standard partitions.

The Expert option of the Edit Partition Scheme dialog box allows
you to choose which slot will contain the extended partition, and
which of four slots will contain standard partitions.

The Select the extended partition scheme dialog box displays the
current extended partition scheme. The Partition section on the left
side of the dialog box shows the partition number, size, and range
of each partition. The Extended Partition Range dialog box on the
right side of the dialog box allows you to choose which slot will
contain the extended partition scheme.

The Extended Partition Range dialog box displays each slot’s range
of partitions.

In the example below, all four slots contain partition information.
The first slot contains partition one. The second slot contains the
extended partition, which is subdivided as partitions two through
eight. The partitions included in the extended partition are always
highlighted. The third slot includes partition nine, and the fourth slot
contains partition ten. Slots one, three and four contain standard
partitions.

é:Sg_:le_ct__:;he' .e_gttended__pgr_fti.::_thn scheme |

Partition  Extended Partition Range

#1__ [10.6Mb from #Z to ®8
B 10.6Mb “from #2 to #3
Yl 10.6Mb from B2 to #18
LTH 4. 6HD fron HI to #9
from #I to #18 |
¢ from #4 to B10
u__ D .
H__

|__Mb |
wio. [_iMb | (@ eorT)[ok ] [CARCEL]
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- OTHER ADVANCED HARD DISK UTILITIES
DISK FILES

e HDX.RSC is a GEM resource file used by HDX.PRG
.« WINCAP is a text file that includes information used by
HDX.PRG.
* HINSTALL.RSC is a GEM resource file used by
HINSTALL.PRG.

« SHDRIVER.RAW is used with HINSTALL.PRG to create
SHDRIVER.SYS, the hard disk driver file that directs your
system to start from a hard disk.

-
o
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APPENDIX D
THOUBLESHOOTING AND
PREVENTIVE MAINTENANCE

TROUBLESHOOTING

If you run into problems while connecting or operating your
computer, don't panic. You can probably fix it yourself. This
section describes some common problems and suggests
solutions.

0 Note: The most common and easily fixed problem is failure to

switch on the power to the computer or the monitor. Always check
this first betore exploring other possibilities.

It Will Not Switch On : “tRIG L e iV

If the power light will not come on or the video display stays dark-
the remedy is easy. Follow these steps:

1. Switch off all components in your system (the computer, .
external drives, the monitor, and all other peripherals).

2. Make sure all cables are correctly and securely fastened.
Check the power cables and the video cable.

3. Check your wall socket or power strip by plugging in a desk
lamp or appliance.

4. Switch on all components.

5. Check the brightness and contrast adjustments on your
monitor. Turn up the adjustment knobs if necessary.

Troubleshooting and Preventive Maintenance
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- No Desktop

If the power lights come on, the monitor brightens, and the busy
lights for the internal floppy and hard drive's busy lights light up,
but the desktop does not display. you may have a bad desk
accessory file in your startup disk or folder.

v
With the computer switched off, place a disk in floppy drive A (do
not use the Advanced Hard Disk Utilities disk). Switch on your
system. (If you need to bypass an installed hard disk driver, hold
down [Alternate] when drive A’s busy light comes on. Release the
key when the busy light shuts off.) The basic desktop displays.

Next, remove the disk from drive A. If the questionable desk
accessory resides on a floppy startup disk, insert the floppy disk '
into drive A. Remove the file from the disk. If the questionable

desk accessory resides in the root directory of your hard disk,
remove the file from drive C.

Switch off your computer and restart in your usual way.

o

Software Problems

If you have problems with an application, it may be that the soft-
ware contains imperfections (bugs). Try coldstarting your system,
then switch it on again. Reopen the application. If this helps, it
may mean the application experienced a momentary tailure. !

If you still experience problems, make a new working copy of the ¥
application from the original application disk onto a newly 3
formatted floppy disk. Try running the application from the new
copy. If you are running the application from your hard disk,
remove the questionable file from the hard disk and copy it again
from the original application disk back onto the hard disk. If this
works, the problem is probably with the original working copy of
the application file. If none of your disks work properly, you may
need to replace your original application disk.

Troubleshooting and Preventive Maintenance
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You may find that some older programs (especially games) do not
run properly with the Cache option turned on. If you think this may
. be the problem, make sure the Cache option is off before running

. the program.

Bombs @

Sometimes applications develop errors that are potentially
damaging to the computer’s operating system. When such an
error occurs, TOS detects the error and terminates the program.
As a signal to you, TOS displays one or more bombs across the
screen and attempts to recover from the error.

To protect the computer’s operating system, immediately perform
a keyboard coldboot when you see bombs displayed. If the
problem recurs, discontinue using the program.

The Hard Disk Drive

Some symptoms identify the hard disk drive as the source of the
problem. Many problems can be easily remedied using the
Advanced Hard Disk Drive utilities.

Common Problems

Use the following table to identify and correct common hard disk
drive problems.

Troubleshooting and Preventive Maintenance
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Problem it ARSI

N E™T gy s s M)

Hard disk drive icon C does not
appear when you swilch on your
system.

The system will not start from the
hard disk.

An application program will not
start from the hard disk.
start

Suggested
Solution

It you are starling your system
from a floppy disk drive. make
sure the startup disk contains
AHDI.PRG in the AUTO folder.
If you are starting your system
from the hard disk, AHDI.PRG
must be in the AUTO folder on
drive C. If you have AHDLPRG
in the proper folder and the
system slill does not display
disk icon C. you may need to
reformat the drive. (See
Formatting in Appendix C))

Run the hard disk driver
installation program
(HINSTALL.PRG.) If the
problem continues, the hard
disk should be backed up and
reformatted. (See Backing Up
the Hard Disk and
Formatting in Appendix C.)

The program contains garbled
data or was not designed lo

from a hard disk. Try starling
your system from the floppy .
disk drive with a working copy
of the program. Attempl o run
the program from the program
disk. It it still will not run,
contact the program's
manufacturer for more
information.

Identifying and Replacing or Erasing Corrupted Data

If you still have problems, your hard disk may have developed
unusable data. Unusable data appears altered or is unusable. Try
erasing individual bad files and replacing them with valid backups.
If replacement is not possible, follow these steps to try and

recover data:

Troubleshooting and Preventive Maintenance
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1. Run the Markbad option of the HDX program on the Atari
Advanced Hard Disk Utilities disk (as described in Marking Bad
Sectors in Appendix C) in each logical drive containing
unreadable data. Recover as much data as possible. o

2. Back up the data recovered from the logical drive onto floppy
disks.

3. Erase all data in the problem logical drive(s) with the Zero
option of the HDX program and run Markbad on the logical
drive again.

4. Copy the data you backed Up on to the logical drive. #onnsd

If the main drive (drive C) contains unreadable data, you may not
be able to start your system from the hard disk. Use a working
copy of the Atari Advanced Hard Disk Utilities as a floppy startup
disk to start the system. Follow the steps above, then install the
hard disk driver as described in this appendix. .

-aft
Error Messages

If an error ressage appears while you run one of the Atari
programs from the Atari Advanced Hard Disk Utilities disk, the
problem is usually something easily remedied. If you aren't sure
what to do when an error message appears, read the message
carefully for a suggested solution. If there is no suggested
solution. find the message in the alphabetical list below and try the
solution suggested.

Program

Error andlor Suggested
Message Option Solution
Bad Seclor List is corrupted! HDX See message.
Try backing up the disk Format
and reformatting it. Partition
[oK] Zero

Markbad
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Error
Message

Cannot creale driver
full.

at destination! R

Cannot find format .
parameters for disk type
<disk lype name>

[OK]

Cannot find partition scheme
<selected partition scheme>
[OK]

Cannot format
<selected unit>!

Try checking all the | "IL'

conneclions and
reformatting.
[OK]

Cannot open driver
source file!
[OK]

Cannot partition
<selected unit>!
Try reformatting.
[OK]

Cannot read Bad Seclor
List from the disk!

Try backing up the disk
and reformatting.

[OK]

£{ Program

and/or
Option

HINSTALL

Install

HDX

HDX
Partition

HDX

“* Format

HINSTALL
Install

HDX
Partition

HDX
Format
Partition
Zero
Markbad

Suggesied
Solution

Your root directory may be

You need to delete dala to
make room for the driver
file. Or, your root directory
may be corrupted. If so,
back up as much data as
you can and reformat the
drive.

Make sure the original
WINCAP tile is on the disk
wilh HDX.

This partition scheme is not
recognized by HDX. Make
sure you are using your
original WINCAP file.
Warning: Do not modify the
WINCAP file. Doing so may
destroy the disk.

Make sure your hard disk is
securely connected as
explained in Chapter 1.
Then reformat the drive.

Make sure the
SHDRIVER.RAW file is on
the disk with
HINSTALL.PRG.

n3
See message.

See message.

Troubleshooting and Preventive Maintenance
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Error g
Message,

Cannot rfad Boot Sector
from the Jogical drive!
Try backing up the disk
and refofmalting.

K
Cannot rLad File Allocation
Table from the logical drive!

Try backing up the disk and .

reformatting:
[OK]

Cannot read from directory! _

Try re-running Markbad on
this logical drive when the
current Markbad is
completed.

[OK] amarsimnn

Cannot read Root Directory
entries from the logical drive!
Try backing up the disk and
relormalting.

[OK]

Cannot read Root Sector
from the disk!

Try backing up the disk
and reformatting.

[OK]

Cannol save any more
files in the root direclory!
Deleting the remaining lost
clusters of the subdirectory
will free up disk space.
[OK] [CANCEL]

Bt 1~

Program
andl/or
Option

HDX

Zero
Markbad
HINSTALL
Install

HDX

© Partition

Zero
Markbad

HDX
Markbad

HDX
Markbad

HDX
Partition
HINSTALL
Install
Remove

HDX
Markbad

Suggested
Solution

See message. ad

See message.

See message.

S

See message. -+

See message.

When the Markbad option
found a bad sector in a
subdirectory, you directed
the program {o save the
deleted directory’s files to
the root directory. There is
no more room in the root
directory for the files. Either
select OK to delete the rest
of the directory’s files or
select CANCEL touse a
disk utility that can recover
the directory’s liles.
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Error T
Message

Cannot write Bad Sector
List to the disk!

. Try backing up the disk
and reformatting.
[OK]

Cannot write Boot Sector
fo the logical drive!

Try backing up the disk and
reformatting.

[oK]

Cannot write driver
file to destination!
[OK]

Cannot write Header
to the logical drive!

Try backing up the disk
and reformatting.

[OK]

Cannot write Root Directory
entries to the logical drive!
Try backing up the disk and
reformaltting.

[oK]

Cannot write Root Seclor
to the disk!

Try backing up the disk
and reformatting.

[oK]

Cannot write 1o directory!
Try re-running Markbad on
this logical drive when the

current Markbad is completed.

[oK]

Driver file does not exist!
[oK]

Program
andl/or
Option

HDX
Format
Partition
Zero
Markbad

HDX
ZERO
HINSTALL

HINSTALL
Install

HDX
Zero

HDX
Markbad

HDX
Format
Parlition
HINSTALL
Install
Remove

HDX
Markbad

HINSTALL
Remove

Suggested v
Solution &
See message. “w

See message.

HINSTALL cannot write to
the root directory of the
drive. Try backing up the
hard disk and reformatting it.

See message.

See message.

See message.

See message.

The driver lile
SHDRIVER.SYS

has nol been installed or is
missing.
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Ertor
ssage

File Allocation Table is
corrupted!

Try backing up the logical
drive and zeroing.

[OK]

Format parameters in the
root sector are corrupted!
Please reformal the disk.
[OK]

HDX.RSC
(oK)

No menu items available
for this disk's capacity.
{oK]

Not enough system memory!
Cannot continue.
[OK]

Reserved seclors are bad!
Try backing up the disk
and reformatting it.

[OK]

Selected partition scheme
is for a bigger capacity unit.
Please select another one.
[OK}

Too many bad sectors to
record. Try backing up
{he disk and reformatting.
[oK]

Program
andlor
Option
HDX

Markbad

HDX
Partition

HDX

HDX
Partition

HDX
HINSTALL

HDX
Format
Partition

HDX
Partition

HDX
Markbad

Suggesled
Solution &

Back up the logical drive,
erase its data with the HDX
Zero option. run Markbad.
and restore your data.

See message.

The HDX.RSC file is either
missing or damaged. Copy
the HDX.RSC file from the
original Atari Advanced Hard
Disk Utilities disk onto your
working copy of the disk.

Use the Edit Partition
Scheme dialog box to set
partition sizes.

Your computer's memory
capacity is too low to run
these programs. You need
a minimum of 512 kilobytes.

See message.

See message.

See message.
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Program

Erfor b St and/or Suggested el
Message X Oplion Solution
Too many logical drives! HDX You cannol have more thz
You cannot have more than Format 14 |logical drives on your
14 logical drives. : Parlition system. Repartition disks :
[OK] necessary.
Unrecognized boot sector! HDX Before you can use Zero ¢
Either this logical drive's Zero Markbad, you must back v
boot sector is corrupled. or +  Markbad your hard disk (if necessai
another utility was used to and reformat with HDX
artition this disk. Format.

OK]
WINCAP file not found! HDX Copy the WINCAP file on
Cannot continue. the Advanced Hard Disk

~ [oK] Ulilities disk to the disk fro

which you are running HD
Your system will have to HDX No action required. Your
rebootl when you quit HDX, Format syslem will reboot when y¢
for new disk information Markbad quit HDX so the disk
to take effect. paramelers you changed
[OK] can lake effecl. Any data il
8" XGH RAM will be lost.
The Mouse
iz |

With time, the mouse may begin to move slowly or sporadically.
If this happens, make sure the mouse is plugged firmly into
mouse/joystick port 0. If the problem persists, the mouse may
need cleaning. (See the Atari Mouse manual for instructions.)

Monitors

If you have both an Atari color monitor and an Atari monochrome
monitor set up side by side, make sure only the one connected t
the computer is switched on. With both monitors switched on, yo
may get interference patterns on the screen. If you only have on
monitor switched on and you get interference patterns, some
other peripheral may be causing the trouble. Try moving power
supplies. printers, and modems as far away from the monitor as
possible.

Troubleshooting and Preventive Maintenance
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PREVENTIVE MAINTENANCE

To ensure top performance from your TT computer system, follow
the guidelines in this section.

Caring for the Computer

Always place the system securely on a firm, level surface.

Avoid dusty or greasy work areas.

Keep all components away from extreme heat or moisture.

Keep all components out of direct sunlight. ¢v MW

Do not move the components unnecessarily.

Avoid smoking near the computer system. ¢ ..i""\l-”ﬁ' 3,
Keep liquids away from the components. A,

Always switch off the system before cleaning it. Clean the outside
of the components with a soft, slightly damp, lint-free cloth only.
Do not use cleansers, abrasives, or solvents.

Always switch the computer off before inserting or removing a "
cartridge.

Always switch the computer and peripherals off before connecting
or disconnecting components.

When you switch off the computer, wait at least ten seconds
before you switch it on again.

To ship or store the system, repack it in the original factory
packing materials. Always park the hard disk before moving your
TT.

Troubleshooting and Preventive Maintenance
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Caring for Floppy Disks
Do not switch the floppy disk drive off while its busy light is lit.
Do not insert or remove disks while the floppy drive’s busy lightis
lit.
Do not leave disks in the floppy drive when the drive is off.

Keep disks away from sources of magnetism (such as monitors,
televisions. electric motors, and telephones).

Never leave disks in direct sunlight. %

Never touch or clean a disk's magnetic recording surface inside
the plastic casing.

A FINAL NOTE

Your TT computer system is designed for low maintehance and
high reliability. But like anything electronic and mechanical, the
equipment can break down. .

If you experience problems that appear serious, take the
computer (or any other component) to an authorized Atari service
center. For the location of the nearest Atari service center, contact
your Atari dealer or Atari Customer Support. (See Customer
Support at the end of this manual.)

Troubleshooting and Preventive Maintenance
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APPENDIX E
TT COMPUTER SPECIFICATIONS

Processor .- it 68030 32 MHz processor

Math Coprocessor 68882 floating point coprocessor

Memory Two, four, six, or eight megabytes
e of RAM, depending on the model.

Expandable to 26 megabytes of
RAM, using 4-Mbit DRAM chips

Lt s Y by

Graphics Resolutions ST Low (320 x 200 x 16)
ST Medium (640 x 200 x 4)
L ST High (640 x 400 x 2)
S RN TT Low (320 x 480 x 256) »
TT Medium (640 x 480 x 16)
TT High (1280 x 960 x 2)

...a

Color ... . = Palette of 4,096 colors

Interfaces
Midi In and Midi Out ports

VME-compatible Eurocard (A24,
D16) expansion slot

Monitor port
Parallel port
2 Serial ports

2 fully configured RS232 Modem
ports

Floppy Disk port (includes
controller)

SCSI port
LAN Interface

ACSI DMA port (10 megabits per
second DMA transfer rate)

TT Computer Specifications
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Interfaces, continued

Sound Generator

Keyboard

Power Consumption

Ambient Temperature

Relative Humidity

Physical Characteristics

L (:1;-&-. Sl
-

ROM Cartridge port (128 kilobytes

capacity)
Mouse/Joystick and Joystick ports
Stereo ports

g

Pulse Code Modulated (PCM)
sound (8-bit digital-to-analog sound
converters)

3 voices from 30 Hz to above
audible range; built-in amplitude
envelopes and noise generator

95-key intelligent keyboard using its
own MICroprocessor

95 Watts (maximum)

41 to 113°F (5 to 45°C), operating
or idle, -4 to 149°F (20 to 65°C),
storage, -40 to 149°F (-40 to 65°C),
transport

20% to 80%, operating or idle;
(noncondensing) up o 95%,
storage or transport

Height: 90 mm, 3.54 inches
Width: 490 mm, 19.29 inches
Depth: 290 mm, 11.41 inches
Internal power supply

TT Computer Specifications
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Internal Floppy Disk Drive

Storage Medium 3Vz-inch floppy disks, double-
density, double- or single-sided,
135 tracks per inch

Storage Capacity 360 kilobytes per side (formatted
MFM); 720 kilobytes total

Track Density 135 tracks per inch

Head Positioning Stepper motor

Mechanism

Data Transfer Speed 250 kilobits per second

TT Computer Specifications
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APPENDIX F T,

CONNECTOR PINOUT
SPECIFICATIONS

MODEM 1

DB9 Male

MODEM 2

DB9 Male

Wo~JoOosawh —

WENOU&WN =

Connector Pinout Specifications

i e

- & T 8 W

Carrier Detect

Received Data
Transmitted Data

Data Terminal Ready ™"~
Ground

Not Connected

Request To Send

Clear To Send

Ring Indicator

R i

Carrier Detect

Received Data ¥
Transmitted Data

Data Terminal Ready
Ground

Data Set Ready

Request To Send

Clear To Send

Ring Indicator

Input
Input
Output
Output

Qutput
Input
Input

5]
Input
Input
Qutput
Output
Input
Output
Input
Input
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SERIAL 1

DB9 Male

WO O & wh —-
'
H

12 3% a4 8

. T8 R

-- Not Connected

-- Received Data P

-- Transmitted Data -3
-- Data Terminal Ready (1) :
Ground

--  Not Connected

- Request To Send (1)

-- Not Connected

- Not Connected

Input

Output
Output
Output

(1) Data Terminal Ready and Request To Send on this port are asserted

whenever

SERIAL 2

DB9 Male

the TT power is on.

v 1203 408

a7 8N

-- Carrier Detect

-- Received Data

-- Transmitted Dala

-- Data Terminal Ready
Ground

-- Data Set Ready

-- Request To Send

-- Clear To Send

-~ Synchronous Clock
Synchronous Clock

WO N & WN —-
'
H

Connector Pinout Specifications
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Input
Input
Output
Output
Input
Output
Input
Input
Output

e
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WA BT 8 8 4 )2

PAHALLEt PH'NTEH ' E RN N N
. 8 8 8 8 888N
DB25 Female EEEEEEEEEE
o o
1 -- Strobe Qutput
2 - Data0 i -
3 -- Datat -
4 -- Data2 -
5 -- Data3 ==
6 -- Data4 -
7 -- Data$s 3 -
8 -- Datab
9 -- Data?7 -
10 -- Not Connected -
11 -- Busy Input
12-17 -- Not Connected -
18-25 -- Ground -
MIDI OUT
5-pin DIN female
1 - THRU Transmit Data
2 -- Shield Ground
3 -- THRU Loop Return 3 1
4 -- OUT Transmit Dala R A
5 -- OUT Loop Return 2
MIDI IN '

5-pin DIN female

- Not Connected
--  Not Connected
Not Connected
-- IN Receive Data
-- IN Loop Return

N wWwn —
'
H

Connector Pinout Specifications
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MONITOR o757 ., H

.

High Density DB15 " ot

-- Analog Red M
-~ Analog Green

- Analog Blue

- High Resolution Monochrome (ECL)

- Ground

-- Red Return

--  Green Return P

-- Blue Return
--  Monochrome Monitor Detect 10 0
10 -- Ground

11 -- Not Connected YT
12 -- Not Connected

13 -- Horizontal Sync (TTL)

14 -- Verlical Sync (TTL)

15 -- High Resolution Monochrome (ECL}

WD 5 W =
i
R Y]

FLOPPY DISK

14-pin DIN female

-
-- ReadData
-~ Side 0 Select
-~ Ground
-~ Index Pulse
External Drive Select " ™
-- Internal Pull-up ' .
- Ground : .
--  Motor On
-- Direction In s
10 -- Step LY
11 -- Wirite Data
12 -- Write Gate
13 -- Track 00 Detect
14 -- Write Protect

OO WN—
'
'

Connector Pinout Specifications
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ACSI DMA 7 o
ACSI Interface, DB 19 Female ‘ T PP S G A G

-- Data0
-- Data 1
-- Data2
-- Data3
- Data 4
-- Datab
Data 6
w e 8 7 & % & 3 2

-- Data?7
-- Chip Select S'totooa-..]
-- Interrupt Request R

--  Ground e w1y e 13
-- Reset
13 -- Ground o
14 -- Acknowledge 4 g
15 -- Ground , )
16 - Al .
17 -- Ground Tt
P 18 -- Read/Write L
o 19 -- Dala Reques! 1

A oe ) ~ 4

N=O0OE~NON&sawn =
f
.

——

Connector Pinout Specifications
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CARTRIDGE

40-pin PCB Edge Connector, Female

1 -- +5VDC

2 -~ +5VDC

3 -- Data 14

4 -- Data 15

5 -- Datai2

6 -- Data13

7 -- Data 10

8 -- Data !l

9 -- Data8

10 -- Data$9

11 -- Datab .

12 - Data?7 2

13 - Data4 L

14 - Data5 b

15 -- Data2

16 -- Data3 -

17 -- Data0

18 -- Data1 Ly s e M NB OB ABDBTANNB NN
19 - Address 13 MR
20 -- Address 15 R T Y EEEEE RN
21 - Address 8 2 4 6 B 10 12 14 16 A 2022 24 26 78 %0 32 M B @

22 - Address 14

23 -- Address 7

24 -- Address 9

25 -- Address6

26 -- Address 10

27 -- Address 5

28 -- Address 12

29 -- Address 11

30 -- Address 4

31 -- *ROM Select 3

32 -- Address 3

33 -- *ROM Select 4

34 -- Address 2

35 -- *Upper Dala Strobe

36 -- Address 1

37 -- *Lower Data Strobe
38-40 -- Ground

Connector Pinout Specifications
F-6
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MOUSE/JOYSTICK 0
DB9 Male

-- XB/Up

== XA/Down
-~ YAlLeft
-~ YBIRight

- +5VDC
--  Ground

W=~ Wwh —=
|
:

JOYSTICK 1 °+

Middle Button/Joystick Up
-- Left Button/Fire

12 3 4 8§

a7 8@

-~ Right Button/Joystick 1 Fire

LR B D R
e s s b

DBIMale

- Up

-- Down

- Left

-- Right
Reserved
-- Fire Button
- +5VDC

--  Ground

WO &WN—
f
i

STEREO AUDIO OUTPUT

Dual Jacks
Tip — Audio
Shield = Ground

12 3 48

a7 8 @

Not Connected

Connector Pinout Specifications
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SCslI

DB25 female

P = = b ot ot b
CWLENONLWN—=COOIONEWN—

MR N
=W -

LAN

*REQ
*MSG

*O A
*RST o 1
*ACK /
*BSY
Ground
DATA O
Ground @
DATA 3

DATA S

| R
(a7 B

"o

vt

" -

we & 7T 8 S 4 3 2

DATA 6
DATA 7

\

L I L B
8 8 8 " 8 0 088N

7

AUNTBYO

Ground

*CID

Ground

*ATN

Ground

*SEL

DATA PARITY
DATA 1

DATA 2

DATA 4
Ground

Not Connected

8 pin Mini-DIN female RS-422

@I D WA -

Handshake Output

» N

R I

Ge

Vet

ot el

JHTUOOQUA

o

Handshake Input or Internal Clock

*Transmit Data
Ground
*Received Dala
Transmitted Data

General Purpose Inpul

Receive Data

Connector Pinout Specifications
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APPENDIX G | o o
POWER CONNECTION = =
IN THE UNITED KINGDOM

MAINS PLUG

In the United Kingdom, the Atari TT computer operates on
240VAC. 50 Hz mains supply. The wires in the main lead of the
TT are colored as follows:

Green/Yellow —  Earth (E)
Blue —  Neutral (N)
Brown -~ Live (L)
GreenlYellow . Y= prnln o

Blue Fuse

]

Brown

Cord
Grip

If the colors of the wires do not correspond to the colored
markings identifying the terminals in your plug, proceed as
follows:

*1. Connect the GREEN/YELLOW wire to the terminal in the plug
marked by the letter E or by the safety earth symbol, or colored
GREEN or GREEN/YELLOW.

2. Connect the BLUE wire to the terminal marked with the letter N
or colored BLACK. Connect the BROWN wire to the terminal
marked with the letter L or colored RED.

3. If you use a 13-amp (BS1363), you must fit a 3-amp fuse. I

you use any other type of plug, you must fit a 3 or 5-amp fuse
in either the plug, the adapter, or on the distribution board.

Power Connection in the United Kingdom a
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MAINS PLUG ADAPTER

The wires in the mains lead are colored in accordance with the
following code:

Blue —  Neutral (N) i _
Brown - Live (L) 5 70 2lAi
o2 11 ol U arf !
L Coc s DAV
;I KRR E
“inea
[ .

5

If the colors of the terminals in this device do not correspond with
the colors of the terminals in your plug, proceed as follows:

1. Connect the BROWN colored wire colored to the terminal 8
marked with the letter L or colored RED.

2. Connect the BLUE colored wire to the terminal marked with the
letter N or colored BLACK.

3. If you use a 13-amp (BS1363), you must fit a 5-amp fuse. If

you use any other type of plug, you must fit a 5-amp fuse in
either the plug, the adapter, or on the distribution board.

921"

Power Connection in the United Kingdom
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GLOSSARY B uh s

.ACC The desk accessory extension. )
[ e Lk e ]
ACSI Atari Computer System Interface. ACSl is a hardware and software
control procedure used to connect devices to the computer's Hard Disk port

(DMA channel). HUHIRI
active window The window on GEM Desktop that is currently available for

desklop operations such as selecting. copying. moving, and deleting items. 3

The active window is the only window that you can scroll, update, move, or

resize. pe)

alert box A dialog box designed to bring something to your attention. Alert
dialog boxes are puncluated with stop signs, question marks, or exclamation
points.

.APP An executable GEM program file extension. SR L L

application A program written to solve a specific problem or produce a specific
result. and can be executed by a computer. That is, the computer is applied sa0.
1o the task. (See program.)

back up To make an archive copy of a disk or file. Backing up disks ensures twsighias
that information is not lost if the disk is accidentally damaged or erased. -t

baud The standard unit of transmission speed of data through a modem,
calculated in signaling elements per second.

baud rate The speed at which data are transmitied from one source to
another, usually from one computer through a modem to another computer.

bee icon The icon displayed on screen whenever the computer transfers or
retrieves information from the disk drive. You cannot proceed to another
actlion while the bee icon is on screen.

bit The smallest unit of computer data (a binary digit). Eight bits equal one 5o ¢
byte. (See byle.)

boot Initial system load procedure. If the procedure for loading your system is
in ROM, booting is accomplished by switching on your system. (See
coldstart and warmstart.)

boot disk A disk containing the system files needed to boot a computer. (Not
needed for TT compulers, since all TT system files are in ROM.)
11
busy light The light on a disk drive indicating that the drive is reading from or
writing to a disk.

Glossary
1
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byte A unit of computer data. Each byte consists of eight bits, providing 256
possible values. For example, the letter "a” is stored in memory as one byte.
(See bit and kilobyte.)

cache A special co-processing circuit in the TT computer that greatly improves
the speed operations.

cartridge A device (usually containing files and data in ROM) that plugs into
the cartridge slot. Cartridge programs load instantly and do not use any of
the computer's Random Access Memory to load. The cartridge in the
cartridge slot is designated by the c: identifier.

CD-ROM drive A computer-controlled device thal reads high-capacity optical
discs and sends the output to the computer.

click To quickly press and release a mouse button. A click on the left mouse
button selects items on the desktop. (See double-click and shift-click.)

clock/calendar The file-dating feature built into the computer and set from the
Control Panel.

close box The small box in the upper left corner of an active window, used to
close the current window.

coldstart Booting the computer by switching the power off and on or pressing
[Control] [Alternate] [Right Shift] [Delete]. A coldstart can be initiated
while the computer is running by switching off the power for 10 seconds,
then switching it back on. A coldstart completely initializes the system.
(Compare to warmstart.)

configure To customize the computer sysiem to your preferences by setting
colors, baud rate, confirmation, and so on.

control panel A desk accessory used to alter and set many of the system's
features and opftions, such as the color paletle, mouse and keyboard
response, and the clock/calendar.

copy A command used to duplicate the information in a file, folder, or disk.

current directory The directory currently displayed in a window, as specified
by the pathname in the move bar.

cursor A marker that appears on the screen to indicate the position of the next
action. Text cursors are usually either a blinking block or a solid vertical line.
The mouse pointer is sometimes called a cursor.

daisywheel printer A type of printer that uses a rotating wheel 1o impact
characters against a ribbon and onto the paper.

data file A collection of information used by an application. Data file icons look
like sheets of paper with one folded corner.

Glossary
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default A value. option, or setting that the computer automatically selects until
you direct it otherwise. For example, items on the desklop are shown as
icons. by default, unless you change the option in the View menu.

desk accessory An application loaded into memory from the startup disk
when you switch on your computer. Desk accessories can be accessed
either directly from the desktop or from an application that uses the menu
bar format. Desk accessory files are identilied by the .ACC extension.

desktop The main screen for the computer. It includes (but is not limited to) the
menu bar. two disk icons, and the trash icon.

destination disk The disk that intormation is written to during a copy
procedure.

dialog box An interactive message box that the computer uses to communi-
cate with you. To exit a dialog box, you must acknowledge the message or
choose an optlion.

directory A list of files. (See current directory, root directory, and
subdirectory.)

disk drive The most common data storage device. The computer uses the
disk drive to read information from or write information to a disk.

disk identifier The letter in a pathname indicating which disk is in use. The
letter is always followed by a colon {:} and a backslash (\). A disk identifier
appears by itself in the move bar of a directory window when the root
directory displays.

diskcopy A procedure that duplicates data from one disk 1o another disk.

DMA port A high-speed peripheral port for altaching a hard disk drive, CD
ROM drive. or other DMA device to the computer. DMA is an acronym for
Direct Memory Access. (See ACSI.)

document A collection of data you create or modify using an application. Docu-
ments can contain text, graphics. or both. Also called a file. (See file.)

document type See extension.

dot matrix printer A type of printer that forms characters and graphics by
printing small dots.

double-click Two quick clicks on a mouse button. A double-click on the left
mouse button opens a file, disk, or folder.

double-sided Allowing use of both sides of a disk. A double-sided disk has
both sides of its magnetic media certified as sale for storing data. A double-
sided disk can store up to 726,016 bytes of data. A double-sided disk drive
can read. write 1o, and format both single- and double-sided disks.
(Compare to single-sided.)

Glossary
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drag To move an item on the desktop. To drag. point the mouse pointer at an
item, press and hold down the left mouse button, and move the mouse.
While the item is being dragged, a ghost outline of the item appears on the
desktop.

(&S
drop-down menu A list of options that appears below a menu heading when
you touch the menu bar heading with the mouse pointer.

editable text field A dashed line in a dialog box where you can type
characters.

expansion connector An internal connector that permits installation of
additional specialized hardware with your computer. The signals provided
include a direct extension of the microprocessor bus.

extension The characters to the right of the period in a filename. Extensions
that represent the file type are mandatory. An extension can have up to
three characters {(letters and numbers). Some common extensions are sl
.ACC, .APP, PRG, .TOS, and .TTP. .

file A collection of information that can be stored on a disk or in the computer's
memory.

file selector A dialog box. opened from an application. that lists files and
folders. The File Selector dialog box can be accessed from the application.

file specification The search criteria used in a file selector.

filename The name of a file, made up of a mandatory name and an extension,
separated by a period. (See extension and filename.)

floppy disk A magnetic medium used io store information generated on a
computer. The disk is made of material similar to audio tape.

folder A subdirectory for storing liles and other folders. A folder appears as a
folder icon (manila folder) on the desktop, or with a foider symbol (small box)
next to its name when shown as text.

format To set the circular patterns on a floppy disk that enable it to store
information. Formatting erases all information previously stored on the disk.

full box The small box in the upper right corner of a window, used to change
the size of a window alternately between a smaller screen and a full-screen.

function keys The keys [F1] through [F10] along the top edge of the
computer keyboard. Many applications use these keys lo perform special
actions.

GEM The portion of TOS that creates and manages all the windows, icons,
menus, and graphics leatures of the TT computer. GEM is an acronym for
Graphics Environment Manager.

Glossary
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hard disk A device used to store data on a magnetic surface. A hard disk drive W
can store far more data than a floppy disk drive, and can read and write
information many times faster.

hardware The aclual physical apparatus of your computer system. (Compare #shom
to software.) 8
icon A picture on the desktop thal represents a disk, file, folder, or procedure.
The disk icon looks like a filing cabinet; the data file icon looks like sheets of
paper with one corner folded: the program file icon looks like a small
desklop; the folder icon looks like a manila folder: the trash icon looks like a 1
trash can; and the bee icon looks like a bee.

information line The line at the top of a directory window immediately below
the move bar. telling how many bytes are used by the items listed in the
directory, and how many items there are.

initialize To set the computer to its starting configuration.

input/output (I/0) The communication process that takes place between the
computer and a peripheral device such as a disk drive or printer. Input is
information the computer receives (that is, it is sent in): output is information  avom
the computer transmits (that is, it is sent out). W

interface An electronic connection that allows communication between the e
computer and a peripheral. :

kilobyte 1,024 bytes of data. {(See Byte.)
L
laser printer A high-speed. high-resolution printer that electrophotographically
produces an image on paper. The Atari SLM804 is a laser printer.

LAN (Local Area Network) is a communications channel that connects
computers and other devices together.

megabyte 1.024 kilobyles of data. The abbreviation for megabyte is MB. (See  ™i!q0
kilobyte.)

memory The internal or external media that the computer uses 1o store data
and programs. There are iwo kinds ol computer memory: RAM (Random
Access Memory) and ROM (Read-Only Memory). RAM loses its data if the
power is turned off; ROM retains its information whether the computer has
power or not.

menu bar A bar at the top of the desktop. When you first start up your system,
the headings on the menu bar are Desk, File, View, and Options. Other
application programs may have different headings in the menu bar.

Glossary
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MIDI! A standard interface designed to connect a computer to a number of
electronic musical devices. MIDI is an acronym for Musical Instrument Digital
Interface.

modem A device that enables you to connect your compulter directly to
telephone lines in order to establish a communication link with other
computers and on-line information networks. Also, the port on the computer
for connecling a modem or other serial device. Modem is a contraction of
MOdulator/DEModulator.

monitor See video display.

mouse A small. hand-manipulated device connected to your computer that
controls the movement of a pointer on the deskiop. As you slide the mouse,
a small roller on the bottom tracks the movements. The mouse has two
buttons. The left button is used for most desktop operations. The right
button is used with some applications.

move To move files or folders from their original locations to a different iolder
and/or disk.

move bar The bar at the top of an active window. Use the move bar to drag a
window to a new location on the desktop.

MS-DOS Microsoft Disk Operating System. An operating system used with
IBM PC's and compalibles. Floppy disks formatted on the TT are compatible
with PC systems using MS-DOS and 3z-inch floppy drives.

name The identitying name of a file. A name is mandatory and can have up to
eight characters (letters and numbers).

NEWDESK.INF The file that holds your customized desktop data.
NEWDESK.INF must be in the roof directory of the boot disk in order for the
computer lo read it during booting.

option An item in a drop-down menu that enables you to manipulate the
desktop and the elements on it.

parallel port An interface which accepts the simultaneous transmission of
more than one bit. (See serial port.)

parameter Data given to a program that controls its operation.

pathname The list of items that specifies the path through the subdirectories
on the disk to the current directory. A pathname consists of a disk identifier
and a string of folders separated by backslashes (for example
A:\documentitextl). It may also contain a file specification.

peripheral Any external device, such as a disk drive, monitor, or printer, that
you connect to your computer.
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pixel A dot on the computer’s video display. Pixels are arranged in a grid, and
set to either 320 x 200, 640 x 200, or 640 x 400 dots per grid, depending on
your screen resolution. Pixel is short for picture element.

pointer The smaI‘I image on the screen that moves when you move the mouse.
The mouse pointer is usually an arrow, but it may change to other shapes
such as a bee icon during certain procedures.

.PRG A GEM application file extension.

program A detailed and explicit set of instructions for accomplishing some
purpose, expressed in a language that can be read by a computer. (See
also Application.)

program file A file that contains an applications program. The program file
icon looks like a small desktop. Double-click the leit mouse button on a
program file to execute the program.

prompt Any symbol or message on screen indicating that the computer is
awaiting input from the user.

RAM The part of the computer’'s memory used 10 write data to and read data
from a disk. When you work with your computer, the information displayed
on the monitor screen is in RAM. RAM is an acronym for Random Access
Memory. —

RGB The color signals that the computer produces lo create its special color
display. The combinations of 16 different intensities each of red, green, and
blue enable you to create 4,096 colors with the TT computer. RGB stands
for Red, Green, Blue.

ROM The part of the computer's memory containing the operating systerh.
ROM never changes. and retains its information with or without power to the
computer. ROM is an acronym for Read-Only Memory.

root directory The first directory displayed when you open a disk. The root
directory is specified by the disk identifier alone (such as AN

RS232 An industry-standard connection for serial peripherals. The RS232 port
on the back of the computer is labeled "Modem.” This port is sometimes
referred to as the serial port.

scroll Scrolling allows different areas of a window to be displayed. You can
scroll left, right, up, or down.

scroll bar One of two bars that border an active window on the bottom and
right edges. The scroll bars contain the scroll arrows and are shaded if part
of the window's contents cannot be seen. The larger the shaded portion, the
greater the percentage of the window's contents that is hidden from view.

scsi (Small Computer Systems Interface) bus is a standard bus that
allows you to connect SCSI peripheral devices to your TT computer.
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sector A section of a track on a hard or floppy disk. Sectors are usually 128,
256, 512, or 1024 bytes long. On a floppy disk, the sectors are 512 bytes
long. (See track.)

selecting Clicking the left mouse button on an icon, file, or menu option.
Selected icons and files highlight to indicate the selection.

serial port An interface which accepts the transmission of data one bitata . |,
time. (See parallel port.) -

shift-click Clicking with the mouse button while holding down the [Shiftlkey.

single-sided Allowing use of one side only of a floppy disk. A single-sided disk
has only one side of its magnetic media certified as safe for storing data. A
single-sided disk can store up to 357,376 bytes of data. A single-sided disk
drive can read, write to, and format only single-sided disks, or double-sided
disks that have been formatted as single-sided. (Compare to double-
sided.)

‘A

size box A small box at the lower right corner of a window, used o change the

window's size or shape.

sizing The process of changing the size or shape of a window.

software The instructions used by your computer to process data. (Compare
to hardware.)

source disk The disk from which information is copied during a Diskcopy
procedure.

startup disk A disk that usually contains desk accessories, applications, and a
desktop configuration (DESKTOP.INF) file. Insert a startup disk in the
floppy drive before the computer is switched on.

subdirectory A directory inside a directory; often called a folder. (See root
directory.)

i fnT
.TOS The TOS application file extension.
TOS The operating system for the TT computer.

track One of the circular sections of a disk that can store data. Each track is
made up of smaller sections called sectors. (See sector.)

trash can GEM Desklop icon used to permanently delete files or folders from
the deskiop.

_.TTP The TOS-takes parameters file extension.

video display A device containing a video screen that you and your computer
use to communicate.

Glossary
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VMEDbus allows you to connect standard VME devices for high speed
asynchronous parallel data transfer.

warmstart Rebooting the computer by pressing the Reset button on the back
of the computer or pressing [Control] [Alternate] [Delete]. A warmstart
only partially initializes the system. (Compare Coldstart.)

wildcard A question mark (?) or asterisk (*) character used in a file
specification to specity the search criterion. "?" replaces one character; ™"
replaces all characters to the end of the first name or extension.

window The work area that the computer uses 1o display files and folders or to
run programs. Up to four directory windows can be open on the desktop at
one time.

write-protect To mechanically prevent a disk from being formatted, erased, or
written to. To write-protect a disk, move the write-prolect tab so you can see
through the nolch.

Glossary
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CUSTOMER SUPPORT

Atari Corporation welcomes inquiries about your Atari computer
products. We also provide technical assistance. Write to Customer
Relations at an address listed below.

Atari user groups also provide outstanding assistance. To receive a
list

of Atari user groups in your area, send a self-addressed, stamped
envelope to an address below.

In the United States, write fo:

Atari Corporation
Customer Relations
P. O. Box 61657
Sunnyvale, CA 94088

In Canada, write to:

Atari (Canada) Corp.
90 Gough Road
Markham, Ontario
Canada L3R 5V5

In the United Kingdom, write to:

Atari Corp. (UK) Ltd.
P. Q. Box 555
Slough

Berkshire SL2 5BZ

Please indicate User Group List, Technical Assistance, Of the subject
of your letter on the outside of the envelope.
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INDEX

A

About. 6-3
ACC extension, 4-3, 5-5
ACSI,

port, 1-10

devices, 1-10
active window, 3-13
advanced hard disk ulilities

advanced hard disk utilities

disk files. C-18
erasing the contents of a
logical drive. C-11
i extended parlition

schemes, C-16, C-17
extending the system wide

folder limit, C-12. C-

14

application,
installing, 4-19
'1 installing to normal or autoboot
status, 4-23
installing to open from function
i keystroke, 4-22, 4-23
0 arguments, 4-19, 4-20
: arrow keys, 2-9
audio feedback, 6-14

backup copy, 3-19, 3-20
baud rate, 6-17

bell button, 6-15

bit, 2-1

bits/char. 6-17

bottom to top, 4-8
brackels, 1-4

busy bee icon, 2-7

formatting and partitioning byte, 2-1

the hard drive. bytes used, 3-12 -

C-5 through C-10 .
formatting, C-5. C-6, C-7 R
partitioning. C-7 through C-10 C

installing and removing the _

hard disk driver file, C-3, C-4 } . .
installing the hard disk driver. C-5 g:ﬁ:r::‘at?)rai?éfp;g 2-9
removing the hard disk driver. C-4 - [Caps Lock] key, 2-8
bypassing the hard disk driver. C-4 cartridge, 1-8. 3-3

marking bad sectors, C-12
organizing and maintaining

your hard disk, C-15, C-16

CDARS504 compact disc drive, 1-10
CD-ROM disc, 2-2
clicking, 3-4

backing up the hard drive, C-15 close box, 3-12
optimizer programs. C-16 y

parking and unparking the read/

close directory, 4-8
close top window, 4-8

write heads. C-1 through C-3 [CIr Home] key, B-1

alert box. 4-1, 4-2
alphanumeric keys, 2-8

[Alternate] [CIr Home] keys. B-1

[Alternate] [Help] keys, B-1

[Alternate] [Insert] keys. 3-5, 3-6

[Alternate] key. 3-4
[Alternate] [Shift] keys, 3-4
.APP extension, 5-5

coldstart, 2-10

color, 6-19

connecling your system. 1-4 through 1-14
connector pinout specifications, F-1 through F-8

Index
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Control Panel, 4-4. 6-2 through 6-22 - 50

About, 6-3

Setup, 6-3 through 6-8
Advanced Setup Options. 6-6, 6-7
CPX Info. 6-7, 6-8
CPX Mover and Reload

CPXs. 6-4, 6-5 -

Date and Time. 6-3, 6-4 -,
Open CPXs, 6-7
Unload CPX. 6-8

CPXs. 6-8 through 6-2

Accelerator. 6-21, 6-2 s

Color Setup. 6-10, 6-11. 6-12
Configure CPXs, 6-12. 6-13
General Selup. 6-14. 6-15, 6-16
Modem Setup. 6-16, 6-117, 6-18
Printer Setup. 6-18. 6-19. 6-20
Sound Setup. 66-20, 6-21
Window Colors, 6-8. 6-9. 6-10
copy operation,
copying a disk, 3-19, 3-20
file, 3-22
folder, 3-22 s
source disk. 3-20
CPX directory path. 6-6, 6-7
CPXs. 6-2 through 6-22
cursor. text. 2-9

D

daisy chaining. 1-10
Delete. 4-7
default directory, 4-21, 4-22
define single keystroke, 4-27. 4-28
deleting files and folders, 3-22, 3-23
desk accessories,
Control Panel, 6-1 through 6-22
installing. 6-1
opening. 6-2
Desk menu, 4-3. 4-4
desktop,
files. 3-2
folders, 3-2
icons, 2-6. 2-7, 3-2
initial screen display, 2-6
menu bar. 2-7
pointer. 2-7
windows. 3-2

Index

Desktop Contiguration, 4-27. 4-28
Desktop Information, 4-4
destination disk, 3-20
dialog box, 4-1, 4-2
directories and folders, 5-1, 5-2
disk drive, built-in hard disk, 1-7
disk drive, external floppy. 1-9
disk drive, external hard,
ACSI port, 1-10
connecting, 1-10, 1-12
SCSl port, 1-12
disk drive, built-in floppy, 1-7
disk. floppy,
copying, 3-19, 3-20
destination. 3-20
double-sided, 3-17
formatting. 3-17, 3-18, 3-19, 4-9, 4-10
icon, 2-7
inserting. 3-1, 3-2
MS-DOS tormat compatibility, 3-17
removing, 3-1, 3-2
single-sided, 3-17
source, 3-20
storage capacity, 2-2, 3-16
write protecting, 3-21
DMA,
port, 1-10
devices, 1-10
double clicking, 3-4
double click response, 6-16
dragging, 3-7, 3-8
drive selector, 5-7

E i
exclamation point, 1-4
expansion slot, 1-8, 1-12

F

File Mask, 3-12, 5-6
File menu, 4-4 through 4-10
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file. -
copying. 3-21, 5-13, 5-14
data, 5-11
deleting. 4-7. 5-15, 5-16
invalid file name characters, 5-4
moving, 3-7, 3-8. 5-14, 5-15
naming, 4-5, 4-6, 5-14
opening. 5- 7 through 5-12
pathname, 5-6, 5-7
program. 5-7
renaming, 4-5, 4-6, 5-15
filename. 5-2. 5-3
file selector. 5-7, 5-8.
file specification. 5-10, 5-11
fill patterns. 4-13
floating point coprocessor. 1-1
floppy disk. see disk. floppy
floppy disk drive. see disk drive. floppy
flow control. 6-18
folder.
copying. 3-21, 5-13, 5-14
creating, 4-7, 4-8,
deleting, 4-7. 5-15, 5-16
invalid folder name characters, 5-4
moving. 3-7. 3-8, 5-14, 5-15
naming. 4-5. 4-6

opening, 3-11, 3-12
renaming. 4-5. 4-6, 5-15
format floppy disk. 4-9, 4-10
full box, 3-12
function keys. 2-9, 4-27
G
GEM, 2-3. 2-6 E

graphics modes chart, 4-26

icon, -
changing the icon identifier. 4-18
changing the icon label. 4-18
desktop. 3-2
floppy disk, 2-7

hard disk, 2-6, 2-7
trash can, 2-7
window, 3-2
information line, 3-12
4 input parameter, 4-27, 4-28

.

install application, 4-19 through 4-23

install devices, 4-24
installing,
_applications, 4-19
desk accessories, 6-1
devices, 4-24
icon, 4-14 through 4-18

J
joystick, 1-13°

e

K
keyboard,
alphanumeric keys, 2-8
arrow keys, 2-9
calculator keypad, 2-9
. connecting. 1-5
A function keys, 2-9, 4-27
response, 6-15
kilobyte, 2-1
S
: L
LAN, 1-11

laser printer port, 1-10
linking a document type to an

application, 4-20, 4-21
logical drive. 3-2

M

main directory, 5-1
mains plug, G-1
mains plug adapter, G-1

Index
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b

memory.
external memory, 2-1, 2-2
internal memory, 2-1, 2-2
menu bar, 2-7, 3-2, 4-3 through 4-30
MIDI, 1-13
minimum number of siots, 6-6
modem, 1-11
modem recognition, 6-21, 6-22
monitor, 1-5, 1-6
mouse,
clicking, 3-4
connecting. 1-4
double clicking, 3-4
moving, 3-3
move bar, 3-12

" megabyte, 2-1 BE s

W

1

s

musical instrument digital interface, see MIDI

N

name conflict during copying, 5-14
naming.

files, 4-5, 4-6

folders, 4-5, 4-6
NEWDESK.INF, 4-10, 4-14, 4-27
no sort, 4-12
notations, special. 1-4

o

on/off switch, 1-6
Open. 4-4. 4-5 .
Options menu, 4-14 through 4-30 !

P

paleite, 1-1, 4-13

panels and ports, A-1

paper, 6-20

parallel printer, 1-11

parity, 6-17

pathname, 5-6. 5-7

peripheral, see individual listings
pinout specifications, F-1 through F-8
pixel, 3-4

Index

pointer,
control, quick reference, B-1
controlling with keystrokes, 3-3, 3-4
controlling with the mouse, 3-3

port, 1-8 0
ACSI, 1-10
external floppy drive, 1-9
joystick, 1-13
LAN, 1-11
MIDI. 1-13
modem, 1-11 .
mouse, 1-4
parallel printer. 1-10
SCsSl. 1-12
serial, 1-11

power connection in the UK, G-1, G-2
PRG, 5-5

Print Screen, 4-29, 4-30

printer type. 6-19

processor. 1-1

Q
quality, 6-19, 6-20

R

RAM, 1-1, 2-2

READ.INF file, 4-26. 4-27
remove desktop icon, 4-24, 4-25
reset button, 1-7

resolution, 4-26

[Return] key, 2-8

ROM, 2-1, 2-2

rubber band box, 3-9, 3-10, 3-11

S

Save Desktop, 4-28, 4-29
screen resolution,
setting, 4-26
available, 4-26
screen saver, 6-21, 6-22
scroll arrow, 3-12
scroll bar, 3-12
scroll box, 3-12
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SCsl, 1-12

SDUMP .PRG, 4-30

search, 4-7

select all items. 4-8

selecting,
a single item, 3-4, 3-5, 3-6, 3-7
an icon, 3-6
default directory. 4-21, 4-22
menu heading, 3-6. 3-7
multiple icons, 3-9
parameter, 4-22
with the mouse button, 3-4, 3-5
with keystroke combinations, 3-5

serial port selector, 6-16

set color and style, 4-12, 4-13

set file mask, 4-9

Set Preferences. 4-25, 4-26

setup, 6-3 through 6-8

shift-clicking, 3-10, 3-11

[Shift] key. 2-8

Show as Icons, 4-11

Show as Text, 4-11

Show Information, 4-5, 4-6

size box, 3-12

size 1o fit, 4-12

Sort by Date. 4-12

Sort by Name, 4-12

Sort by Size, 4-12

Sort by Type, 4-12

sound, 6-15

source disk, 3-20

specifications, E-1 through E-3

starting your system,
from a hard disk drive, 2-4
from a Hloppy startup disk. 2-5

status, 6-14

stereo, 1-12, 1-13

stop sign, 1-4

stop bits. 6-18

switching off the system, 2-9, 2-10

T

TOS, 2-2, 2-3

.TOS extension, 5-5

trash canicon, 2-7
troubleshooting, D1 through D-12
.TTP extension, 5-5

U
updating a directory display, 4-1

v

View menu, 4-10 through 4-13
VMEDbus, 1-12

w

warmstart, 2-10
warning icon, 1-4
wildcards, 5-10, 5-11
windows,
active, 3-13
closing, 3-11, 3-12
moving, 3-14
opening, 3-11, 3-12
 scrolling, 3-15, 3-16
' sizing, 3-13, 3-14
write protecting floppy disk, 3-21

X
XCONTROL.ACC, see Control Panel
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